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About this document

This document provides information about setting up, installing, configuring, and
working with the three IBM® TotalStorage™ FAStT premium features that assist with
copy services; FlashCopy™, VolumeCopy and the Remote Mirror option. These
features are used with IBM Fibre Array Storage Technology (FAStT) Storage
Manager Version 8.4. Use this guide to:

» Determine the hardware and software that are required to install the copy
services features

* Install, enable, and activate the IBM FAStT FlashCopy feature

» Install, enable, and activate the IBM FAStT VolumeCopy feature
 Install, enable, and activate the IBM FAStT Remote Mirror Option
» Troubleshoot hardware and software problems

Note: The VolumeCopy premium feature is only supported in FAStT Storage
Manager version 8.4. If you are not presently running Storage Manager 8.4,
you must purchase an upgrade.

Who should read this document

This guide is for system administrators who are responsible for operating and
maintaining storage systems, with an emphasis on disaster prevention and
recovery.

Before you install this product, make sure that you have purchased the premium
feature keys necessary for those features you want to install and consult the
following documentation:

* readme file - Read this text file first. The readme file is located in the root
directory of the installation CD. For the latest installation and user information, go
to the following Web site:

www.storage.ibm.com/support/
and then choose FASET Storage Servers.

* |IBM FASIT Storage Manager Version 8.4 Installation and Support Guide for your
operating system or platform - Use this document to become familiar with
terminology and features of the IBM FAStT Storage Manager Version 8.4
software. You can download this book from the following Web site:

www.ibm.com/pc/support

FAStT installation process overview

[Figure 1 on page xii| gives an overview of the FASIT hardware and the FAStT
Storage Manager software installation process. Lined arrows in the flow chart
indicate consecutive steps in the hardware and software installation process.
Labeled arrows indicate which current documents provide detailed information about

© Copyright IBM Corp. 2003 Xi



those steps.

Install Process Documentation

FC Planning and

) b X FAStT Storage Server
Plan Installation Integration: User's Guide _’ Connect Power and Installation Guides
and Svc Info Start Server
Fibre Channel
A FAST Storage Manager Hardware Maintenance
Concepts Guide v and Problem
Install Storage Determination Guide
Server/RAID Controller Verify Server
3 FASLT St ) a
Enclosure(s) in Rack e operation w/ LEDs
FAStT RAID Controller
Enclosure Unit Install v
and User's Guide
Install Storage \ Pre;l:»lare for ;
i i nstallation of
Expansion Unit(s) ) o s FASHT Storage
FASIT Storage FXP Units Manager Installation
Install and User's Guides and Support
OS Guides
Make FC C ti v
ake onnections FAStT Storage Manager
Install and Verify SM SW Copy.Servi_ces
on Host and User's Guide
Workstation
Set Link Speed
(1 Gb only) FAStT and HBA Install
and User's Guides v

Complete SM SW

FAStT Fibre Channel 5
Installation

Storage Server
Installation Guides

Determine
Management
Method

Fibre Channel Cabling
Instructions

Out-of-Band

Configure Storage

Hardware Online Help

Install Network
Hardware; Prepare
Network Connection

]

[
Z >

* For pSeries Server and 6227 or 6228 HBA use only

Configure Storage
Subsystems on Host

Figure 1. Installation process flow by current publications

FAStIT documentation

The following table presents an overview of the FASIT Storage Manager product
library. The table lists documents included in the library and what common tasks
they address. Click on active links in the tables to access those documents

currently available on the Internet. You can access documentation for the other
FASIT products at the following Web site:

issddom02.storage.ibm.com/techsup/webnav.nsf/support/fastt/
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http://ssddom02.storage.ibm.com/techsup/webnav.nsf/support/fastt

FAStT Storage Manager Version 8.4 library

associates each document in the FASIT Storage Manager library with its
related common user tasks.

Table 1. TotalStorage FAStT Storage Manager Version 8.4 titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
FAStT Storag

Manager 8.4 Library,

Guide and Common

Index, GC26-7600

IBM TotalStorage)

Support Guide for
Intel-based|
Operating System|

Environments,
GC26-758

IBM TotalStorage)

Support Guide for|
AIX®, UNIX, and
Solaris, GC26-7593|

IBM TotalStora e|

FAStT Storage)
Manager Copyj
Services User’s|

Guide, GC26-7561|

IBM FASLT Storage
Manager Script
Commands (see
product CD)

IBM TotaIStorage|
FAStT Storag
Manager Concepts|
Guide, GC26-7560

How this document is organized

[Chapter 1, “Introduction,” on page 1|provides information on how to enable, view,

and disable the premium features.

[Chapter 2, “Overview of FlashCopy,” on page 7| provides information about the

FlashCopy feature, how to enable the feature, plan, create, and reuse FlashCopy

logical drives, and how to perform some common FlashCopy tasks.

[Chapter 3, “Overview of VolumeCopy,” on page 47| provides information about the

VolumeCopy feature, how to use the Create Copy wizard and the Copy Manager to
copy, backup, and restore data.

About this document
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[Chapter 4, “Managing VolumeCopy,” on page 63provides information to help you
manage your VolumeCopies. It also provides information about how to re-copy,
stop, or remove a VolumeCopy, modify the attributes of a logical drive, view the
status of a VolumeCopy operation, and determine what logical drives are involved in
a VolumeCopy operation.

|Chapter 5, “Troubleshooting VolumeCopy,” on page 75| provides information about
troubleshooting some of the more common problems encountered when you use
the VolumeCopy feature.

|Chapter 6, “Overview of the Remote Mirror Option,” on page 81| provides an
introduction to the Remote Mirror Option and describes the hardware and software
requirements for using the Remote Mirror Option. It also provides information about
configuration types, describes how the Remote Mirror Option interfaces with other
premium features (such as Storage Partitioning and FlashCopy logical drives), and
provides a hardware and software checklist to ensure that all the requirements are
met before you install and configure your systems.

Chapter 7, “Installing hardware and software for the Remote Mirror Option,” on page|
95| provides information about preparing the site and instructions for installing key
hardware and software components to run the Remote Mirror Option.

[Chapter 8, “Using the Remote Mirror Option,” on page 121|provides step-by-step
instructions for enabling and activating the Remote Mirror Option, creating a mirror
relationship, and maintaining a mirror relationship.

[Chapter 9, “Disaster recovery,” on page 127 provides a number of scenarios about
how the Remote Mirror Option can help prevent data loss, and assist with the
recovery of critical data if a disaster or unrecoverable error occurs.

[Chapter 10, “Troubleshooting the Remote Mirror Option,” on page 135| provides
information for troubleshooting hardware and software components, and describes
the events that might be logged when using the Remote Mirror Option.

IAppendix A, “Controller firmware version 5.4 upgrades,” on page 147 describes the
procedure that you must follow to upgrade controller firmware to ensure that the
Remote Mirror Option works properly.

lAppendix B, “Additional FAStT documentation,” on page 149 provides a bibliography
of additional documentation.

[‘Notices” on page 155 provides product notices and trademark information.

Notices that this document uses

This document contains the following notices designed to highlight key information:
* Notes: These notices provide important tips, guidance, or advice.

* Important: These notices provide information that might help you avoid
inconvenient or problem situations.

» Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.
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Getting information, help, and service

Before you call

If you need help, service, or technical assistance or just want more information
about IBM and IBM products, you will find a wide variety of sources available from
IBM to assist you. This section contains information about where to go for additional
information, what to do if you experience a problem with your IBM @server
xSeries™ or IntelliStation® system, and whom to call for service, if it is necessary.

Before you call, make sure that you take these steps to try to solve the problem
yourself:

» Check all cables to make sure that they are connected.

* Check the power switches to make sure that the system is turned on.

» Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system.

* Go to the IBM Support Web site at:
www.ibm.com/pc/support/
to check for technical information, hints, tips, and new device drivers.

* Use an IBM discussion forum on the IBM Web site to ask questions.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information that
comes with your system also describes the diagnostic tests that you can perform.
Most xSeries and IntelliStation systems, operating systems, and programs come
with information that contains troubleshooting procedures and explanations of error
messages and error codes. If you suspect a software problem, see the information
for the operating system or program.

Using the documentation

Web sites

Information about your xSeries or IntelliStation system and preinstalled software, if
any, is available in the documentation that comes with your system. That
documentation includes printed documents, online documents, readme files, and
help files. See the troubleshooting information in your system documentation for
instructions for using the diagnostic programs. The troubleshooting information or
the diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM® maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to the Web site at:

www.ibm.com/pc/support/

and follow the instructions. Also, to order publications through the IBM Publications
Ordering System, go to the Web site at:

www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi/

On the World Wide Web, the IBM Web site has up-to-date information about
xSeries and IntelliStation products, services, and support.

For the most up-to-date information about IBM FAStT storage servers, go to the
following Web site:
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www.storage.ibm.com/hardsoft/disk/fastt/

For information about all IBM storage products, go to the following Web site:
www.storage.ibm.com/

For xSeries information, go to the Web site at:
www.ibm.com/eserver/xseries/

For IntelliStation information, go to the Web site at:
www.ibm.com/pc/intellistation/

For service information for your IBM products, including supported options, go to
the Web site at:

www.ibm.com/pc/support/

If you click Profile from the support page, you can create a customized support
page. The support page has many sources of information and ways for you to solve
problems, including how to:

» Diagnose problems, using the IBM Online Assistant

* Download the latest device drivers and updates for your products

» View Frequently Asked Questions (FAQ)

* View hints and tips to help you solve problems

» Participate in IBM discussion forums

» Set up e-mail notification of technical updates about your products

For the latest information about operating system and HBA support, clustering
support, storage area network (SAN) fabric support, and Storage Manager feature
support, see the IBM TotalStorage FAStT Interoperability Matrix at the following
Web site at:

www.storage.ibm.com/disk/fastt/supserver.htm

Software service and support
Through the IBM Support Line, for a fee, you can get telephone assistance with
usage, configuration, and software problems with xSeries servers, IntelliStation
workstations and appliances. For information about which products are supported
by Support Line in your country or region, go to the Web site at:
www.ibm.com/services/sl/products/

For more information about Support Line and other IBM services, go to the Web
site at:

www.ibm.com/services/
or, for support telephone numbers, go to the Web site at:

www.ibm.com/planetwide/
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Hardware service and support

You can receive hardware service through IBM Integrated Technology Services or
through your IBM reseller, if your reseller is authorized by IBM to provide warranty
service. For support telephone numbers, go to the Web site at:

www.ibm.com/planetwide/
In the U.S. and Canada, hardware service and support is available 24 hours a day,

7 days a week. In the U.K., these services are available Monday through Friday,
from 9 a.m. to 6 p.m.

How to send your comments

Your feedback is important to help us provide the highest quality of information. If
you have any comments about this document, you can submit them in one of the
following ways:

* E-mail
Submit your comments electronically to:
starpubs @us.ibm.com
Be sure to include the name and order number of the document and, if

applicable, the specific location of the text that you are commenting on, such as
a page number or table number.

e Mail or fax

Fill out the Readers’ Comments form (RCF) at the back of this document and
return it by mail or fax (1-800-426-6209) or give it to an IBM representative. If the
RCF has been removed, you may address your comments to:

International Business Machines Corporation
RCF Processing Department

Dept. M86/Bldg. 050-3

5600 Cottle Road

San Jose, CA 95193-0001

U.S.A.
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Chapter 1. Introduction

This chapter introduces three Storage Manager premium features that assist with
copy services:

FlashCopy

You use the FlashCopy feature to create and manage FlashCopy logical
drives. A FlashCopy is the logical equivalent of a complete physical copy,
but is created more quickly and requires less disk space. It is host
addressable, so you can perform backups using FlashCopy while the base
logical drive is online and user-accessible. When the backup completes,
you can delete the FlashCopy logical drive or save it for reuse.

VolumeCopy

The VolumeCopy feature is a FASIT Storage Server controller
firmware-based mechanism that you use to copy data from one logical drive
(the source logical drive) to another logical drive (the target logical drive) in
a single storage subsystem. Once defined, the combination of the source
and target logical drives in a VolumeCopy relationship is referred to as a
VolumeCopy logical drive pair. The VolumeCopy feature can be used to
perform the following tasks:

» Copy data from arrays that use smaller capacity drives to arrays that use
larger capacity drives

* Back up data
» Restore FlashCopy logical drive data to the base logical drive

The VolumeCopy feature includes a Create Copy wizard that you use to
create a logical drive copy, and a Copy Manager that you use to monitor
logical drive pairs after they have been created.

Important: During the VolumeCopy data transfer operation, any write
requests to the source logical drive will be rejected. If the source logical
drive is used in a production environment, the FlashCopy feature must be
enabled and the FlashCopy of the logical drive must be specified as the
VolumeCopy source logical drive instead of using the actual logical drive
itself. This requirement is to prevent the logical drive from being
inaccessible to the users.

Remote Mirror Option

© Copyright IBM Corp. 2003

The Remote Mirror Option feature provides online, real-time replication of
data between storage subsystems over a remote distance. In the event of a
disaster or unrecoverable error at one storage subsystem, the Remote
Mirror Option enables you to promote a second storage subsystem to take
over responsibility for normal input/output (1/0) operations.

FAStT600 and FAStT600 Turbo:
The Remote Mirror Option is not supported on the FAStT600 or the
FAStT600 Turbo Fibre Channel Storage Servers with Storage
Manager 8.4.




Supported features

indicates the support for FlashCopy, VolumeCopy and the Remote Mirror
Option on the FAStT600, FAStT600 Turbo, FAStT700, and FAStT900.

Table 2. Feature support on the FAStT600, FAStT600 Turbo, FAStT700, and FAStT900

2

Feature

FAStT600

FAStT600 Turbo

FAStT700

FAStT900

FlashCopy

Supported

Supported

Supported

Supported

* Maximum
number of
logical drives
that can be
defined (See
note 1)

* Maximum total
FlashCopy
logical drives
(See note 2)

* Maximum
FlashCopy
logical drives
per base RAID
logical drive

1024

512

1024

512

2048

1024

2048

1024

VolumeCopy

Supported

Supported

Supported

Supported

* Maximum
number of
VolumeCopy
target logical
drives for a
given source
logical drive

* Maximum
copy pairs per
array

* Maximum
running copies
per array (See
note 3)

1023

1023

1023

1023

2047

2047

2047

2047

Remote Mirror
Option

Not Supported

Not Supported

Supported

Supported

» Total Remote
Mirror logical
drives

N/A

N/A

32

32

Notes:

1. When using firmware version 5.xx.xx.xx, the firmware reserves one logical drive
for use by the system. For firmware version 05.2x.xx.xx and higher, the
maximum number of logical drives includes the FlashCopy repository logical
drives, the VolumeCopy target logical drive and the Remote Mirror logical drives
in addition to the standard data logical drives. If the Remote Mirror Option is

enabled, two logical drives are reserved for use by the system.
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2. The total number of FlashCopy logical drives is limited to one half of the total
number of logical drives.

3. Refers to logical drives in the copy-in-progress state.

Enabling premium features

You must perform the following tasks to enable a premium feature on your storage
subsystem:

+ Obtain the feature enable identifier

* Generate the feature key file

Enable the feature

Verify that the premium feature is enabled

Before you begin, gather the following information:

* Your Feature Activation Code, which is printed on the IBM FlashCopy Premium
entitlement card

* Your controller unit IBM serial number, which is printed on the label on the back
of your FAStT controller unit

* A 32 alphanumeric IBM FASLT storage subsystem premium feature identifier
string.

To obtain the storage subsystem premium feature identifier string, ensure that your
controller unit and expansion units are connected, powered on, and managed using
the SMclient. Continue with the next section.

Obtaining the feature enable identifier

Each storage subsystem has its own unique feature enable identifier. This identifier
ensures that a particular feature key file is applicable only to that storage
subsystem. Complete the following steps to obtain the feature enable identifier:

1. Click Start » Programs » FAStT Storage Manager 8 Client. The Enterprise
Management window opens.

2. In the left pane, double-click the storage subsystem for which you want to
enable the premium feature. The Subsystem Management window opens for the
selected storage subsystem.

3. In the Subsystem Management window, click Storage Subsystem » Premium
Features » List. The Premium Feature List window opens and displays the
feature enable identifier.

4. Record the feature enable identifier.
5. Close the Premium Feature List window.

Generating the feature key file and enabling the premium feature

You can enable the premium feature by using the Premium Feature Activation tool
that is located at the following Web site:

www.ibm.com/storage/fasttkeys

Perform the following tasks on the Web site to enable your premium features:
1. Generate and store the key activation file.

2. Download the key activation file to your controller unit.

3. Enable the premium feature.

4. Verify that the premium feature was successfully enabled.
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EI available.

Your system is now ready to use the premium feature that you enabled.

Note: To check the status of a premium feature, select Storage Subsystem -
Premium Features ~» List from the pull-down menu.

If a premium feature becomes disabled, you can access the Web site and repeat
this process. For any additional assistance, contact your local IBM service provider.
Make sure you have the information listed in |“Enabling premium features” on page|

Viewing the status of premium features

Perform the following steps to see a list of those premium features that are enabled
on your storage subsystem:

1. In the Subsystem Management window, click Storage Subsystem » Premium
Features - List.

The List Premium Features window opens (see .

BRITSO - IBM FASIT Storage Manager 8 (Subsystem

Storage Su
| Locate 4
Configuration ]
— > 3>BmppPpoB6mee P H SR eE I

FPremium Features Enable...

Remote Mirroring » Disahle. .
Fecavery Gurd... E
Monitor Performance.
Diownload 4 3. E
Change 4 :
rOrive En
Set Cantraller Clocks...
1l
Eedistihite Canice D ivE & -~
@ 2
Fun Read Link Status Diagnostics
Rename...
Exit
SJ000827

Figure 2. Listing premium features

The dialog lists the following items:
* The premium features that are enabled on the storage subsystem
* The feature enable identifier

2. Click Close to close the window.

Disabling premium features

4

In normal system operations, you do not need to disable the premium features.
However, if you want to disable a premium feature, make sure that you have the
key file or the IBM FASLT premium feature entitlement card with the premium
feature activation code for generating the key file. You need this key file to reenable
the premium feature at a later time.

Perform the following steps to disable a premium feature on the storage subsystem:

IBM TotalStorage FAStT Storage Manager Copy Services User’s Guide



1.

In the Subsystem Management window, click Storage Subsystem » Premium
Features » Disable.

The Disable Premium Feature window opens and lists all the premium features
that are enabled.

2. Select one item in the list, and click OK.
A confirmation dialog displays that states that disabling a premium feature is not
recommended.

3. Click Yes.
The Working dialog displays while the feature is being disabled. When the
feature has been disabled, the Working dialog closes.

Notes:

1. If you want to enable the premium feature in the future, you must re-apply the
Feature Key file for that feature.

2. You can disable the Remote Mirror Option without deactivating the feature. If the

feature is disabled but activated, you can perform all mirroring operations on
existing remote mirrors. However, when the feature is disabled you cannot
create any new remote mirrors. For more information about activating the
Remote Mirror Option, see [Enabling and activating the Remote Mirror Option’]

or see “Using the Activate Remote Mirroring Wizard” in the Storage

Manager online help.
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Chapter 2. Overview of FlashCopy

You use FlashCopy to create and manage FlashCopy logical drives. A FlashCopy
logical drive is a point-in-time image of a standard logical drive in your storage
subsystem. The logical drive that is copied is called a base logical drive.

When you make a FlashCopy, the controller suspends write operations to the base
logical drive for a few seconds while it creates a FlashCopy repository logical drive.
This is a physical logical drive where FlashCopy metadata and copy-on-write data
are stored.

Note: In order to ensure an accurate FlashCopy image of the base logical drive,
the 1/Os to the base logical drive must quiesce during the time the
FlashCopy image is being made. In addition, all of the operating system
cache I/Os to the base logical drive must be flushed and all opened files on
the base logical drive should be closed.

You can create up to four FlashCopies of a base logical drive, and then write data
to the FlashCopy logical drives to perform testing and analysis. For example, before
upgrading a database management system, you can use FlashCopy logical drives
to test different configurations.

You can create FlashCopy logical drives for repeated reuse (frequent or nightly
backups) or for one-time use (speculative change or upgrade testing).

This chapter describes the following procedures:

+ [“Enabling FlashCopy’|

[‘Planning a FlashCopy logical drive” on page 8|
[‘Creating a FlashCopy logical drive” on page 20|
[‘Reusing a FlashCopy logical drive” on page 32|
[‘Performing FlashCopy tasks” on page 37|

You can perform these procedures using the SMclient GUI interface or the
command-line interface (SMcli) and the script editor. For more information, click the
Help tab in the Enterprise Management window, and then search for SMcli or script
editor.

Note: FlashCopy is not supported on the FAStT600 that is running firmware
version 5.3X.XX.XX.

Enabling FlashCopy

To enable FlashCopy, you must perform the following tasks in the following order:
1. Obtain the feature enable identifier. This procedure is described in detail in
[‘Obtaining the feature enable identifier’ on page 3|

2. Generate the feature key file and enable FlashCopy. This procedure is
described in detail in[‘Generating the feature key file and enabling the premium
[feature” on page 3/

Before you begin, gather the following information:

* Your Feature Activation Code, which is printed on the IBM FlashCopy Premium
entitlement card
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* Your controller unit IBM serial number, which is printed on the label on the back
of your FAStT controller unit

* A 32 alphanumeric IBM FAStT storage subsystem premium feature identifier
string.

To obtain the storage subsystem premium feature identifier string, ensure that your
controller unit and expansion units are connected, powered on, and managed using
the SMclient.

For information on how to view a list of those premium features that are enabled on
your storage subsystem, see [‘Viewing the status of premium features” on page 4)

Planning a FlashCopy logical drive

Before you create a FlashCopy logical drive, make sure that you are familiar with
the following concepts, which are described in this section:

+ [“Specifying FlashCopy repository logical drive failure settings’|

« [“Estimating FlashCopy repository logical drive capacity” on page 9|
« [“Estimating FlashCopy repository life” on page 11|

+ [‘Previewing the FlashCopy Logical Drive wizard” on page 12|

Specifying FlashCopy repository logical drive failure settings

8

When you create a FlashCopy logical drive, you also create and define the
parameters of a physical logical drive that is called the FlashCopy repository logical
drive. The repository logical drive is where FlashCopy data and copy-on-write data
are stored.

This section contains information that helps you choose the FlashCopy repository
logical drive failure settings that you specify in the FlashCopy Logical Drive wizard.

You should read this section before you create a FlashCopy logical drive, so that
you have a better understanding of the parameters when you set them initially.

For information about changing the properties of an existing FlashCopy repository
logical drive, see [‘Changing FlashCopy repository logical drive properties” on page|

Repository capacity threshold warning level
When you create the FlashCopy repository logical drive, you specify its capacity
threshold warning level.

The threshold warning is the only warning that is given before the FlashCopy
repository logical drive becomes full, so do not ignore it. When you receive the
Threshold Exceeded warning, you can perform one of the following two actions:

* Increase the capacity of the FlashCopy repository logical drive
* Increase the FlashCopy repository logical drive threshold capacity warning level

Important: Increasing the threshold capacity warning level reduces the amount of
time that you have to perform the necessary tasks to prevent the FlashCopy
repository logical drive from becoming full when you receive a Threshold Exceeded
warning.
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See [‘Specify Logical Drive Parameters panel” on page 14| for information about
setting the capacity threshold warning level for the FlashCopy repository logical
drive.

If you are not sure how high to set the threshold warning level, accept the default
setting.

Repository full policy

When you create the FlashCopy repository logical drive, you can specify the action
that you want the system to perform when the drive reaches its capacity and
becomes full. You can choose from the following two options:

Fail FlashCopy logical drive
When the FlashCopy repository logical drive becomes full, FlashCopy
logical drive data is not recoverable and the FlashCopy cannot be
accessed. In this case, the only possible action is to delete the FlashCopy
logical drive or re-create the FlashCopy logical drive to create a new
point-in-time image.

This is the default option.

Fail writes to base logical drive
When the FlashCopy repository logical drive becomes full, the FlashCopy
logical drive data is still accessible. However, all write requests to the base
logical drive are rejected until the FlashCopy repository logical drive
capacity is increased. This is not a recommended setting.

Attention: The Fail writes to base logical drive option is not supported on
AIX. Selecting this option might cause data loss on the base logical drive. If
you are using AlX, select the Fail FlashCopy logical drive option, which is
the default. Be sure to monitor the capacity of the FlashCopy repository
logical drive, because you cannot access the FlashCopy if the repository
logical drive becomes full.

For more information about increasing the storage capacity of an existing
FlashCopy repository logical drive, see|‘Resizing a FlashCopy repository logicall
[drive” on page 43.

Estimating FlashCopy repository logical drive capacity

If numerous I/O requests are written to the base logical drive, the FlashCopy
repository logical drive can eventually exceed the base logical drive capacity if all
the original data blocks are changed.

Note: Different operating systems might deal with data modifications, such as
deleting, replacing, adding only, or deleting only, differently. For example, if
you continuously delete and recreate a 10 MB file, the operating system
might use only new disk blocks each time the file is created which causes
the FlashCopy repository logical drive to become full with the original data.
So, instead of generating the 10 MB worth of data in the FlashCopy
repository logical drive, it might generate data up to the size of the base
logical drive in the FlashCopy repository logical drive.

You can estimate the FlashCopy repository logical drive capacity by calculating the

amount of expected management overhead and the space required for
copy-on-write data.
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Note: You should re-estimate the FlashCopy repository logical drive capacity
periodically. You can estimate the FlashCopy repository logical drive capacity
by calculating the following figures:

* The amount of expected management overhead
* The space required for copy-on-write data

* The rate that the FlashCopy repository logical drive is filled up with the
copy-on-write data

Considerations
The following information can help you to determine the appropriate capacity of the

FlashCopy repository logical drive:
* The minimum capacity of a FlashCopy repository logical drive is 8 MB.

* The amount of write activity to the base logical drive that takes place after the
FlashCopy logical drive has been created determines the size of a FlashCopy
repository logical drive. As the amount of write activity to the base logical drive
increases, the number of original data blocks that need to be copied from the
base logical drive to the FlashCopy repository logical drive also increases.

« The longer a FlashCopy logical drive remains enabled, the higher the risk of the
FlashCopy repository logical drive reaching its maximum capacity. For more
information, see [‘Estimating FlashCopy repository life” on page 11

* There is not necessarily a one-to-one correlation between the number of data
blocks that change on the base logical drive and the amount of copy-on-write
data that is stored on the FlashCopy repository logical drive. The controller might
copy over a full set of 32 blocks for performance reasons, even if only one set of
blocks has changed. Keep this in mind when determining the percentage of the
capacity of the base logical drive that can be copied to the FlashCopy repository
logical drive.

Calculating estimated repository capacity

The following formula should be used merely as a guide. When you estimate the
FlashCopy repository logical drive capacity, keep in mind the information listed in
[‘Considerations.”|

Note: When performing this calculation, you must convert the bytes to kilobytes,
the kilobytes to megabytes, and the megabytes to gigabytes.

Use the following formula to calculate the amount of expected management
overhead:

192 KB + (X / 2000)
where X is the capacity of the base logical drive in bytes.

Then, add this amount to the amount of space that is required for copy-on-write
data. The result is the estimated FlashCopy repository logical drive capacity.

Sample calculation: On a base logical drive of 5 GB, 30% of the data blocks on
the base logical drive are expected to change.

1. Calculate the amount of management overhead that is required.
a. Convert the capacity of the base logical drive to bytes.
5 GB = 5 368 709 120 bytes
b. Divide the capacity of the base logical drive (in bytes) by 2000.
5 368 709 120 / 2000 = 2 684 354.56 bytes
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c. Convert the result from step [1b on page 10| (in bytes) to kilobytes (KB).

2 684 354.56 bytes = 2621.44 KB

d. Add 192 KB to the results from step[1d
192 KB + 2621.44 KB = 2813.44 KB

e. Convert the result from stepto megabytes (MB), then to gigabytes (GB).
2813.44 KB = 2.75 MB = 0.002686 GB

Result: The amount of required management overhead is 0.002686 GB.

2. Determine the amount of space (in gigabytes) that is required for copy-on-write
data, using the percentage of the base logical drive that is expected to change
(30%).

30% of 5 GB = 1.5 GB
Result: The amount of space that is required for copy-on-write data is 1.5 GB.

3. Add the result from step E| to the result from step

1.5 GB + 0.002686 GB = 1.502686 GB

Result: The estimated FlashCopy repository logical drive capacity is 1.502686 GB.

For more information on estimating the FlashCopy repository logical drive capacity,
see “Learn About Estimating FlashCopy Repository Logical Drive Capacity” in the
FlashCopy online help.

Estimating FlashCopy repository life

When you initially define the properties of the FlashCopy repository logical drive,
keep in mind the kind of usage that is planned for the FlashCopy logical drive.
Understanding how the FlashCopy logical drive will be used can help you to
estimate the life expectancy of the FlashCopy repository logical drive.

After you have created the FlashCopy repository logical drive and some usage data
is available, you can estimate its life expectancy using the following procedure as a
guide. You can then change the properties of the FlashCopy repository logical drive,
if necessary.

Note: The life expectancy of a FlashCopy repository logical drive should be
re-estimated periodically.

1. Select the FlashCopy repository logical drive in the Logical view. Click Logical
Drive » Properties and click the Capacity tab.

2. Record the creation timestamp day and time.
Record the capacity used (GB) and the available capacity (GB).

4. Determine the elapsed time (t) by subtracting the creation time from the current
time, expressing the elapsed time in either minutes, hours, or days.

5. The total time (Tr) that the repository is available for copy-on-write data can now
be estimated, based on the current usage. Multiply the elapsed time (1) by the
available capacity (Ct), and then divide the resultant number by the capacity
used (Cu).

Use the following formula:

Tr =(t *Ct)/Cu

w

Where:
Tr Total time available
t Elapsed time
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Ct Available capacity
Cu Capacity used

Note: The total time available (Tr) indicates the total usage time for the FlashCopy
repository logical drive.

Using the result of these calculations, you can decide whether to increase the
capacity of the FlashCopy repository logical drive. If the repository capacity
becomes 100% full during the expected lifetime of the FlashCopy, then you should
increase the capacity of the FlashCopy repository logical drive.

For more information, see |“Resizing a FlashCopy repository logical drive” on pagel

Previewing the FlashCopy Logical Drive wizard

12

This section contains descriptions of the parameters that you specify on the
following FlashCopy Logical Drive wizard panels:

* Introduction

* Allocate Capacity

» Specify Logical Drive Parameters

» Specify Array Parameters

* Specify Names

» Specify FlashCopy Repository Logical Drive Capacity
* Preview

Note: See the FlashCopy Logical Drive wizard online help for additional
information.

Introduction panel
The Introduction panel, shown in|Figure 3 on page 13| provides a definition of a
FlashCopy logical drive and describes its physical components.
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aem Create A FlashCopy Logical Drive Wizard - Introduction

This wizard will help you guickly create 2 FlashCopy logical
drive and its associated FlashCopy repository logical drive,

AFlashCopy logical drive is a logical point-in-time image of a
hase logical drive. AFlashCopy logical drive uses twio
physical resources: a hase lagical drive and a special lagical
drive called the FlashCopy repository logical drive. 1fthe
controller receives an 10 wiite requastto modify data on the
hase logical drive, then it first copies over the original data to
the FlashCopy repositany for safekeeping. Both the base and
the FlashCopy repositony logical drive are used to maintain
ah accurate point-intime image,

& gimple (recommended)

Selectthis option to specify basic FlashCopy parameters
and acceptthe common default settings.

" Advanced

Selectthis option to customize advanced settings (capacity
allocation, repositary logical drive full conditions and

Cancel | Help |

SJ0o00834
Figure 3. FlashCopy Logical Drive Wizard Introduction panel

On this panel you can select one of the following options:

Simple

You can use this option if there is free capacity in the array in which the
base logical drive is allocated and the free capacity is at least 8 MB plus
1% of the base logical drive capacity. Select this option to specify basic
FlashCopy parameters with default settings for FlashCopy logical drive

mappings.

Advanced

You can use this option if you want to specify the following factors:
* Where the FlashCopy repository logical drive will be created

» All of the customizable FlashCopy settings

Allocate Capacity panel

On the Allocate Capacity panel, shown in [Figure 4 on page 14} you can specify

where to allocate the repository storage capacity.

Chapter 2. Overview of FlashCopy
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Specify where t0 allocate capacity for the FlashCopy repository logical drive,
Logical Drive information

FlashCopy Repository logical drive name: Uservol-R1
Base logical drive capacity: 3.000 GB
Array of base logical drive: array 1 (RAID 5)

Capacity allocation

' Froe capacity on game array as hase (recommended)

204 GB) on array 1 {RAID 5)

€ Free capacity on different array

© Unconfigured capacity (create new array)

= Back Cancel | Help |

SJ000835

Figure 4. Allocate Capacity panel

Free Capacity You can choose Free Capacity on same array as base or Free
capacity on different array. These paths take you to the Specify
Logical Drive Parameters panel, where you can define the mapping
and repository logical drive parameters.

Unconfigured Capacity
This path takes you to the Specify Array Parameters panel, where
you can specify a new array on which the repository resides and
choose the RAID level of the array.

Specify Logical Drive Parameters panel
Use the Specify Logical Drive Parameters panel, shown in |Figure 5 on page 15[, to
specify the action that you want the system to perform when a FlashCopy
repository logical drive reaches its capacity and becomes full.
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Create A FlashCopy Logical Drive Wizard - Specify Log x|

Specity the advanced parameters for this (ogical drive,

~FlaghCopy logical drive parameter:
FlashCopy lagical drive-to-LURN mapping:
" Automatic

= Map laterwith Storage Partitioning

~Repositorr logical drive parameters
Muotify wwhen repository [ogical drive capacity reaches:

| 50 3: nercent (% full

If repository logical drive becarmes full...
= Fail FlaghCopy logical drive

" Failwrites to baze logical drive

= Back |

Figure 5. Specify Logical Drive Parameters panel

Cancel | Help |

SJ000836

FlashCopy logical drive parameters

In this section of the panel you can specify one of the following options for

logical drive-to-LUN mapping:

Automatic
If you choose this option, the system maps the FlashCopy logical
drive automatically.

Map later with Storage Partitioning
If you choose this option, follow the procedure described in

|“Mapping the FlashCopy logical drive to the host” on page 22| after
you have finished using the wizard.

Repository logical drive parameters
In this section of the panel you can specify the threshold warning level and
repository fail policy.
Percent (%) full

This field specifies the threshold warning level for the FlashCopy
repository logical drive. Storage Manager provides a warning

message when the FlashCopy repository logical drive exceeds the
threshold level that you specify.

Important: This warning is the only notification that you receive
before the repository becomes full.

The threshold warning level for the FlashCopy repository logical
drive is initially set to 50%. If you are not sure how high to set the
threshold warning level, accept this default setting.
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You can specify one of the following actions that you want Storage Manager
to perform when the repository becomes full:

Fail FlashCopy logical drive
If you specify this option, the FlashCopy logical drive data is not
recoverable when the FlashCopy repository logical drive becomes
full, and the FlashCopy cannot be accessed. In this case, the only
possible action is to delete the FlashCopy logical drive or re-create
the FlashCopy logical drive to create a new point-in-time image.

This is the default option.

Fail writes to base logical drive
If you specify this option, the FlashCopy logical drive data is
accessible when the FlashCopy repository logical drive becomes
full. However, the FlashCopy repository logical drive capacity must
be increased so that writes to the base logical drive are not
rejected. This is not a recommended setting.

Attention: AlX does not support the Fail writes to base logical
drive option. Selecting this option might cause data loss on the
base logical drive. If you are using AlX, select the Fail FlashCopy
logical drive option, which is the default. Be sure to monitor the
capacity of the FlashCopy repository logical drive, because you
cannot access the FlashCopy if the repository logical drive
becomes full.

See [‘Specifying FlashCopy repository logical drive failure settings” on page 8| for
more information about repository capacity and failure settings.

When you click Next, the Preview panel opens and displays the parameters that
you specified. Click Back to return to the previous panels to edit the repository
parameters or click Finish to proceed to the Specify Names panel.

Specify Array Parameters panel

If you specified the Unconfigured Capacity option on the Allocate Capacity panel,
the Specify Array Parameters panel shown in|Figure 6 on page 17}, displays. On this
panel you can specify a new array on which to place the repository logical drive.
You can also specify the RAID level of the array that meets the FlashCopy
repository logical drive data storage and protection requirements.
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% Create Logical Drive Wizard - Specify Array Parameters T il

Because you specified unconfigured capacity from the grevious screen, you must indicate
E.i_ the RAID level and overall capacity of the new array. You specify the exact capacity for the
- individual logical drive on the next screen.

~Create neve array

RAID [ewel IRAID 5 ‘I

Drive gelection chaices:
 Automatic - selectfrom list of provided capacitiesidrives

o Manual - select your own drives to abtain capacity

Enclogure Slot Drive Capacity

F Teenic
i lieanio
4 16,912 GB

4 16912 GB j

Array capa iy

&pph‘r | A

[Miarrber ot dtive s

= Back et 2 Cancel | Help |

SJ000838
Figure 6. Specify Array Parameters panel
Click Next to go to the Specify Names panel.

Specify Names panel
On the Specify Names panel, shown in [Figure 7 on page 18, you can define the

FlashCopy logical drive name and the name of its associated FlashCopy repository
logical drive.

Chapter 2. Overview of FlashCopy 17



18

Specify a name that helps you associate the FlashCopy logical drive and FlashCopy
repository logic al drive with its corresponding base logical drive. The name can be up

to 30 characters.

Base logical drive name: DataVol

FlashCopy logical drive narme:

I Datavaol-1

FlashCopy Repository logical drive name:

I Datavol-R1

= Back Cancel | Help I

$J000839
Figure 7. Specify Names panel

The default naming convention for the first FlashCopy uses the base volume name
and adds a suffix of “-1” for the FlashCopy logical drive and “-R1” for the FlashCopy
logical repository drive. The second FlashCopy increments this number to 2, and so
on, up to the four volumes.

For example, if you are creating the first FlashCopy logical drive for a base logical
drive called DataVol, then the default FlashCopy logical drive name is DataVol-1.
The associated FlashCopy repository logical drive default name is DataVol-R1. The
default name of the next FlashCopy logical drive that you create based on DataVol
is DataVol-2, and the corresponding FlashCopy repository logical drive name is
DataVol-R2.

Change the default names if required.

Tips about names:

* You must choose a unique name for the FlashCopy and FlashCopy repository
logical drives. Otherwise, the system displays an error message.

* Regardless of whether you use the software-supplied sequence number that (by
default) populates the FlashCopy logical drive name or FlashCopy repository
logical drive name field, the next default name for a FlashCopy or FlashCopy
repository logical drive still receives a sequence number determined by the
software. For example, you might name the first FlashCopy of base logical drive
DataVol DataVolMay28, without using the software-supplied sequence number of
-1. Regardless, the software assigns a default name for the next FlashCopy as
DataVol-2.
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* The next available sequence number is based on the number of existing
FlashCopies of a base logical drive. If you delete a FlashCopy logical drive, the
assigned sequence number becomes available again.

* Names have a 30-character limit, including spaces. When you reach this limit in
either the FlashCopy logical drive name or FlashCopy repository logical
drive name field, no more input is accepted. If the base logical drive name
contains 30 characters, the default names for the FlashCopy and its associated
FlashCopy repository logical drive use the base logical drive name truncated just
enough to add the sequence string. For example, for “Host Software Engineering
Group GR-17, the default FlashCopy name would be “Host Software Engineering
GR-1”. The default repository name would be “Host Software Engineering G-R1.”

Click Next to go to the Specify FlashCopy Repository Logical Drive Capacity panel.

Specify FlashCopy Repository Logical Drive Capacity panel

On the Specify FlashCopy Repository Logical Drive Capacity panel, shown in
, you can set the repository drive capacity as a percentage of the capacity
of the base logical drive.

Specifythe FlashCopy repository logical drive's capacity 8s a percentage of the base
lngical drive's capacity. The capacity used for tha FlashCopy repository logical driva
will come frorm free capacity existing on the storage subsystern as indic ated below.

Capacity Information

Base logical drive capacity: 2.000 GB
FlashCopy logical drive capacity: 2.000 GB
Free capacity used: 142.203 GB an array 1

FlashCopy Repository logical drive capacity= 0,400 GB
a0 = percent (%) of base logical drive

Free capacity remaining=141.803 GB

Cancel | Help |

= Back

SJ000840

Figure 8. Specify Repository Logical Drive Capacity panel

percent (%) of base logical drive
This field sets the FlashCopy repository logical drive capacity as a
percentage of the base logical drive. The default is 20%.

If you calculate a different capacity using the procedure described in
['Estimating FlashCopy repository logical drive capacity” on page 9, you can
increase or decrease the percentage in the percent (%) of base logical
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drive field until the FlashCopy Repository Logical Drive Capacity value
matches the estimated capacity that you calculated. You might need to
round up the number.

Preview panel

The Preview panel, shown in , displays the parameters that you have
specified for the FlashCopy logical drive and the FlashCopy repository logical drive.
If you click Finish on this panel, the FlashCopy logical drive create process initiates.

E= Create A FlashCopy Logical Drive Wizard - Praview

AR

AFlashCopy logical drive and associated FlashCopy repository [ogical drive will be
created with the following pararmeters. Select Finish to create the logical drives.

@ FlashCopy Logical Drive Parameters

MName: Datavol-1
FlashCopy logical drive capacity: 2.000 GB

=] FlashCopy Repositary Logical Drive Parameatars

Name: Datavol-R1
FlashCopy Repository logical drive capacity: 0.6B0 GB (34% of base logical drive ea...
Capacity used from: Free Capacity 142.203 GB on array 1

Cancel | Help |

= Back |

S$J000841

Figure 9. Preview panel

Creating a FlashCopy logical drive

20

You can create a FlashCopy logical drive using the Create FlashCopy Logical Drive
wizard. This section describes how to create a FlashCopy logical drive by
performing the following procedures, in the order that they are listed:

1. [‘Prepare the host operating system” on page 21|
2. [‘Create a FlashCopy logical drive using the FlashCopy Logical Drive wizard” on|

page 21|

3. [‘Mapping the FlashCopy logical drive to the host” on page 22|
4. [‘Configure the host for the FlashCopy logical drive” on page 25

Attention: Failure to complete the procedures that are required for your host
operating system can result in an inaccurate point-in-time image of the base logical
drive.
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Restriction: You cannot create a FlashCopy logical drive of a base logical drive
that is the secondary logical drive in a Remote Mirror.

Prepare the host operating system

Before you use the Create FlashCopy Logical Drive wizard to create a FlashCopy
logical drive, you must complete the following steps to prepare the host operating
system:

1. Stop the host application that is accessing the base logical drive.

2. Synchronize the file system and flush the operating system cached I/Os to
disks.

In Microsoft® Windows®, the utility SMrepassist can be used to flush the
operating systems cache 1/O before a FlashCopy logical drive is created. For
more information on the SMrepassist utility, see the “SMrepassist” topic in the
storage subsystem online help.

3. Unmount the base logical drive, if possible.

It might not be convenient to stop database applications. In this case, place the
application into a backup mode or place it in an acquiesced state while you create
the FlashCopy logical drive. Back up the application recovery files, such as role
back and redo logs, because these files might be located in different physical disk
storage or on different logical drives.

After you have prepared the host operating system, you can create a FlashCopy
logical drive using the wizard, as described in the next section.

Notes:

1. Unmounting the base logical drive does not apply when the base logical drive is
the root disk of the host operating system.

2. If you plan to use the FlashCopy logical drive at a later date, do not unmount or
stop 1/O activity to the base logical drive at this time. You must perform these
activities immediately before you initiate the task to create the FlashCopy logical
drive.

Create a FlashCopy logical drive using the FlashCopy Logical Drive

wizard

After you prepare the host operating system, create a FlashCopy logical drive using
the FlashCopy Logical Drive wizard, which you access through SMclient.

Before you begin: You can refer to ['Previewing the FlashCopy Logical Drivel
lv_vizard” on page 12| to view screen captures of the FlashCopy Logical Drive wizard
panels and read descriptions of the parameters.

Perform the following steps to create a FlashCopy logical drive:

1. Select a base logical drive from the Logical/Physical view of the Storage
Manager Subsystem Management window.

2. Click Logical Drive » FlashCopy » Create.

Note: If the FlashCopy logical drive is to be based on the root disk of the host
operating system, the final point-in-time image might not be completely
consistent with the base logical drive.

3. Review the information in the initial panel. Click OK to proceed to the wizard
introduction panel.
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Follow the instructions on each wizard panel, and click Next when you are
ready to continue to the next panel.

Note: Each wizard panel has context-sensitive help. Click Help on a particular
panel to receive help for that panel.

On the final Preview panel, which displays the associated logical drives and the

components that make up the FlashCopy relationship, click Finish to continue.

The FlashCopy drives are now displayed in the Logical/Physical view of the

Subsystem Management window.

Restart the host application. After you create one or more FlashCopy logical

drives, mount the base logical drive and restart the host application using that

base logical drive.

If you did not choose automatic mapping when using the wizard, go to [‘Mapping the

FlashCopy logical drive to the host.”] If you chose automatic mapping, go to

‘Configure the host for the IEIashCopy logical drive” on page 25,

Note: You are not done creating the FlashCopy logical drive until you have

completed the procedure described for your host operating system in
[Configure the host for the FlashCopy logical drive” on page 25.|

Mapping the FlashCopy logical drive to the host

22

Use the Mappings view in the SMclient to assign logical drive-to-LUN mappings
between the FlashCopy logical drive and the host that will access the FlashCopy
logical drive.

Note: Because the FlashCopy logical drive is an exact copy of the original base

logical drive, if you map both a base logical drive and its associated
FlashCopy logical drives to the same host, it can result in conflicts if the host
operating systems or the logical volume manager software depend on the
data in the logical drive to identify it. For more information on how to properly
configure your host operating system, see [‘Configure the host for the]
[FlashCopy logical drive” on page 25

Perform the following steps to map the FlashCopy logical drive to a host:

In the SMclient, open the Mappings view of the Subsystem Management
window, as shown in [Figure 10 on page 23| The newly-created FlashCopy
logical drive displays in the undefined mapping section.
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[T LogicalPhysical Wiew | 3 Mappings View |
Logical

% Storage Subsystem ITSO

P

FE DataVol-1 =LUN?

Eﬁ’ II Default Group

ELB HosStAAE18
!Host Ports

Eﬁf E-E i] Host Group ReserchDEPT

ELB Host ReserchSRV
!Host Ports

=B [ HostaaE19

——f—! Host Ports

LIS

$J000843

Figure 10. Undefined FlashCopy disk

2. Right-click the host or host group to which you want to map the drive, and click
Define Additional Mapping, as shown in

i TS0 - IBM FASIT Storage Manager 8 (Subsystem Management) [ (O] x|
Storage Subsystern  View Mappings  Array  Loogical Drive  Contraller  Drive  Help

B2 |

[T LogicalPhysical View [ mappings view |

Topology Defined Mappings
%Btorage Subsystern TS0 1| Logical Driwe Mame | Accessible Elyl LLIM | Logical Drive Capaciml Type |
=-7f Undefined Mappings %Access Default Group 31 ACCE..

- DataVol-1 =LUN?
-:| Default Graup
o[ HostasETs

Define Host...

I‘!ﬂ E Host Backupsr
=B Host Ports

------ B HostPort Delete...

Define Storage Partitioning...

—ZI@ Host Group Resercl  Rename...
= [ Host ResearchsRy

AI II\- Hnct Pare I 5 ILI
o a

Partitions AllowediUsed: G472
SJ000844

Figure 11. Define Additional Mapping

3. In the Define Additional Mapping window, specify the following options, as
shown in|Figure 12 on page 24}

« Select the host or host group.
« Set the LUN number.
» Select the FlashCopy logical drive.
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» Click Add.

Define Additional Mapping [ x|

Select a host group or host, logical unit number (LUN)Y, and logical
drive to create a logical drive-ta-LIN mapping.

Host group or host:

Host Group Backup-server

Logical unit number (LURN) (0 to 31):
| 1] Yi

Logical Drrive:

Logical Drive Mame Logical Drive Capacity |
Dataval-1 IGB

| Close | Help |

$§J000845

Figure 12. The Define Additional Mapping window

When you are finished, the FlashCopy logical drive is available to the host or
host group, as shown in[Figure 13 on page 25|
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Figure 13. Mapped FlashCopy logical disk

In the mapping example shown in [Figure 12 on page 24 and [Figure 13} the
FlashCopy logical drive named DataVol-1 is made available to the backup
server host group. This enables the backup server to access and mount the
drive as part of its own file system. It also allows a local backup to be
performed by the backup application software.

It is possible to map the FlashCopy logical drive to the same server that owns
the base logical drive. However, immediately after you create the FlashCopy,
the two logical drives are exactly the same (a block-by-block copy). Many
operating systems do not tolerate seeing an exact duplicate logical drive. You
might need to complete other steps, such as restarting your computer or
running the Hot_Add utility, before you can access the FlashCopy logical drive.
For more information, see the Storage Manager 8.4 Installation and User’s
Guide for your operating system.

Note: If you use this FlashCopy on a regular basis (for example, for backup
purposes), use the Disable FlashCopy and Re-create FlashCopy options
to reuse the FlashCopy. Using these options preserves the existing
mappings to the FlashCopy logical drive. For more information, see
“Disabling a FlashCopy logical drive” on page 40|and [‘Re-creating a|
FlashCopy logical drive” on page 42

After you have mapped the FlashCopy logical drive, configure the host, as
described in[‘Configure the host for the FlashCopy logical drive.”|

Configure the host for the FlashCopy logical drive

After you use the Create FlashCopy Logical Drive wizard to create the FlashCopy
logical drive and map the FlashCopy logical drive to the host, you must complete
some additional steps to configure the host operating system.

Complete the procedure that is applicable for your host operating system:
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* [“Instructions for AIX”|

* [“Instructions for HP-UX and Linux” on page 28|

« [“Instructions for Solaris” on page 30|

* [“Instructions for Windows 2000 and Windows Server 2003” on page 31|
+ [“Instructions for Windows NT®” on page 31|

. |“Instructions for Novell NetWare” on page 31|

Attention: You must complete the procedure described for your host operating
system in this section. Failure to do so can result in an inaccurate point-in-time
image of the base logical drive.

Using the script editor and the command-line interface

If you are using an AlX, HP-UX, Linux or Solaris host, you must use the script
editor or command line interface (SMcli) to configure your host for the new
FlashCopy logical drive.

You can use the script editor to create or edit a script file, save a script file to the
local disk of the Storage Management station, or load a script file from disk. You
can also use SMcli to issue individual commands to the scripting engine from the
host operating system command shell or to call complete prewritten scripts.

For more information about how to use SMcli and the script editor, click on the Help
tab on the Enterprise Management window.

Instructions for AIX
Use the following procedures on a host that is running AIX using Logical Volume
Manager (LVM).

Restrictions:

» FlashCopy logical drives can be created only for AIX arrays. If an array has more
than one logical drive, you must create a FlashCopy logical drive for each logical
drive in the array.

» AIX does not support the Fail writes to base logical drive option of the
repository full policy. Selecting this option might cause data loss on the base
logical drive. You must ensure that the repository full policy is set to the default
option, Fail FlashCopy logical drive.

For information about how to set the repository full policy, see |“Changing|
[FlashCopy repository logical drive properties” on page 39.|

Before you begin:

 Read the information in[‘Planning a FlashCopy logical drive” on page 8| and
[“Using the script editor and the command-line interface.]

» Perform the procedures that are described in the previous sections:
1. [‘Prepare the host operating system” on page 21|

2. [‘Create a FlashCopy logical drive using the FlashCopy Logical Drive wizard’|
on page 21|
3. ['Mapping the FlashCopy logical drive to the host” on page 22|

Perform the following steps to configure the AIX host for the new FlashCopy logical
drives:

1. Log in to the host as root.

2. Ensure that the host operating system recognizes the FlashCopy logical drives.
At the host prompt, type the following command and press Enter.
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|cfgmgr |

Several minutes might pass while the operating system accesses the drives.
When the operation completes, a window opens with the following message:

|Device nodes have been updated |

The new logical drives are now available from the operating system.
3. At the host prompt, type the following command and press Enter.

Ispv

A list of the physical drives that are recognized by the operating system is
displayed.

4. Look for the operating system device name of your FlashCopy logical drive in
the list. The list shows a physical logical drive ID (PVID) for the FlashCopy
logical drive. This is the same as the PVID for the associated base logical
drive, because the FlashCopy logical drive contains the same array data
structures as the base logical drive.

5. Clear the PVID for the FlashCopy logical drives. At the host prompt, type the
following command and press Enter.

chdev -1 os_device_name -a pv=clear

where os_device_name is the operating system device name of the FlashCopy
logical drive.

Repeat this step for each FlashCopy logical drive in the AIX array.

6. Re-create a new array using the recreatevg command. This command reads
the array data structure inside a logical drive and reconstructs it. It also
allocates new physical logical drive identifiers (PIDs) to the FlashCopy logical
drives and enables access to the FlashCopy logical drive for the selected host.

At the host prompt, type the following command and press Enter:

recreatevg -y logical drivegroupname -L /directoryname os_device_name

where:

 logical drivegroupname is the name that you want to assign to the
FlashCopy array.

 directoryname is the name of the directory where you want to mount the
FlashCopy logical drive.

* 0s_device_name is the operating system device name of the FlashCopy
logical drive. If your AIX array contains more than one FlashCopy logical
drive, add an os_device_name for each logical drive.

The array is re-created, and contains the FlashCopy logical drive or drives.

7. Mount the FlashCopy logical drive to its intended host. At the host prompt, type
the following command and press Enter.

mount mount-point

where mount-point is the name of the filesystem that being mounted. Include
the directoryname that was used in step @

8. Ensure that the logical drives are back online. At the host prompt, type the
following command and press Enter.

df -k
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A list of the mounted disks displays.

9. Use the FlashCopy logical drive with your backup application or with another
application.

10. When the FlashCopy logical drive is no longer required, unmount the
filesystem. At the host prompt, type the following command and press Enter.

umount mount-point

11. Disable or delete the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and avoids any reduction
in performance that might occur if the FlashCopy logical drive remains
available.

To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable
or Delete.

12. Delete the array that you created in step[6 on page 27 that contains the
FlashCopy logical drives. At the host prompt, type the following commands and
press Enter.

|varyoffvg logical drivegroupname exportvg logical drivegroupname

where logical drivegroupname is the name of the FlashCopy array.

Instructions for HP-UX and Linux

Use the following procedures on a host that is running HP-UX 11.0 (or higher) and
uses LVM (or higher). Failure to complete the steps listed can result in an
inaccurate point-in-time image of the base logical drive.

Before you begin:

« Read the information in[‘Planning a FlashCopy logical drive” on page 8| and
[‘Using the script editor and the command-line interface” on page 26.|

» Perform the procedures that are described in the previous sections:
1. [‘Prepare the host operating system” on page 21|
2. |‘Create a FlashCopy logical drive using the FlashCopy Logical Drive wizard’|

on page 21|

3. [‘Mapping the FlashCopy logical drive to the host” on page 22|

Perform the following steps to configure the HP-UX host for the new FlashCopy
logical drives:

1. At the host prompt, type the following command and press Enter.

ioscan -fn

A list of the mapped devices that are recognized by the host displays.

Note: If the required device names are not displayed by using this command,
type the following command at the host prompt and press Enter.

insf
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2. Remount the base logical drive to its original host.

Note: If I/O activity to the base logical drive was stopped or data transfer was
suspended, resume |/O activity to the base logical drive or re-enable data
transfer at this time.

3. Perform the following steps to import the FlashCopy logical drives into the LVM:

a. Create a new directory for the new array, as shown in the following

example.

[mkdir /dev/vgo2 |

b. Create a group node for the new array, as shown in the following example.

|mknod /dev/vg02/group c 64 -0x020000 |

c. Import the FlashCopy logical drive LUNs. At the host prompt, type the
following command and press Enter.

vgimport /dev/vg02 FlashCopy-block-node-1 FlashCopy-block-node-2

The following example addresses how to handle redundancy with multiple
paths. The two paths or nodes represent the primary and alternate paths of
the FlashCopy volume.

vgimport /dev/vg02 /dev/dsk/c66t0dl /dev/dsk/c69t0d1

Note: You must verify that the /dev/dsk device files exist on the FlashCopy
logical drive. Use the SMdevices utility or the HP-UX ioscan utility to
perform the verification.

The system displays a warning indicating that a backup of the array that is
being imported might not exist on the host. This message is only a warning
and requires no response. The import operation continues and completes
successfully.

The backup for this array is created later, when it is exported.
d. Activate the new array, as shown in the following example:

vgchange -a y /dev/vg02

4. If a file system existed on the base logical drive, then it also exists on the
FlashCopy logical drive. Before you mount the FlashCopy logical drive,
however, perform a file system check to ensure that the file system is
consistent, for example:

fsck /dev/vg02/1vol01

5. Mount the FlashCopy logical drive to its intended host.

6. Use the FlashCopy logical drive with your backup application or with another
application.

7. Unmount the FlashCopy logical drive.
8. Disable or delete the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
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drive. Then, when you need to create a different FlashCopy of the same base

logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and avoids any reduction
in performance that might occur if the FlashCopy logical drive remains available.

To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable or
Delete.

Instructions for Solaris

Use the following procedure on a host that is running Solaris 7 and 8. Failure to
complete the steps listed can result in an inaccurate point-in-time image of the base
logical drive.

Before you begin:

+ Read the information in[“Planning a FlashCopy logical drive” on page 8| and
[‘Using the script editor and the command-line interface” on page 26.|

» Perform the procedures that are described in the previous sections:
1. [‘Prepare the host operating system” on page 21|
2. [‘Create a FlashCopy logical drive using the FlashCopy Logical Drive wizard’|

on page 21|

3. [‘Mapping the FlashCopy logical drive to the host” on page 22|

Perform the following steps to configure your operating system:
1. At the host prompt, type the following command and press Enter.

/etc/raid/bin/hot_add

This step ensures that the operating system is aware of the newly-created
logical drives, without having to restart the host.

2. Run the SMdevices utility to associate the LUN with a host operating system
device and to ensure that the FlashCopy logical drive is recognized by the host.

This step ensures that the logical drive hame and the operating system device
name (assigned by the operating system) correlate.

3. If you plan to use the FlashCopy logical drive immediately, go to step If you
plan to use the FlashCopy logical drive at a later date, disable the FlashCopy
logical drive now. Click Logical Drive » FlashCopy » Disable in the Subsystem
Management window.

Note: If I/O activity to the base logical drive was stopped or data transfer was
suspended, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

4. Mount the FlashCopy logical drive to its intended host.

5. Use the FlashCopy logical drive with your backup application, for speculative
testing, or with another application.

6. Unmount the FlashCopy logical drive.
7. Disable or delete the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and avoids any reduction
in performance that might occur if the FlashCopy logical drive remains available.
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To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable or
Delete.

Instructions for Windows 2000 and Windows Server 2003
You cannot add the FlashCopy logical drive to the same Windows 2000 or Windows

Server 2003 server that the FlashCopy base logical drive is mapped to. You must
add the FlashCopy logical drive to another Windows 2000 or Windows Server 2003
server, or unmap the base logical drive from the server that it is mapped to.

Complete the following steps to configure your host for the new FlashCopy logical
drives:

1. Run the hot_add utility to let the system recognize the newly-added FlashCopy
logical drive.

Note: If the system does not recognize the FlashCopy logical drive after you
run the hot_add utility, restart the server.

2. In the System Management window, open the Disk Management directory and
assign a drive letter or mount point to the new FlashCopy logical drive.

3. When you no longer need the FlashCopy logical drive, remove the drive letter or
mount point from the Disk Management directory before you delete the
FlashCopy logical drive.

Instructions for Windows NT®
Complete the following steps to configure your host for the new FlashCopy logical
drive:

1. Run the hot_add utility to let the system recognize the newly-added FlashCopy
logical drive.

Note: If the system does not recognize the FlashCopy logical drive after you
run the hot_add utility, restart the server.

2. Resolve duplicate logical drive signatures by typing the following command:

SMrepassist -r

3. In the NT4 Disk Administrator window, assign a drive letter to the new
FlashCopy logical drive.

4. When you no longer need the FlashCopy logical drive, open the NT4 Disk
Management window and remove the drive letter before you delete the
FlashCopy logical drive.

Instructions for Novell NetWare
You cannot add the FlashCopy logical drive to the same NetWare server where the

FlashCopy base logical drive is located. You must add the FlashCopy logical drive
to another NetWare server, or unmap the base logical drive from the server that it is
mapped to.

Complete the following steps to configure your host for the new FlashCopy logical
drive:

1. Run the hot_add utility to let the system recognize the newly-added FlashCopy
logical drive.

Note: If the system does not recognize the FlashCopy logical drive after you
run the hot_add utility, restart the server.
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2. Type the logical drive in the command window, or use the Disk Management
menu in the ConsoleOne window to verify that the drive is added.

Reusing a FlashCopy logical drive

Typically, after a FlashCopy logical drive is created, it is disabled until a new
point-in-time image of the same base logical drive is needed.

To create a new point-in-time image of the same base logical drive, complete the
procedure that is applicable for your host operating system:

« [‘Instructions for AIX’|
» [“Instructions for HP-UX and Linux” on page 33|
« [Instructions for Solaris” on page 35|

Instructions for AIX

Before you begin: Stop all I/O activity to the base logical drive, or suspend data
transfer. This ensures that you capture an accurate point-in-time image of the base
logical drive.

Perform the following steps to create a new point-in-time image of the same base
logical drive:

1. Unmount the filesystems in the array on which the FlashCopy logical drive is to
be based. At the host prompt, type the following command and press Enter.

umount mount-point

where mount-point is the name of the filesystem that is being unmounted.

2. Ensure that the host operating system recognizes the FlashCopy logical drive.
At the host prompt, type the following command and press Enter.

cfgmgr

Several minutes might pass while the operating system accesses the drives.
When the operation completes, a window opens that contains the following
message:

Device nodes have been updated

The new logical drives are now available from the operating system.

3. Start the storage management software. The Enterprise Management window
opens.

4. Launch a Subsystem Management window using one of the following methods:

» Select the storage subsystem in either the Device Tree view or Device
Table. Click Manage Device on the toolbar or click Tools + Manage
Device.

* Right-click the storage subsystem in the Device Tree view or from the
Device Table, and click Manage Device.

» Double-click a storage subsystem node in the Device Table.

+ Select the storage subsystem in the Device Tree view or from the Device
Table, and press Enter.

The Subsystem Management window opens in a separate window.
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5. In the Storage Management software, re-create the FlashCopy logical drive.
Click Logical Drive » FlashCopy » Re-create in the Subsystem Management
window.

6. Clear the PVID for the FlashCopy logical drives. At the host prompt, type the
following command and press Enter.

chdev -1 os_device_name -a pv=clear

where 0s_device_name is the operating system device name of the FlashCopy
logical drive.

Repeat this step for each FlashCopy logical drive in the AIX array.

7. Re-create a new array. At the host prompt, type the following command and
press Enter:

recreatevg -y logical drivegroupname -L /directoryname os_device_name

where:

* logical drivegroupname is the name that you want to assign to the
FlashCopy array.

» directoryname is the name of the directory where you want to mount the
FlashCopy logical drive.

* 0s_device_name is the operating system device name of the FlashCopy
logical drive. If your AIX array contains more than one FlashCopy logical
drive, add an os_device_name for each logical drive.

The array is re-created and contains the FlashCopy logical drive or drives.

8. Mount the filesystem to its intended host. At the host prompt, type the following
command and press Enter:

mount mount-point

where mount-point is the name of the filesystem that is being mounted. Include
the directoryname that was used in step ﬂ

9. Ensure that the logical drives are back online. At the host prompt, type the
following command and press Enter:

df -k

A list of the mounted disks is displayed.

10. Use the FlashCopy logical drive with your backup application or other
application.

11. Disable the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.

Instructions for HP-UX and Linux

Before you begin: Stop all I/O activity to the base logical drive, or suspend data
transfer. This ensures that you capture an accurate point-in-time image of the base
logical drive.

Chapter 2. Overview of FlashCopy 33



34

Perform the following steps to create a new point-in-time image of the same base
logical drive:

1. Start the storage management software. The Enterprise Management window
opens.

2. Launch a Subsystem Management window using one of the following methods:

+ Select the storage subsystem in either the Device Tree view or from the
Device Table. Then, click Manage Device on the toolbar or click Tools»
Manage Device.

* Right-click the storage subsystem in the Device Tree view or from the
Device Table, and click Manage Device.

* Double-click a storage subsystem node in the Device Table.
» Select the storage subsystem in the Device Tree view or from the Device
Table, and then press Enter.
The Subsystem Management window opens in a separate window.
3. Unmount the base logical drive.

4. In the storage management software, re-create the FlashCopy logical drive.
Click Logical Drive » FlashCopy » Re-create in the Subsystem Management
window.

5. Remount the base logical drive to its original host.

Note: If you stopped I/O activity to the base logical drive or suspended a data
transfer, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

6. Perform the following steps to import the FlashCopy logical drives into the
Logical Volume Manager:

a. Create a new directory for the new array, as shown in the following
example.

mkdir /dev/vgo2 |

b. Create a group node for the new array, as shown in the following example.

|mknod /dev/vg02/group c 64 -0x020000 |

c. Import the FlashCopy logical drive LUNs. At the host prompt, type the
following command and press Enter.

|vg1mpor‘t /dev/vg02 FlashCopy-block-node-1 FlashCopy-block-node-2 ... |

An alternate command can be used, as shown in the following example.

|vg1’mport /dev/vg02 /dev/dsk/c66t0d1 /dev/dsk/c69t0d1 |

Note: You must verify that the /dev/dsk device files exist on the FlashCopy
logical drive. Use the SMdevices utility or the HP-UX ioscan utility to
perform this verification.

A warning is displayed indicating that a backup of the array that is being
imported might not exist on the host. This message is only a warning and
can be ignored. The import operation continues and completes
successfully.

IBM TotalStorage FAStT Storage Manager Copy Services User's Guide



The backup for this array is created when it is exported later.
d. Activate the new array, as shown in the following example.

vgchange -a y /dev/vg02

7. If a file system existed on the base logical drive, then it also exists on the
FlashCopy logical drive. However, before you mount the FlashCopy logical
drive, perform a file system check to ensure that the file system is consistent.
For example:

fsck /dev/vg02/1vo101

8. Mount the FlashCopy logical drive to its intended host.

9. Use the FlashCopy logical drive with your backup application or other
application.

10. Unmount the FlashCopy logical drive.
11. Disable the FlashCopy logical drive after it is no longer needed.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.

Instructions for Solaris

Perform the following steps to create a new point-in-time image of the same base

logical drive:

1. Unmount the base logical drive.

2. In the storage management software, re-create the FlashCopy logical drive.
Click Logical Drive » FlashCopy » Re-create in the Subsystem Management
window.

3. Remount the base logical drive to its original host.

4. Mount the FlashCopy logical drive to its intended host.

Note: If you stopped I/O activity to the base logical drive or suspended data
transfer, resume I/O activity to the base logical drive or re-enable data
transfer at this time.

5. Use the FlashCopy logical drive with your backup application or with another
application.

6. Unmount the FlashCopy logical drive.

7. After the FlashCopy logical drive is no longer needed, disable the FlashCopy
logical drive.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and stops any
performance reduction that might occur if the FlashCopy logical drive remains
available.
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Instructions for Windows

Perform the following steps to create a new point-in-time image of the same base
logical drive:

1.
2.
3.

6.
7.
8.

Stop the host application or suspend data transfer.
Run SMrepassist -f on the host where the FlashCopy logical drive resides.
Disable the FlashCopy logical drive.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and avoids any reduction
in performance that might occur if the FlashCopy logical drive remains available.

To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable or
Delete.

Run SMrepassist -f on the host where the base logical drive resides.

Re-create the FlashCopy logical drive. For instructions about how to re-create a
FlashCopy logical drive, see [‘Re-creating a FlashCopy logical drive” on page]

Restart the host application or re-enable data transfer.
The FlashCopy logical drive is ready to use.
Disable the FlashCopy logical drive until it is required again.

Instructions for Novell NetWare

Perform the following steps to create a new point-in-time image of the same base
logical drive:
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1.
2.
3.
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Stop the host application or suspend data transfer.

Unmount the base logical drive.

Re-create the FlashCopy logical drive. For instructions about how to re-create a
FlashCopy logical drive, see ['‘Re-creating a FlashCopy logical drive” on page|
Remount the base logical drive.

Restart the host application.

Remount the FlashCopy logical drive.

The FlashCopy logical drive is ready to use (for backup, speculative test, or
upgrades).

Unmount the FlashCopy logical drive.

Disable the FlashCopy logical drive until it is required again.

If you disable the FlashCopy logical drive instead of deleting it, you can retain
the FlashCopy logical drive and its associated FlashCopy repository logical
drive. Then, when you need to create a different FlashCopy of the same base
logical drive, you can re-create the disabled FlashCopy logical drive. This takes
less time than creating a new FlashCopy logical drive and avoids any reduction
in performance that might occur if the FlashCopy logical drive remains available.
To disable or delete a FlashCopy logical drive, in the Subsystem Management
window, right-click the FlashCopy logical drive icon and select either Disable or
Delete.
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Performing FlashCopy tasks

This section describes the following FlashCopy tasks:
» Viewing the FlashCopy logical drive status

» Disabling a FlashCopy logical drive

* Re-creating a FlashCopy logical drive

* Resizing a FlashCopy repository logical drive

» Deleting a FlashCopy logical drive

* Viewing and recovering missing logical drives

Viewing the FlashCopy logical drive status

You can determine the status of the FlashCopy logical drive by viewing the icons.
The icons change depending of the state of the drive. The logical drive component
property display is also useful in determining the state of the logical drives.

Use the FlashCopy Repository Logical Drive - Properties window to view the
FlashCopy repository logical drive base and capacity properties. You can also use
this window to specify the capacity percentage full and the action to be taken if the
FlashCopy repository logical drive becomes full.

The progress of the modification operations displays at the bottom of the window.

FlashCopy icon states

To view the FlashCopy icon, open the Storage Management Device Manager GUI
Physical/Logical view. The icon states are shown in

FlashCopy status representation in logical view

$J000847

Figure 14. FlashCopy icon states
What to do if the FlashCopy repository logical drive becomes full

If the FlashCopy repository logical drive becomes full, you should first, view the
current FlashCopy logical drive properties, then you can change the failure settings.
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Viewing the current FlashCopy logical drive properties: Complete the following
steps to view the current FlashCopy logical drive properties.

1. Select a FlashCopy repository logical drive in the Logical view of the Subsystem
Management window.

2. Click Logical Drive » Properties. The FlashCopy Repository Logical Drive -
Properties window opens. See [Figure 15

Base | capaciy|

Logical Dirive name: DiatavWol-R1

World-wide name: G00ADBB0N00CD466000000EC3CF4ECOA
Subsystem D (SSID): 3

Status: Optimal {1}

Owned by controller inslob A

Capacity: D.68GH

RAID level 3

Segment size: B4 KB

Modific ation priority: High

Acssociated array: 1

Read tache: Enabled

Write cache: Enabled

Wyrite cache with mirroring: Enabled

Write cache without batteries: Disahled

Flush write cache after (in seconds), 10.00
Cache read ahead multiplier: 0

Enahle hackground media scan: Disahled
Media scan with redundancy check: Disabled
Associated base logical drive: Datavol
Associated FlashCGopy logical drive: Datavol-1

Cancel Help
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Figure 15. FlashCopy repository logical drive properties

3. Click the Capacity tab to view the currently defined settings, as shown in
[Figure 16 on page 39|
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FlashCopy Repository Logical Drive - Properties

Base Capatity

Aveilable capaciy, 1.000 GB
Caparityused 0% (0 000 GHE)

Moiify when FlashCopy repository logical drive capacity reaches:

0 EI: perceni () ull

Ir FlashCopy repositony [0g(cal dive becomes Tull...
@ Fail FlashCopy Ingical driva

" Fail writes to base logical drive
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Figure 16. Repository capacity settings

Changing FlashCopy repository logical drive properties: |If the repository full
policy is set to Fail FlashCopy logical drive (default setting), the data is not
recoverable when the drive becomes full and FlashCopy cannot be accessed. If this
situation occurs, you can perform one of the following actions:

» Delete the FlashCopy logical drive
* Re-create the FlashCopy logical drive to create a new point-in-time image

If the repository full policy is set to Fail writes to base logical drive, the data is
accessible. However, all write requests to the base logical drive are rejected until
the FlashCopy repository logical drive capacity is increased. This is not a
recommended setting.

Attention: AIX does not support the Fail writes to base logical drive option of the
repository full policy. Selecting this option might cause data loss on the base logical
drive. If you are using AIX ensure that the default option, Fail FlashCopy logical
drive, is selected. Be sure to monitor the capacity of the FlashCopy repository
logical drive, because the you cannot access the FlashCopy if the repository logical
drive becomes full.

For information about increasing the capacity of a FlashCopy repository logical
drive, see [‘Resizing a FlashCopy repository logical drive” on page 43/

Notes:

1. Deleting a FlashCopy logical drive automatically deletes the associated
FlashCopy repository logical drive.
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2. Deleting a FlashCopy repository logical drive automatically deletes the
associated FlashCopy logical drive.

3. Deleting a FlashCopy logical drive, and then creating it again, forces you to stop
the host application and unmount the base logical drive while the FlashCopy is
being created again.

4. If you re-create a FlashCopy logical drive, you do not need to create a
FlashCopy repository logical drive, or remap the assigned logical drive-to-LUN
mappings between the FlashCopy logical drive and the host.

5. After you re-create the FlashCopy logical drive, you can change parameters on
the FlashCopy repository logical drive through the appropriate menu options.

6. To avoid another FlashCopy repository logical drive full failure, increase the
capacity of the FlashCopy repository logical drive. For more information, see
|“Resizing a FlashCopy repository logical drive” on page 43.|

Viewing the progress of a modification operation
The progress bar at the bottom of the FlashCopy Repository Logical Drive

Properties window displays the progress of an operation. You can view the progress
of the following operations:

» Copyback

* Reconstruction

* Initialization

* RAID level change

* Dynamic logical drive expansion
» Capacity increase

» Defragmentation

* Segment size change

Note: The storage management software cannot obtain progress information
from the storage subsystem controllers if the network management
connection to the controllers is down or if the storage subsystem is
partially managed. For more information about a partially managed
storage subsystem or an unresponsive controller or storage subsystem
condition, see the Enterprise Management window online help.

Disabling a FlashCopy logical drive
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If you no longer need a FlashCopy logical drive, you might want to disable it. As
long as a FlashCopy logical drive is enabled, your storage subsystem performance
can be impacted by copy-on-write activity that is directed to the associated
FlashCopy repository logical drive. The copy-on-write activity ends when you
disable a FlashCopy logical drive.

If you disable a FlashCopy logical drive instead of deleting it, you can retain it and
its associated repository for future use. When you need to create a different
FlashCopy of the same base logical drive, you can use the Re-create option to
re-enable the previously disabled FlashCopy. This takes less time than creating a
new FlashCopy.

When you disable a FlashCopy logical drive, note the following points:

* You cannot use that FlashCopy logical drive again until you use the Re-create
option on that logical drive.

* Only that FlashCopy logical drive is disabled. All other FlashCopy logical drives
remain functional.
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If you do not intend to re-create a FlashCopy, you can delete that FlashCopy logical
drive instead of disabling it.

Perform the following steps to disable a FlashCopy logical drive:

1. Select the FlashCopy logical drive. Right-click and select Disable, as shown in

Figure 17
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Figure 17. Choosing to disable the FlashCopy drive

2. The Disable FlashCopy Logical Drive confirmation window opens, as shown in

[Figure 18 on page 42| In this window, type Yes and click OK to begin the
disable operation.
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Figure 18. Disable FlashCopy confirmation window

The FlashCopy icon in the Physical/Logical view now displays as disabled.

Re-creating a FlashCopy logical drive
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Re-creating a FlashCopy logical drive takes less time than creating a new one. If
you have a FlashCopy logical drive that you no longer need, instead of deleting it,
you can reuse it (and its associated FlashCopy repository logical drive) to create a
different FlashCopy logical drive of the same base logical drive.

When you re-create a FlashCopy logical drive, note the following points:
* The FlashCopy logical drive must be in either an optimal or a disabled state.

If the FlashCopy logical drive is in an optimal state, the process first disables and
then re-creates the FlashCopy logical drive. This process invalidates the current
FlashCopy.

» All copy-on-write data on the FlashCopy repository logical drive is deleted.

* When you use the Re-create option, the previously-configured FlashCopy name,
parameters, and FlashCopy repository logical drive are used.

FlashCopy and FlashCopy repository logical drive parameters remain the same
as the previously-disabled FlashCopy logical drive and its associated FlashCopy
repository logical drive. After you re-create a FlashCopy logical drive, you can
change parameters on its associated FlashCopy repository logical drive through
the appropriate menu options.

* The system retains the original names for the FlashCopy and FlashCopy
repository logical drives. You can change these names, however, after the
Re-create option completes.

Before you re-create a FlashCopy logical drive, go to [“Prepare the host operating
lsystem” on page 21| and perform the procedure to prepare your host operating
system. Then, perform the following steps to re-create a FlashCopy drive:

1. Select the FlashCopy logical drive. Right-click and select Re-Create, as shown
in|Figure 19 on page 43

IBM TotalStorage FAStT Storage Manager Copy Services User's Guide



#a TS0 - IBM FAS{T Starage Manager 8 {Subsystem Management)
i Starage Subsystem View  Mappings  Arsy Logical Drive  Condroller  Drve  Help

| EFl T el E T e e e i e
[ LogicalPhysical View | 3 Mappings Viewr

Logical Hoas B | RSl caliies

[ storage Supspsten TS0 : Contrallar Enclasura

|

| o B arrar 1 (RAD ) .
[ L@ Flashaaurs (566) |
f !
= F@ Vser/ol (30B) |

w rDrive Enclosure O
View Associated Componants @
o e e b e b B

,ﬁ DAl Goto FlashCopy Reposiiony Logical Dirive
| @UseNoR| pogre

al Frae Capa Rename...

A [B i=F =
B [E = i | EI

Lroan e,

| Properies

T @ 60 Faritions Allowedsed, 843

$J000854

Figure 19. Recreating a FlashCopy logical drive

2. The Re-create FlashCopy Logical Drive window opens. Type Yes and click OK.

This disables and re-creates the FlashCopy logical drive (if it had not been
previously disabled) and displays it in the Logical view in an Optimal state. The
creation timestamp shown on the FlashCopy Logical Drive Properties window is
updated to reflect the new point-in-time image. Copy-on-write activity resumes to
the associated FlashCopy repository logical drive.

Resizing a FlashCopy repository logical drive

Use this option to increase the storage capacity of an existing FlashCopy repository
logical drive. Typically, this option is used when you receive a warning that the
FlashCopy repository logical drive is in danger of becoming full.

You can achieve an increase in storage capacity by using one of the following
methods:

» Use the free capacity that is available on the array of the FlashCopy repository
logical drive.

» Add unconfigured capacity (in the form of unused drives) to the array of the
FlashCopy repository logical drive. Use this method when no free capacity exists
on the array.

Note: A maximum of two drives can be added at one time to increase
FlashCopy repository logical drive capacity.

The storage capacity of a FlashCopy repository logical drive cannot be increased if
any of the following conditions exists:

* One or more hot spare drives are in use in the logical drive.
* The logical drive has a non-optimal status.
* Any logical drive in the array is in any state of modification.
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The controller that owns this logical drive is in the process of adding capacity to
another logical drive. Each controller can add capacity to only one logical drive at
a time.

No free capacity exists in the array.
No unconfigured capacity (in the form of drives) is available to add to the array.

Perform the following steps to resize a FlashCopy repository drive:

1.

3.

Select a FlashCopy repository logical drive in the Logical view of the Subsystem
Management window.

Click Logical Drive » Increase Capacity.

Note: If no free capacity or unconfigured capacity is available, the Increase
Capacity option is not available.

The Increase Repository Capacity window opens. You can see the FlashCopy
repository logical drive name, the associated FlashCopy logical drive name, the
associated base logical drive name, the current capacity, and the amount of free
capacity that is available for the selected repository.

If free capacity is available, the maximum free space is shown in the Increase
Capacity by field. If there is no free capacity on the array, the value that is
shown in the Increase Capacity by field is 0. Add drives to create free capacity
on the array of the standard logical drive.

Use one of the following two methods to increase capacity:
» Using the free capacity on the array of the FlashCopy repository logical drive:

a. Accept the final capacity increase or use the Increase Capacity by field
to adjust the capacity. Click OK.

b. A confirmation window displays. Type Yes and click OK to continue.

The Logical view is updated. The FlashCopy repository logical drive with
its capacity increased shows a status of Operation in Progress, together
with its original capacity and the total capacity being added.

c. The Free Capacity node involved shows a reduction in capacity. If all of
the free capacity is used to increase the logical drive size, then the Free
Capacity node involved is removed from the Logical view.

» Adding unconfigured capacity (drives) to the array of the FlashCopy
repository logical drive:

a. If there are no unassigned drives available and empty slots in the drive
enclosures are available, insert new drives.

If there are no unassigned drives available, and there are no empty slots
available in the drive enclosures, install another drive enclosure and
additional drives.

b. Click Add Drives.

The Increase Repository Capacity - Add Free Capacity window opens.
Details about enclosure, slot, and usable capacity for the available free
drives are displayed.

Note: The drives that are displayed have a capacity that is either
equivalent to or larger than those that are already employed by the
array.

c. Select a single drive, or two drives, to be added:
— Press Ctrl+Enter to select the nonadjacent drives.
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— Press Shift+Enter to select the adjacent drives.
d. Click Add.

The Add Free Capacity window closes. Check the Drives to add
[enclosure, slot] field to ensure that the correct drives are added.

e. Accept the final capacity or use the Increase Capacity by field to adjust
the capacity.

f. Click OK.

g. A confirmation window opens. Type Yes to confirm the operation, and click
OK to continue.

The Logical view is updated. The FlashCopy repository logical drive that is
having its capacity increased shows a status of Operation in Progress. It
also shows its original capacity and the total capacity that is being added.
The Free Capacity node involved in the increase shows a reduction in
capacity.

If all of the free capacity is used to increase the size of the logical drives,
then the Free Capacity node that is involved is removed from the Logical
view.

If a Free Capacity node did not exist before you added capacity and not all of
the capacity that is added will be used to increase the capacity of the
FlashCopy repository logical drive, a new Free Capacity node is created and
displayed in the Logical view.

Unassigned drives (unconfigured capacity) that are added to increase the
FlashCopy repository logical drives capacity change in the Physical view to
assigned drives. They become associated to the array of the FlashCopy
repository logical drive.

4. View the progress of the capacity increase process. Select the FlashCopy

repository logical drive. Click Logical Drive » Properties.

The FlashCopy Repository Logical Drive - Properties window opens. A progress
bar at the bottom of the window indicates the status of the capacity increase.

Deleting a FlashCopy drive

Use this option to delete a FlashCopy logical drive that is no longer needed for
backup or application testing purposes. This option results in an increase of free
capacity in the array or additional unconfigured capacity.

Notes:

1.

2.

When you delete a logical drive, all data on the logical drive is lost. Back up the
data and stop all I/0O before you perform this operation, if necessary.

If a file system is mounted on the logical drive, unmount it before you perform
this operation.

When you delete a base logical drive, the associated FlashCopy logical drive
and FlashCopy repository logical drive are automatically deleted.

Perform the following steps to delete a FlashCopy drive:

1.

Select the FlashCopy logical drive in the Logical view.

2. Click Logical Drive » Delete, as shown in|Figure 20 on page 46|

Chapter 2. Overview of FlashCopy 45



46

52 ITSO - IBM FASAT Storage Manager 8 (Subsystem Management)
Storage Subsystem  View  Mappings  Array  Logical Orive  Confroller Drive  Help

B B 2 % 8|

@ LogicalPhysical View | (35 Mappinas View |

Logical Physical

EE storane Subsystem TS0 2 antoller Enclosure

= Bg a1 GADS) O - 1= T it
- @ Flashsouree (508) B [E 1 = 1 a |

= Uservol (36E)
o ~Dtive Encl 0
B Userval-1 (363 tive Enclosure

@ Uservol-2 (3GH) E

[P Uservol-3 (308)

Wiewe Azsociated Components

ﬁ Dataval (268
;-@USENDFR'] {1,020
@Y UservarR2 (085G Rarame.
i [P Usanal-R3 (0BG Disable..

ﬁB Uszen/ol-R4 (056G Re-treate

EE—— Properties
i ii@ Ejf Partiions Allowed/Us

SJ000855

G0 1o FlashCopy Repository Logical Drive

Figure 20. Deleting the FlashCopy logical drive

3. The Delete FlashCopy Logical Drive window opens, as shown in|Figure 21
Type Yes and click OK.

B Delete FlashCopy Logical Drive

Deleting a FlashCopy logical drive will remove the FlashGopy
logical drive and also delete and destroy ALL data on the
FlashGopy logical drive's associated FlashCopy repository
logical drive

‘y Stop all /0 and unmount any filesystems on this array before

/

i

proceeding.

IMPORTANT: Ifyou see system errar messages related to this
deleted Ingical drive, you may need to reboot your host system to
permanently temove any information aboutthis logical drive.

Are yoU SUre you wahtto continue?

Typevyes and select Dk to start the operation.

$J000856

Figure 21. Delete FlashCopy Logical Drive window

The FlashCopy logical drive and the FlashCopy repository logical drive are
deleted, destroying any data that they contained.
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Chapter 3. Overview of VolumeCopy

VolumeCopy is a premium feature that comes with the FAStT Storage Manager 8.4
software and is enabled by purchasing a premium feature key. VolumeCopy is used
in conjunction with FlashCopy and, therefore, it can be purchased together with
FlashCopy as a single copy service option, or at a later time as an enhancement to
FlashCopy.

The VolumeCopy feature is a firmware-based mechanism that you use to copy data
from one logical drive (the source logical drive) to another logical drive (the target
logical drive) in a single storage subsystem. The source logical drive and the target
logical drive in a VolumeCopy operation that are located on the same storage
subsystem can also be referred to as a VolumeCopy pair.

Important: If the logical drive that you want to copy is used in a production
environment, the FlashCopy feature must be enabled. A FlashCopy of the logical
drive must be created and then specified as the VolumeCopy source logical drive,
instead of using the actual logical drive itself. This requirement allows the original
logical drive to continue to be accessible during the VolumeCopy operation.

With VolumeCopy, you can also copy data from arrays that use smaller capacity
drives to arrays that use larger capacity drives, back up data, or restore FlashCopy
logical drive data to the base logical drive. The VolumeCopy feature includes a
Create Copy wizard that you use to create a VolumeCopy operation, and a Copy
Manager that you use to monitor logical drive copies after they have been created.

The VolumeCopy feature is useful for the following tasks:

Copying data for greater access
As your storage requirements for a logical drive change, you can use
VolumeCopy to copy data to a logical drive in an array that uses larger
capacity disk drives within the same storage subsystem. You can move
data to larger drives (for example, 73 GB to 146 GB), change to drives with
a higher data transfer rate (for example, 1 Gbps to 2 Gbps), or change to
drives that use new technologies for higher performance.

Backing up data
With VolumeCopy you can create a backup of a logical drive by copying
data from one logical drive to another logical drive in the same storage
subsystem. You can use the target logical drive as a backup for the source
logical drive, for system testing, or to back up to another device, such as a
tape drive.

Restoring FlashCopy logical drive data to the FlashCopy base logical drive
If you need to restore data to the FlashCopy base logical drive from its
associated FlashCopy logical drive, you can use the VolumeCopy feature to
copy the data from the FlashCopy logical drive to another logical drive (the
VolumeCopy target logical drive) first. Then, copy the data on the
VolumeCopy target logical drive back to the FlashCopy base logical drive.

For more information about FlashCopy, see |[Chapter 2, “Overview of
[FlashCopy,” on page 7.|

Using VolumeCopy with FlashCopy

VolumeCopy is used with FlashCopy. It can be purchased together with FlashCopy
as a single copy service option, or at a later time as an enhancement to FlashCopy.
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Before you create a VolumeCopy, you first create a FlashCopy of the logical drive
that you want to copy. During the VolumeCopy operation, use the FlashCopy as the
source logical drive of the VolumeCopy pair.

Note: A VolumeCopy operation will fail all FlashCopy logical drives that are
associated with the target logical drive, if any exist. You must disable all
FlashCopy logical drives that are associated with the base logical drive
before you can select the base logical drive as a target logical drive.
Otherwise, you cannot use the base logical drive as a target logical drive.

Enabling the VolumeCopy feature

To enable VolumeCopy, you must perform the following two procedures in the
following order:

1. Obtain the feature enable identifier. This procedure is described in detail in
[‘Obtaining the feature enable identifier” on page 3|

2. Generate the feature key file and enabling VolumeCopy. This procedure is
described in detail in[‘Generating the feature key file and enabling the premium
[feature” on page 3/

Before you begin, gather the following information:

* Your Feature Activation Code, which is printed on the IBM FlashCopy Premium
entitlement card

» Your controller unit IBM serial number, which is printed on the label on the back
of your FASLT controller unit

* A 32 alphanumeric IBM FASTT storage subsystem premium feature identifier
string.

To obtain the storage subsystem premium feature identifier string, ensure that your
controller unit and expansion units are connected, powered on, and managed using
the SMclient.

For more details about how to enable the VolumeCopy feature, see
lpremium features” on page 3.|For information about how to view a list of those

premium features that are enabled on your storage subsystem, see|“Viewing the
istatus of premium features” on page 4.|

If the VolumeCopy feature is disabled, but VolumeCopy pairs exist, all of the options
in the Copy Manager (stop copy, remove copy pairs, start copy, enable and disable
read-only) will still be available. However, you will not be permitted to create any
new VolumeCopies.

Create Copy wizard

The Create Copy wizard guides you through the VolumeCopy process. The Create
Copy wizard helps you to select a source logical drive from a list of available logical
drives, select a target logical drive from a list of available logical drives, and set the
copy priority for the VolumeCopy operation. When you have completed the wizard
panels, the VolumeCopy operation starts and data is read from the source logical
drive and written to the target logical drive.

Creating a VolumeCopy

48

The process of creating a VolumeCopy (copying data from the source volume to the
target volume) is managed by the controllers and is transparent to host machines
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and applications. This section describes how you use the storage management
software to copy data with VolumeCopy, and the actions taken by the controllers
during the creation of a VolumeCopy.

The Create Copy wizard guides you through the steps to create a new
VolumeCopy.

Before you begin: Create a FlashCopy of the logical drive that you want to copy.
During the VolumeCopy operation, you use the FlashCopy logical drive as the
source logical drive of the VolumeCopy pair.

See r‘Creating a FlashCopy logical drive” on page 20| for information about how to
create a FlashCopy.

Note: Before you use the Create FlashCopy Logical Drive wizard to create a
FlashCopy logical drive, you must complete the following steps to prepare
the host operating system:

1. Stop the host application that is accessing the base logical drive.

2. Synchronize the file system and flush the operating system cached I/Os
to disks.

In Microsoft Windows, the utility SMrepassist can be used to flush the
operating systems cache 1/O before a FlashCopy logical drive is created.
For more information on the SMrepassist utility, see the “SMrepassist”
topic in the storage subsystem online help.

3. Unmount the base logical drive, if possible.

Perform the following steps to create a VolumeCopy using the Create Copy wizard:
1. Stop all I/O activity to the target logical drive.

For more information about what types of logical drives are acceptable for
source and target logical drives, see [‘Selecting the source logical drive” on page|
and [‘Selecting the target logical drive” on page 51|

2. Unmount any filesystems on the target logical drive.

3. Select the source logical drive (the FlashCopy that you just created) in the
Logical view of the Subsystem Management window.

4. Click Logical Drive » Copy » Create .

The Create Copy Wizard - Introduction panel displays. Select the source logical
drive from the list of valid source logical drives on the storage subsystem.

Note: If the FlashCopy logical drive that you selected to start the wizard is a
valid source logical drive, it is highlighted in the table.
Click Next. The Select Target Volume and Copy Priority panel opens.

5. Select the target logical drive for the VolumeCopy operation and set the copy
priority.

The copy priority determines how much of the resources of the controller are
used to complete the VolumeCopy operation versus to fulfill I/O activity. For
more information about selecting a target logical drive, see |“Selecting the target|
logical drive” on page 51.| For more information about the copy priority, see
“Setting the copy priority” on page 54.|

Click Next. The Preview panel opens.

6. Review the source logical drive, the target logical drive and copy priority that
you specified in the previous steps. For more information about the Preview
panel, see[‘The Preview panel of the Create Copy wizard” on page 55
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When you have completed the wizard tasks, the VolumeCopy operation starts and
the preferred controller of the source logical drive reads data from the source logical
drive and writes it to the target logical drive. Operation in Progress icons display
on the source logical drive and target logical drive while the VolumeCopy operation
completes.

While a VolumeCopy operation has a status of In Progress, Pending, or Failed:
* The source logical drive is available for read I/O activity only
* The target logical drive is not available for read or write 1/0 activity

After the VolumeCopy operation completes:
» The source logical drive is available for both read and write 1/O activity

* The target logical drive is available for read 1/O activity, unless the Read-Only
attribute has been disabled. For more information about setting the Read-Only
attribute on the target logical drive, see [‘Setting the target logical drive read-only|
[attribute option” on page 67.

Important: A maximum of eight VolumeCopy copies can be In Progress at one
time. If you create more than eight VolumeCopy copies, they will have a status of
Pending until one of the VolumeCopies with a status of In Progress completes.

While a VolumeCopy operation is In Progress, the same controller must own both
the source logical drive and target logical drive. If the same controller does not own
both the source logical drive and target logical drive before you begin the the
VolumeCopy operation, ownership of the target logical drive is automatically
transferred to the controller owner of the source logical drive.

When the VolumeCopy operation completes or is stopped, ownership of the target
logical drive is restored to its preferred controller. If ownership of the source logical
drive changes during the VolumeCopy operation, ownership of the target logical
drive also changes.

Selecting the source logical drive

50

The first panel of the Create Copy wizard is the Introduction panel. The Introduction
panel defines what a VolumeCopy is and allows you to select a source logical drive.
The table that is displayed on the Introduction panel contains all the valid source
logical drives on the storage subsystem, including the logical drive that you selected
to start the wizard.

Note: Before you start the VolumeCopy operation, use the FlashCopy feature to
create a FlashCopy of the logical drive that you want to copy, and use it as
the source logical drive of the VolumeCopy pair.

The source logical drive is a FlashCopy logical drive that accepts host 1/O requests
and stores application data. When the VolumeCopy operation is started, all data
from the source logical drive is copied to the target logical drive.

The source logical drive is available for read I/O activity only while a VolumeCopy
operation has a status of In Progress, Pending, or Failed. Write requests are
allowed after the VolumeCopy operation is completed.

All valid source logical drives on the storage subsystem are displayed in the list in
the Introduction panel. The logical drive that you selected to start the wizard is
highlighted.
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Note: In addition to the FlashCopy logical drives that are listed in the Introduction

panel, standard logical drives and Remote Mirror primary logical drives are
also displayed. However, do not use standard or Remote Mirror primary
logical drives as source logical drives for a VolumeCopy.

The following logical drives are not valid source logical drives and do not display on
the list:

A Remote Mirror secondary logical drive

A Remote Mirror repository logical drive

A FlashCopy repository logical drive

A failed logical drive

A missing logical drive

A logical drive that is currently in a modification operation

A logical drive that is holding a legacy or persistent reservation

A logical drive that is a source logical drive or target logical drive in another
VolumeCopy operation with a status of In Progress, Failed, or Pending

From the Introduction panel, you can open the View Drives window to view drive,
slot, and capacity of the selected source logical drive. You can use this information
to copy high-access logical drives to different arrays for increased accessibility, or to
copy logical drives to an array that uses larger capacity drives.

Note: After the VolumeCopy operation completes for a VolumeCopy pair, you do

not need to perform any additional processing or synchronization between
the source and the target logical drives. If you recopy, it causes the
VolumeCopy to start copying from the beginning of the source logical drive.
Therefore, a source logical drive can be in as many VolumeCopy pairs as
there are eligible target logical drives in the storage subsystem.

Selecting the target logical drive

In the Create Copy Wizard: Select Target Logical Drive and Copy Priority panel, you
can select the target logical drive for the VolumeCopy and set the copy priority as
shown in [Figure 22 on page 52| For more information about setting the copy
priority, see [“Setting the copy priority” on page 54|
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Figure 22. Select Target Logical Drive and Copy Priority panel of the Create Copy wizard

A target logical drive is a standard logical drive in a VolumeCopy logical drive pair
that contains a copy of the data from the source logical drive. Read and write
requests to the target logical drive will not take place while the VolumeCopy
operation has a status of In Progress, Pending, or Failed.

Note: The target logical drive capacity must be equal to or greater than the usable
capacity of the original source logical drive (not the FlashCopy of the original
logical drive).

Important: A VolumeCopy overwrites data on the target logical drive and
automatically makes the target logical drive read-only to hosts.

When a VolumeCopy operation is started, the data from the source logical drive is
written to the target logical drive. However, if the VolumeCopy operation is stopped,
and then restarted using the Re-Copy option, the data on the source logical drive
might not be the same as the data on the target logical drive. If hosts have been
mapped to the source logical drive before the VolumeCopy operation was restarted,
the data that will be copied to the target logical drive when you re-copy might have
changed since the previous VolumeCopy was created. So the VolumeCopy
operation always copies the image of the source logical drive at the time the copy
operation starts, not a second eatrlier or later.

Important: A VolumeCopy operation will overwrite data on the target logical drive
and automatically make the target logical drive read-only to hosts. After the
VolumeCopy operation completes, use the Copy Manager to disable the read-only
attribute for the target logical drive. If you have used the target logical drive in a
VolumeCopy operation before, make sure that you no longer need that data or have
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backed it up. For more information about the read-only attribute, see|“Setting the
ttarget logical drive read-only attribute option” on page 67

All valid target logical drives on the storage subsystem are displayed in the list in
the Select Target Logical Drive window.

The following drives can be used as a target logical drive:

» A standard logical drive

* A Remote Mirror primary logical drive

* A base logical drive of a disabled or failed FlashCopy logical drive

Note: You must disable all FlashCopy logical drives that are associated with the
base logical drive before you can select it as a target logical drive.
Otherwise, the base logical drive cannot be used as a target logical drive.

The following logical drives are not valid target logical drives and do not display on
the list:

* A Remote Mirror secondary logical drive

* A Remote Mirror repository logical drive

* A FlashCopy logical drive

* A FlashCopy repository logical drive

* A base logical drive of an optimal FlashCopy logical drive

» A failed logical drive

* A missing logical drive

* A logical drive with a status of Degraded

* Alogical drive that is currently in a modification operation

* A logical drive that is holding a legacy or persistent reservation

» Alogical drive that is a source logical drive or target logical drive in another
VolumeCopy operation that has a status of In Progress, Failed, or Pending

* Alogical drive that has already been defined as a target logical drive for another
VolumeCopy pair

You can also create a target logical drive specifically for the VolumeCopy operation.
For more information, see “Creating a Storage Subsystem Logical Drive” in the
Subsystem Management online help.

Note: After you have selected or created a target logical drive, give it a unique
name so that it is easily recognizable in the Logical view. For example, if the
source logical drive name is Accounting, name the target logical drive
Accounting-Copy. That way you can quickly identify the source logical drives
and target logical drives that are available on the storage subsystem.

From the Select Target Logical Drive and Copy Priority panel, you can open the
View Drives window to view drive, slot, and capacity of the target logical drive. You
can use this information to copy high-access logical drives to different arrays for
increased accessibility, or to copy logical drives to an array that uses larger capacity
drives.

For more information about source logical drives and target logical drives, see
['Restrictions” on page 63
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Setting the copy priority

54

In the Select Target Logical Drive and Copy Priority panel you can set the copy
priority for the VolumeCopy operation as shown in [Figure 22 on page 52

Several factors contribute to system performance including the following factors:
* 1/O activity

VolumeCopy diverts controller processing resources from I/O activity. The copy
priority defines how much of the system resources are used to complete a
VolumeCopy operation versus fulfill I/O requests.

* The logical drive RAID level
* The logical drive configuration
The number of drives in the array or cache parameters
* The logical drive type
FlashCopy logical drives may take more time to copy than standard logical drives
* The source logical drive capacity
All the data in the source logical drive copies to the target logical drive.
* The number of other VolumeCopy operations being performed at the same time
* The hard drive family type
* The number of hard drives that make up the logical drive

You can set the priority of each active VolumeCopy operation in the Create Copy
wizard with respect to other tasks in the FASIT storage subsystem. You can use the
Copy Manager to change the copy priority after it is set and you can change the
priority of the VolumeCopy operation while it is actively copying.

The following copy priority rates are available:

* Lowest

* Low

* Medium

* High

* Highest

The Highest priority rate supports the VolumeCopy operation, but I/O activity might

be affected. The Lowest priority rate supports I/O activity, but the VolumeCopy
operation will take longer.

For more information, see “Changing Copy Priority” on the How To tab in the
Subsystem Management window online help.
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The Preview panel of the Create Copy wizard

The Preview panel provides an overview of the selected source logical drive, target
logical drive, and copy priority for the VolumeCopy operation as shown in|Figure 23

552 BlueStone - Create Copy Wizard - Preview x|
The data on source logical drive Blu_7_3 (25.825 GB) will now he copied to target
logical drive Blu_B_3 {25.825 GBE) at Highest priarity.
CAUTICON: Starting the copy operation will overwrite ALL existing data on the target
logical drive and make the target logical drive READ-ORLY to hosts, and will fail ALL
flash copy logical drives associated with the target logical drive, if any exist. If you have
used logical drive Blu_B_3 as a copy before, be sure you no longer need that data or
have it backed up.

Far any post-creation activities, use the Logical Drive==Copy==Copy Manager optian.

Are you sure you wwant to continue?

Type yes to confirm that you want to perform this operation.

Iyes
= Back | Finish I Cancel | Help |
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Figure 23. The Preview panel of the Create Copy wizard

You can also return to previous panels to edit the parameters you have chosen.

When you type Yes in the text box and click Finish, the Copy Started window
opens to verify that the VolumeCopy operation has begun.

Note: You can also click Back to change your choices.

You can create a new VolumeCopy operation or exit the wizard. To close the Copy
Started window, you must select one of the following options:

* Yes - Create a new VolumeCopy
* No - Exit the wizard

Icons that show the progress of the operation display on the source logical drive
and target logical drive while the VolumeCopy operation has a status of In
Progress or Pending. For more information about copy status, see [‘Copy status” on|

The progress of the VolumeCopy operation displays in the status bar at the
bottom-right of the Copy Manager. The status bar shows the estimated time
remaining for the VolumeCopy operation to complete. You can view the progress of
a VolumeCopy operation in the Copy Manager only when a VolumeCopy operation
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has a status of In Progress. For more information about the Copy Manager and
how to access it, see [Chapter 4, “Managing VolumeCopy,” on page 63|

Viewing drives

The View Drives panel displays the drive tray, slot, and capacity information for the
selected source logical drive or target logical drive. The View Drives panel is
available in the Create Copy Wizard - Introduction and Create Copy Wizard - Select
Target Logical Drive panels.

Content for this panel will automatically update dynamically if you select a different
source logical drive or target logical drive in the Copy Wizard panel while the View
Drives panel is open.

The information presented in the View Drives panel can be used to copy
high-access logical drives to different logical drive groups for increased accessibility,
or to copy logical drives to a logical drive group that uses drives with a greater
capacity.

Accessing the VolumeCopy target logical drive on an AIX host

56

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, then mount the target logical drive to a
directory.

Complete the following steps to change the target permissions to Disable Read

OnTy:

1. In the Logical view of the SMclient Subsystem Management window, right-click
the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change » Target Volume Permissions » Disable
Read Only.

Complete the following steps to configure the AIX host for the new VolumeCopy
logical drive:

1. Log in to the host as root.

2. Ensure that the host operating system recognizes the VolumeCopy logical drive.
At the host prompt, type the following command and press Enter.

|cfgmgr |

Several minutes might pass while the operating system accesses the drive.
When the operation completes, a window opens with the following message:

|Dev1ce nodes have been updated |

The new logical drive is now available from the operating system.
3. At the host prompt, type the following command and press Enter.

1spv

A list of the physical drives that are recognized by the operating system is
displayed.

4. Look for the operating system device name of your VolumeCopy logical drive in
the list. The list shows a physical logical drive ID (PVID) for the VolumeCopy
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logical drive. This is the same as the PVID for the associated base logical drive,
because the VolumeCopy logical drive contains the same array data structures
as the base logical drive.

Clear the PVID for the VolumeCopy logical drives. At the host prompt, type the
following command and press Enter.

chdev -1 os_device_name -a pv=clear

where 0s_device_name is the operating system device name of the
VolumeCopy logical drive.

Repeat this step for each VolumeCopy logical drive in the AIX array.

Re-create a new array using the recreatevg command. This command reads
the array data structure inside a logical drive and reconstructs it. It also
allocates new physical logical drive identifiers (PIDs) to the VolumeCopy logical
drive and enables access to the VolumeCopy logical drive for the selected host.

At the host prompt, type the following command and press Enter:

recreatevg -y logical drivegroupname -L /directoryname os_device_name

where:

» logical drivegroupname is the name that you want to assign to the
VolumeCopy array.

 directoryname is the name of the directory where you want to mount the
VolumeCopy logical drive.

* 0s_device_name is the operating system device name of the VolumeCopy
logical drive. If your AIX array contains more than one VolumeCopy logical
drive, add an os_device_name for each logical drive.

The array is re-created, and contains the VolumeCopy logical drive or drives.

7. Mount the VolumeCopy logical drive to its intended host. At the host prompt,

type the following command and press Enter.

mount mount-point

where mount-point is the name of the filesystem that being mounted. Include
the directoryname that was used in step

8. Ensure that the logical drives are back online. At the host prompt, type the

following command and press Enter.

|df -k |

A list of the mounted disks displays.

Accessing the VolumeCopy target logical drive on an HP-UX or Solaris

host

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, then mount the target logical drive to a
directory.

Complete the following steps to change the target permissions to Disable Read
Only:

1.

In the Logical view of the SMclient Subsystem Management window, right-click
the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.
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2. From the top menu, select Change » Target Volume Permissions »Disable
Read Only.

Next, complete the following steps on your HP-UX or Solaris host to access the

VolumeCopy target logical drive:

1. Create a directory for the mount point (the target logical drive) in the root
directory. At the command prompt, type the following command:

#mkdir /target_directory

where target_directory is the name of the directory that you want to create.
Mount the source logical drive to the new directory, using the following
command:

#mount /target_logical_drive/target_directory /target_directory

where target_logical_drive is the target logical drive for the VolumeCopy, and
target_directory is the name of the directory that you created in step

Accessing the VolumeCopy target logical drive on a Windows 2000 or
Windows Server 2003 host

58

You cannot map the VolumeCopy target logical drive to the same Windows 2000 or
Windows Server 2003 servers that the VolumeCopy source logical drive is mapped
to. You must use another server, or unmap the VolumeCopy source logical drive
from the server.

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, and then mount the target logical drive to a
drive letter or mount point.

Complete the following steps to change the target permissions to Disable Read

Only:

1. In the Logical view of the SMclient Subsystem Management window, right-click
the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change » Target Volume Permissions » Disable
Read Only.

Complete the following steps to configure your host for the new VolumeCopy target
logical drive:

1. Run the hot_add utility to let the system recognize the newly-added
VolumeCopy target logical drive.

Note: If the system does not recognize the VolumeCopy target logical drive
after you run the hot_add utility, restart the server.

2. In the System Management window, open the Disk Management directory and
assign a drive letter or mount point to the new VolumeCopy target logical drive.

3. When you no longer need the VolumeCopy target logical drive, remove the drive
letter or mount point from the Disk Management directory before you delete the
VolumeCopy target logical drive.
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Accessing the VolumeCopy target logical drive on a Windows NT host

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, and then mount the target logical drive to a
drive letter or mount point.

Complete the following steps to change the target permissions to Disable Read

OnTy:

1. In the Logical view of the SMclient Subsystem Management window, right-click
the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change » Target Volume Permissions » Disable
Read Only.

Complete the following steps to configure your host for the new VolumeCopy target
logical drive:

1. Run the hot_add utility to let the system recognize the newly-added
VolumeCopy target logical drive.

Note: If the system does not recognize the VolumeCopy target logical drive
after you run the hot_add utility, restart the server.

2. Resolve duplicate logical drive signatures by typing the following command:

SMrepassist -r

3. In the NT4 Disk Administrator window, assign a drive letter to the new
VolumeCopy target logical drive.

4. When you no longer need the VolumeCopy target logical drive, open the NT4
Disk Management window and remove the drive letter before you delete the
VolumeCopy target logical drive.

Accessing the VolumeCopy target logical drive on a Novell NetWare

host

You cannot map the VolumeCopy target logical drive to the same Novell NetWare
servers that the VolumeCopy source logical drive is mapped to. You must use
another server, or unmap the VolumeCopy source logical drive from the server.

To access the target logical drive after you have created the VolumeCopy, you must
first change the target permissions, and then mount the target logical drive to a
drive letter or mount point.

Complete the following steps to change the target permissions to Disable Read

OnTy:

1. In the Logical view of the SMclient Subsystem Management window, right-click
the icon for target logical drive and click Copy Manager. The Copy Manager
Window opens.

2. From the top menu, select Change » Target Volume Permissions » Disable
Read Only.

Complete the following steps to configure your host for the new VolumeCopy target
logical drive:
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1. Run the hot_add utility to let the system recognize the newly-added
VolumeCopy target logical drive.

Note: If the system does not recognize the VolumeCopy target logical drive
after you run the hot_add utility, restart the server.
2. Type the logical drive in the command window, or use the Disk Management
menu in the ConsoleOne window to verify that the drive is added.

SMrepassist utility for Windows NT, Windows 2000, and Windows

Server 2003

SMrepassist (replication assistance) is a host-based utility for Windows NT,
Windows 2000, and Windows Server 2003. It should be used before you create a
VolumeCopy on Windows NT, Windows 2000, and Windows Server 2003.

Running the SMrepassist utility ensures that all the memory-resident data for
filesystems on the target volume is flushed. If you are creating a VolumeCopy on
Windows NT, you also use this utility after you map the VolumeCopy target logical
drive to the same Windows NT server that the VolumeCopy source logical drive is
mapped to. This resolves the duplicate disk signatures and system partition table
information.

Important: You cannot map the VolumeCopy target logical drive to the same
Windows 2000 or Windows Server 2003 servers that the VolumeCopy source
logical drive is mapped to. You must use another server, or unmap the VolumeCopy
source logical drive from the server.

The command to run this utility is:

SMrepassist -f [filesystem-identifier] | -r [filesystem-identifier]- list

» where -f flushes all the memory-resident data for the file system indicated by
[filesystem-identifier]

* where [filesystem-identifier] specifies a unique file system in the following
syntax:

drive-letter: [mount-point-path]

The file system might include only a drive letter, or a drive letter plus a mount
point

* where -r (Windows NT only) resolves any duplicate signatures and partition
table information. You must write a unique boot block signature to each logical
drive that has a duplicate signature. Ensure that the driver re-reads the partition
table for the logical drive to avoid a restart of the operating system.

The -r option by itself causes the utility to find and resolve all FlashCopy logical
drive and VolumeCopies on the storage array having duplicate signatures. The
utility will only modify the signature on a FlashCopy logical drive or a
VolumeCopy, not the base logical drive or standard logical drive, even where
there are more than two logical drives that share a common signature.

An error message is provided in the command line and the logical drives are listed
as a logical drive set when the utility cannot distinguish between the following
logical drives:

» Base logical drive and FlashCopy logical drive (for example, if the snapshot
logical drive has been removed)
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» Standard logical drive and VolumeCopy (for example, if the VolumeCopy has
been removed)

Locating associated logical drives

The Go To option can be used to quickly jump to an associated source logical drive
or target logical drive displayed in the Logical view of the Subsystem Management
Window.

Important: The Go To option is available only if the VolumeCopy feature has been
enabled, or if VolumeCopy copies currently exist on the storage array. It is not
accessible using the Mappings view of the Subsystem Management Window.

To locate an associated source logical drive or target logical drive, complete the
following steps:

1. Select a source logical drive or target logical drive in the Logical view of the
Subsystem Management window.

2. Perform one of the following actions, based on the logical drive type that you
have selected:

Source logical drive
Click View » Go To » Target Logical Drive.

The selection jumps to the associated target logical drive in the Logical
view of the Subsystem Management window.

Target logical drive
Click View +Go To »Source Logical Drive.

The selection jumps to the associated source logical drive in the Logical
view of the Subsystem Management window.
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Chapter 4. Managing VolumeCopy

After you create a VolumeCopy with the Create Copy wizard, you can monitor the
VolumeCopy operation through the Copy Manager. You can perform the following
tasks from the Copy Manager:

* Re-copy, stop, or remove a VolumeCopy

* Modify the attributes of a logical drive, including the copy priority and the target
logical drive read-only attribute

* View the status of a VolumeCopy operation
» Determine what logical drives are involved in a VolumeCopy operation

You can also use the Storage Subsystem Profile to determine what logical drives
are involved in a VolumeCopy operation.

Copy Manager displays information for all of the logical drive copies on the storage
subsystem. This information includes the following items:

» The source logical drive

* The target logical drive

* The status of the VolumeCopy operation

» A timestamp for any completed copies

* The VolumeCopy priority assigned to the VolumeCopy

If a target logical drive is read-only to hosts, a lock icon is displayed in the Target
Logical Drive column.

Perform the following steps to access and use the Copy Manager:
1. Click Select Logical Drive » Copy » Copy Manager.
The Copy Manager window opens.

2. Click on the VolumeCopy pair or press Enter to select the VolumeCopy pair in
the table.

3. Select an option from the pull-down menu.

Restrictions

The following restrictions apply to the source logical drive, target logical drive, and
the storage subsystem:

» The source logical drive is available for read I/O activity only while a VolumeCopy
operation has a status of In Progress or Pending. Write requests are allowed
after the VolumeCopy operation is completed.

Before you start the VolumeCopy operation, create a FlashCopy of the logical
drive that you want to copy, and then use the FlashCopy as the source logical
drive of the VolumeCopy pair.

* Alogical drive can be used as a target logical drive in only one VolumeCopy
operation at a time.

* The maximum number of VolumeCopies that are allowed per storage subsystem
depends on the number of target logical drives that are available on your storage
subsystem.

» A storage subsystem can have up to eight logical drive copies running at any
given time.

» The target logical drive capacity must be equal to or greater than the source
logical drive capacity.
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* The target logical drive capacity must be equal to or greater than the usable
capacity of the original source logical drive.

» A target logical drive can be a standard logical drive, a base logical drive of a
disabled or failed FlashCopy logical drive, or a Remote Mirror primary logical
drive.

Note: You must disable all FlashCopy logical drives that are associated with the
base logical drive before you can select it as a target logical drive.
Otherwise, the base logical drive cannot be used as a target logical drive.

Logical drives that have the following statuses cannot be used as a source logical
drive or target logical drive:

* Alogical drive that is reserved by the host
» Alogical drive that is in a modification operation
* Alogical drive with a status of Failed or Degraded

Note: A logical drive can be defined as the source logical drive of multiple
VolumeCopy logical drive pairs even when the status of the VolumeCopy
logical drive pair is In Progress or Failed. After a logical drive is defined as
a target logical drive in a VolumeCopy logical drive pair, it is not available to
participate in any other VolumeCopy logical drive pairs as a target logical
drive regardless of the VolumeCopy logical drive pair status. After a
VolumeCopy operation is completed, the logical drive, which is defined as a
target logical drive in a VolumeCopy logical drive pair, is available to
participate in any other VolumeCopy logical drive pairs as the source logical
drive role only.

Copy status

The progress of the VolumeCopy operation displays in the status bar at the
bottom-right of the Copy Manager. The status bar shows the estimated time
remaining for the VolumeCopy operation to complete. You can view the progress of
a VolumeCopy operation in the Copy Manager only when a VolumeCopy operation
has a status of In Progress.

There are three possible copy statuses:

Copy Pending
The Copy Pending status displays in the Copy Manager when a
VolumeCopy operation has been created, but system resources do not
allow it to start. For example, if there are already eight logical drive copies
with a status of In Progress, any subsequent VolumeCopy that you create
will have a status of Pending until one of the other eight logical drive copies
has completed. In addition, a modification operation on another logical drive
in the array might need to complete before the VolumeCopy operation can
begin.

While in the Copy Pending status, the host has read-only access to the
source logical drive, and read and write requests to the target logical drive
do not take place until the VolumeCopy operation has completed.

Copy In Progress
The Copy In Progress status displays in the Copy Manager while data on
the source logical drive is being read and then written to the target logical
drive. While in the Copy In Progress status, the host has read-only access
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to the source logical drive, and read and write requests to the target logical
drive do not take place until the VolumeCopy operation has completed.

Copy Failed

The Copy Failed status displays in the Copy Manager when an error occurs
while the VolumeCopy is being created. A status of Copy Failed can occur
because of a read error from the source logical drive, a write error to the
target logical drive, or a failure on the storage subsystem that affects the
source logical drive or target logical drive (such as a Remote Mirror role
reversal). A critical event is logged in the Major Event Log (MEL) and a
Needs-Attention icon displays.

While a VolumeCopy operation has the Copy Failed status, the host has
read-only access to the source logical drive, and read and write requests to
the target logical drive will not take place until the failure is fixed.

When a VolumeCopy operation fails, you must use the Stop Copy option in
the Copy Manager to stop the operation and use the Recovery Guru to fix
the problem.

You can use the Re-Copy option to restart the VolumeCopy operation from
the beginning.

Notes:

If there are eight logical drive copies with a status of In Progress, any
subsequent VolumeCopy operation will have a status of Pending until one of the
eight logical drive copies completes.

If a modification operation is running on a source logical drive or target logical
drive, and the VolumeCopy operation has a status of In Progress, Pending, or
Failed, then the VolumeCopy operation will not take place.

If a modification operation is running on a source logical drive or target logical
drive after a VolumeCopy has been created, then the modification operation must
complete before the VolumeCopy operation can start. If a VolumeCopy operation
has a status of In Progress, then any modification operation will not take place.

Viewing VolumeCopy properties

Use the Logical Drive Properties window, shown in|Figure 24 on page 66} to view
the following information about a selected source logical drive or target logical drive:

The role of the logical drive: either source or target

The copy status: Pending, In Progress, Completed, Stopped, Failed
The copy priority: Lowest, Low, Medium, High, Highest

The start timestamp: in the format MM/DD/YY HH/MM/SS
Completion timestamp: in the format MM/DD/YY HH/MM/SS

The read-only attribute: Enabled or Disabled (only if a target logical drive is
selected)

Source or target logical drive ID: WWN
Source or target logical drive name

Chapter 4. Managing VolumeCopy 65



Note: You can only view the progress of a VolumeCopy operation with a status of

In Progress.

% BlueStone - Logical Drive Properties

Base
Ruole: Source

Copy status: In prograss

Caopy priarity; Highest
Starttimestamp: 8014003 6:35:00 PM
Campletion timestamp:

Target logical drive: Blu_8_3

Target logical drive 1D: 60:02:0b:80:00:0195:97:00:00:02:28:3e:e4:60:3b

]

Copy progres

Estimated time rermaining: 0 hours, 28 minutes...

MOTE: To change the copy priotity or other attributes, use the Copy Manager.

Ruole: Source

Copy status: In progress

Copy priority: Highest
Starttimestamp: 81403 6:40:31 PM
Completion timestamp:

Target logical drive: Blu_6_3

Target [ogical drive |D: 60:02:00:80:00:0795:97.00:00:02:24:3e:e4:60:03

Copy progres

Estimated time remaining: 0 hours, 34 minutes. ..

MOTE: To change the copy priority or other attributes, use the Copy Manager.

Close Help

Figure 24. The Logical Drive Properties window

SC000348

Perform the following steps to view the VolumeCopy properties:
1. Select the source logical drive or target logical drive in the Logical view.

2. Click Logical Drive » Properties.

The Logical Drive Properties window opens.

3. Click the Copying tab.
The Copy Properties tab displays.

If a source logical drive has multiple target logical drives, then the details will be

repeated for each target logical drive.
4. Click Close to close the window.

Changing copy priorities

You can change the copy priority to balance 1/O activity with VolumeCopy operation
activity on a storage subsystem. You can set the copy priority to a rate that will
have the least impact on I/O activity. There are five copy priority rates available:
lowest, low, medium, high, and highest. If the copy priority is set at the lowest rate,
I/O activity is prioritized and the VolumeCopy operation will take longer. If the copy
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priority is set to the highest priority rate, the VolumeCopy operation is prioritized, but
I/0O activity for the storage subsystem might be affected.

You can change the copy priority for a VolumeCopy pair before the VolumeCopy
operation begins, while the VolumeCopy operation has a status of In Progress, or
after the VolumeCopy operation has completed (for a re-copy). Perform the
following steps to change the copy priority:

1. Click Select Logical Drive » Copy » Copy Manager.
The Copy Manager window opens as shown in [Figure 25|

[#Z BlueStone - Copy Manager o m]

Copy  Chanoe  Help

Source Logical Drive | Target Lagical Drive | Status | Tirnestarmp | Priarity |
Blu_7_3 BBlu6 3 In Progress™ Highest

In Progress® Highe:z:t

Total number of copies: 2 *21% complete, estimated time remaining: 28 minutes

SC000342

Figure 25. The Copy Manager window

2. Select one or more VolumeCopy pairs in the table. You can select more than
one VolumeCopy pair by pressing Ctrl and the left mouse button.

3. Click Change » Copy Priority.
The Change Copy Priority window opens.

4. In the Copy Priority field, use the slider bar to select the appropriate copy
priority, depending on your system performance needs.

For more information about the copy priority, see [‘Setting the copy priority” on|
5. Click OK.
The Change Copy Priority - Progress window opens.
6. Click OK.
The copy priority for the selected VolumeCopy pair is changed.

Setting the target logical drive read-only attribute option

The target logical drive read-only attribute determines how read and write requests
to the target logical drive are handled after a VolumeCopy operation is complete or
if the VolumeCopy operation fails before it completes. After the VolumeCopy
operation has completed, the target logical drive automatically becomes read-only
to hosts, and write requests to the target logical drive do not take place. You might
want to keep this attribute enabled in order to preserve the data on the target
logical drive. The following situations are examples of when you might want to keep
the read-only attribute enabled:

» If you are using the target logical drive for backup purposes
» If you are copying data from one array to a larger array for greater accessibility
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» If you are using the data on the target logical drive to copy back to the base
logical drive of a disabled or failed FlashCopy logical drive

If you decide not to preserve the data on the target logical drive after the
VolumeCopy operation is completed, use the Copy Manager to disable the
read-only attribute for the target logical drive.

Perform the following steps to enable the read-only attribute:
1. Click Select Logical Drive » Copy » Copy Manager.
The Copy Manager window opens.

2. Select one or more VolumeCopy pairs in the table. You can select more than
one copy pair by pressing Ctrl and the left mouse button.

3. Click Change » Target Logical Drive Permissions » Enable Read-Only.

The read-only attribute is enabled on the target logical drive. Write requests to
the target logical drive are rejected.

Perform the following steps to disable the read-only attribute:
1. Click Select Logical Drive » Copy » Copy Manager.
The Copy Manager window opens.

2. Select one or more VolumeCopy pairs in the table. You can select more than
one VolumeCopy pair by pressing Ctrl and the left mouse button.

3. Click Change » Target Logical Drive Permissions » Disable Read-Only.

The read-only attribute is disabled on the target logical drive. Write requests to
the target logical drive are permitted.

When the read-only attribute for a target logical drive is enabled, a lock icon
displays in the Target Logical Drive column of the Copy Manager. The read-only
attribute can be changed in the Copy Manager only after the VolumeCopy operation
completes.

Re-copying the source logical drive in a VolumeCopy pair
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When you re-copy the source logical drive in a VolumeCopy Pair, you create a new
copy of the source logical drive data on an associated target logical drive. You can
use Re-Copy to create a new copy from the beginning if the original VolumeCopy
operation fails, was stopped, or has completed. You can also use Re-Copy for
backup purposes; for instance, if the data on the source logical drive changes, you
can use Re-Copy to duplicate any new data to the target logical drive.

Attention: Re-copying overwrites existing data on the target logical drive and
makes the target logical drive read-only to hosts until you disable the read-only
attribute in the Copy Manager.

Important: Note the following points before you re-copy logical drives:

» |If hosts have been mapped to the source logical drive, the data that is re-copied
to the target logical drive might have changed since the previous VolumeCopy
was created.

» To use Re-Copy, select only one VolumeCopy in the Copy Manager.

+ See|Selecting the source logical drive” on page 50| and [‘Selecting the targef]
|Iogica| drive” on page 51| for information about what types of logical drives you
can use as source and target logical drives.
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Perform the following steps to create a new VolumeCopy of the data on a selected
VolumeCopy pair:

1. Stop all I/O operations to the source logical drive and target logical drive.
2. Unmount any filesystems on the source logical drive and target logical drive.
3. Click Select Logical Drive » Copy » Copy Manager.

The Copy Manager window opens.

4. Click on the VolumeCopy pair or press Enter to select the VolumeCopy pair in
the table.

5. Click Copy » Re-Copy.

The Re-Copy window opens.
6. Set the copy priority.

See |“Setting the copy priority” on page 54| for more information.
7. Type Yes and click OK.

The VolumeCopy operation begins.

Note: You can view the progress of a VolumeCopy operation in the Copy
Manager only when a VolumeCopy operation has a status of In
Progress.

Stopping a VolumeCopy operation

You can stop a VolumeCopy operation with a status of Pending, In Progress, or
Failed. If you decide not to use a particular logical drive as a source logical drive or
target logical drive, you can stop the VolumeCopy operation before it completes.
Then after you delete the VolumeCopy pair definition, the logical drives can be used
in a new VolumeCopy pair.

Note: If you stop a VolumeCopy operation with a status of Failed, the
Needs-Attention condition on a storage subsystem is cleared.

Important: Note the following points before you stop a VolumeCopy operation:

 If the copying process was stopped prematurely, there is no guarantee that the
target logical drive will be in a usable state.

» Select only one copy pair in the Copy Manager.

* When the VolumeCopy operation is stopped, all mapped hosts will have write
access to the source logical drive. If data is written to the source logical drive,
the data on the target logical drive will no longer match the data on the source
logical drive.

Perform the following steps to stop a VolumeCopy operation:
1. Click Select Logical Drive » Copy » Copy Manager .
The Copy Manager window opens.

2. Click on the VolumeCopy pair or press Enter to select the VolumeCopy pair in
the table.

3. Click Copy ~» Stop.
The Stop Copy window opens.
4. Click Yes.
The VolumeCopy operation stops.
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Removing copy pairs

You can remove one or more VolumeCopies from the Copy Manager. Any
VolumeCopy copy-related information for the source and target logical drive is
removed from the Logical Drive Properties and Storage Subsystem Profile windows.
After you remove the VolumeCopy, you can use the source logical drive and target
logical drive in a new VolumeCopy. When you remove the VolumeCopy, the
read-only attribute for the target logical drive is also removed.

After the VolumeCopy is removed from the Copy Manager, you can select the target
logical drive as a source logical drive or target logical drive for a new VolumeCopy.

If you remove a VolumeCopy, the source logical drive and target logical drive are no
longer displayed in the Copy Manager.

Important: Note the following points before you remove VolumeCopy pairs:

» This action does not delete the data on the source logical drive or target logical
drive.

 If the VolumeCopy operation has a status of In Progress, it must be stopped
before you can remove the VolumeCopy pair from the Copy Manager.

Perform the following steps to remove VolumeCopy pairs from the Copy Manager:
1. Click Select Logical Drive » Copy » Copy Manager.
The Copy Manager window opens.

2. Select one or more VolumeCopy pairs in the table. You can select more than
one VolumeCopy pair by pressing Ctrl and the left mouse button.

3. Click Copy » Remove Copy Pairs.
The Remove Copy Pairs window opens.
4. Click Yes.
The VolumeCopy is removed.

VolumeCopy and other premium features

This section describes how VolumeCopy can be used with other premium features
that are available with Storage Manager Version 8.4. This section covers Storage
Partitioning, FlashCopy, and the Remote Mirroring Option. Although Storage
Partitioning is not covered in this guide, it is a premium feature that is offered with
Storage Manager Version 8.4. For more information about Storage Partitioning, see
your operating system installation and user’s guide or see the Storage Manager
online help.

Storage Partitioning and VolumeCopy
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Note: Storage Partitioning is not a copy services premium feature. This guide does
not describe how to enable and use the storage partitioning feature. For
more information about Storage Partitioning, see the IBM FAStT Storage
Manager Version 8.4 Installation and Support Guide for your specific
operating system.

Storage Partitioning is a feature that enables hosts to share access to logical drives
in a storage subsystem. A storage partition is created when you define a collection
of hosts (a host group) or a single host and then define a volume-to-LUN mapping.
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This mapping allows you to define what host group or host will have access to a
particular logical drive in the storage subsystem.

After a VolumeCopy has been created, the target logical drive automatically
becomes read-only to hosts to ensure that the data is preserved. Hosts that have
been mapped to a target logical drive do not have write access to the volume, and
any attempt to write to the read-only target logical drive results in a host 1/O error.

If you want hosts to have write access to the data on the target logical drive, use
the Copy Manager to disable the read-only attribute for the target logical drive. For
more information about changing the target volume read-only attribute, see
the target logical drive read-only attribute option” on page 67|

FlashCopy and VolumeCopy

A FlashCopy logical drive is a point-in-time image of a standard logical drive and is
typically created so that an application, such as a backup application, can access
the FlashCopy logical drive and read the data while the base logical drive remains
online and accessible to hosts.

Always use a FlashCopy logical drive as the source logical drive for a VolumeCopy.

Important: If you choose the base logical drive of a FlashCopy logical drive as your
target logical drive, you must disable all FlashCopy logical drives that are
associated with the base logical drive before you can select it as a target logical
drive.

When you create a FlashCopy logical drive, a FlashCopy repository logical drive is
automatically created. The FlashCopy repository logical drive stores information
about the data that has changed since the FlashCopy logical drive was created.
FlashCopy repository logical drives cannot be selected as source logical drives or
target logical drives in a VolumeCopy pair.

FlashCopy can be used with VolumeCopy to back up data on the same storage
array, and to restore the data on the FlashCopy logical drive back to its original
base logical drive.

The Remote Mirror Option and VolumeCopy

The Remote Mirror Option is used for online, real-time replication of data between
storage subsystems over a remote distance. In the event of a disaster or a
catastrophic failure of one storage subsystem, you can promote a second storage
subsystem to take over responsibility for computing services.

When you create a remote mirror, a mirrored logical drive pair is created, consisting
of a primary logical drive at the primary storage subsystem and a secondary logical
drive at a secondary, remotely located storage array.

The primary logical drive is the logical drive that accepts host I/O and stores data.
When the mirror relationship is initially created, data from the primary logical drive is
copied in its entirety to the secondary logical drive. This process is known as a full
take synchronization and is directed by the controller owner of the primary logical
drive. During a full synchronization, the primary logical drive remains fully
accessible for all normal I/O activity.

The controller owner of the primary logical drive initiates remote writes to the
secondary logical drive to keep the data on the two logical drive synchronized.
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Role reversals

Whenever the data on the primary logical drive and the secondary logical drive
becomes unsynchronized, the controller owner of the primary logical drive initiates a
full synchronization.

The secondary logical drive maintains a mirror of the data on its associated primary
logical drive. The controller owner of the secondary logical drive receives remote
writes from the primary logical drive controller owner, but will not accept host read
or write requests.

The secondary logical drive remains unavailable to host applications while mirroring
is in progress. In the event of a disaster or catastrophic failure at the primary site,
you can perform a role reversal to promote the secondary logical drive to a primary
role. Hosts are then able to access the newly promoted logical drive and business
operations can continue. For more information about performing a role reversals,
see [‘Role reversals.”|

A primary logical drive that participates in a remote mirror can be selected as the
source logical drive for a VolumeCopy. A secondary logical drive that participates in
a remote mirror cannot be selected as a source logical drive or target logical drive
and is not available in the Create Copy wizard when you create a VolumeCopy.

For more information about the Remote Mirror Option, see to the Subsystem
Management window online help.

A role reversal is the act of promoting the secondary logical drive to be the primary
logical drive of the mirrored logical drive pair, and demoting the primary logical drive
to the secondary logical drive role.

In the event of a disaster at the storage subsystem that contains the primary logical
drive, you can fail over to the secondary site by performing a role reversal to
promote the secondary logical drive to the primary logical drive role. This allows
business operations to continue and hosts to continue accessing data.

You can use one of the following methods to perform a role reversal:

* Click Volume » Remote Mirroring » Change » Role to Primary to change a
secondary logical drive to a primary logical drive.

This option promotes the selected secondary logical drive to become the primary
logical drive of the mirrored pair, and can be used when a catastrophic failure
has occurred. For step-by-step instructions, see the Subsystem Management
window online help.

» Click Volume » Remote Mirroring » Change » Role to Secondary to change a
primary logical drive to a secondary logical drive.

This option demotes the selected primary logical drive to the secondary logical
drive role, and can be used during normal operating conditions. For step-by-step
instructions, see the Subsystem Management Window online help.

If the primary logical drive is selected as the source logical drive for a VolumeCopy,
any VolumeCopies that have a status of In Progress or Pending when the role
reversal takes place fail, and cannot be started again until the primary logical drive
is demoted back to its original Remote Mirror secondary logical drive role.

If the primary storage array is recovered but is unreachable due to a link failure, a
forced promotion of the secondary logical drive results in both the primary and
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secondary logical drives viewing themselves in the primary logical drive role
(dual-primary condition). If this occurs, the logical drive copy in which the primary
logical drive is participating will be unaffected by the role change.
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Chapter 5. Troubleshooting VolumeCopy

This chapter provides information about troubleshooting some of the more common
problems encountered when you use the VolumeCopy feature. The troubleshooting
topics that are included are general VolumeCopy problems and premium feature
troubleshooting topics. Locate the section that is directly related to your problem, or
consult the section that describes general troubleshooting techniques. If your
problem is not discussed in any of the sections in this chapter, contact technical
support.

General troubleshooting

[Table 3| describes some of the typical problems you might encounter when you use
the VolumeCopy feature. The information in this section is presented in sequence,
from the time the feature is enabled to problems that you might encounter when
you use the VolumeCopy feature.

Information about the probable cause and recommended resolution for each
problem are provided. If your problem is not addressed in this chapter, contact
technical support.

Table 3. General troubleshooting for the VolumeCopy feature

Problem

Cause

Resolution

The VolumeCopy menu options in the
Subsystem Management window are
greyed out and unavailable

The VolumeCopy feature is not
enabled.

Enable the VolumeCopy feature. You
must use a Feature Key File to enable
premium features. If one has not been
supplied, contact your storage
supplier.

For step-by-step instructions about
enabling the VolumeCopy feature, see

“Enabling premium features” on page|

3] or the Subsystem Management
Window online help.

The VolumeCopy icon in the premium
status area is greyed out with a red
line

The VolumeCopy feature is not
enabled.

Enable the VolumeCopy feature. You
must use a Feature Key File to enable
premium features. If one has not been
supplied, contact your storage
supplier.

For step-by-step instructions about
enabling the VolumeCopy feature, see

“Enabling premium features” on page|

or the Subsystem Management
Window online help.

The Create Copy option is not
available after selecting a source
logical drive in the Logical view

The logical drive that you have
chosen to be the source logical drive
for the VolumeCopy is not a valid
source logical drive.

See|["Selecting the source logicall

|drive” on page 50 for more

informations on source logical drives.

Select a valid source logical drive,
which can be one of the following:

» A standard logical drive

* A FlashCopy logical drive

* A base logical drive of a FlashCopy
logical drive

» A primary logical drive that is
participating in a Remote Mirror.
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Table 3. General troubleshooting for the VolumeCopy feature (continued)

Problem

Cause

Resolution

The source logical drive or target
logical drive is displayed as being a
missing logical drive

A physical drive on which the
VolumeCopy depends (such as a
source logical drive or target logical
drive) has been removed, and the
logical drive is now displayed under
the Missing Logical Drive node in the
Logical view of the Subsystem
Management window.

If logical drives are missing because
of a power loss to the drive trays or
because drives have accidentally
been removed, you can recover these
logical drive by completing the
following steps:

1. Re-insert the drives into the drive
tray.

2. Ensure that the power supplies for
the drive tray are properly
connected to an operating power
source and have an Optimal
status.

Important: Deleting a missing volume
is a permanent action. Any associated
logical drives or logical drive-to-LUN
mappings will also be deleted.

For more information about
troubleshooting missing volumes, refer
to the Recovery Guru or contact
technical support. If the missing
logical drive is no longer required, it
can be deleted.

The controller owner for the source
logical drive or target logical drive
changes after the VolumeCopy
operation has completed

When the VolumeCopy operation
started, the preferred controller did not
have ownership of both the source
logical drive and target logical drive.

During a VolumeCopy operation, the
same controller must own both the
source logical drive and the target
logical drive. If both logical drives do
not have the same preferred controller
when the VolumeCopy operation
starts, the ownership of the target
logical drive automatically transfers to
the preferred controller of the source
logical drive.

When the VolumeCopy operation
completes or is stopped, ownership of
the target logical drive is restored to
its preferred controller. If ownership of
the source logical drive changes
during the VolumeCopy operation,
ownership of the target logical drive
also changes.

A VolumeCopy that includes a source
logical drive that is participating in a
remote mirror has a status of In
Progress, Pending, or Completed, but
has failed

In response to a catastrophic failure at
the primary storage subsystem, a role
reversal has occurred. The secondary
logical drive in the mirrored pair was
promoted to the primary volume role,
while the primary volume was
demoted to the secondary volume
role.

After the preferred controller of the
primary logical drive can be contacted,
a role reversal will automatically take
place and you can then restart the
VolumeCopy operation.

For more information about role
reversals, see [‘Role reversals” on|

|9age 72.|
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Table 3. General troubleshooting for the VolumeCopy feature (continued)

Problem

Cause

Resolution

The error message indicates that the
VolumeCopy feature is out of
compliance

The VolumeCopy feature is out of
compliance.

This normally occurs if a logical drive
group with existing VolumeCopies has
been moved into a storage subsystem
where the feature is not authorized, or
if you have disabled the feature on a
storage subsystem where the feature
is authorized, and you have existing
VolumeCopies present.

 If the VolumeCopy feature is not
authorized for this storage
subsystem and you want to
authorize it, or the VolumeCopy
feature is authorized for this
storage subsystem but you have
disabled it, complete the following
steps to clear the error:

1. Obtain a new Feature Key File
for this feature, or retrieve the
existing Feature Enable
Identifier by clicking Storage
Subsystem » Premium
Features » List in the
Subsystem Management
window.

2. Enable the VolumeCopy

feature. For step-by-ste
instructions, see [‘Enablin
premium features” on page 3|or

the Subsystem Management
window online help.

 If the VolumeCopy feature is not
authorized for this storage
subsystem and you do not want to
authorize it, disable the
VolumeCopy feature by clicking
Storage Subsystem » Premium
Features » Disable in the
Subsystem Management window.

For more information about disabling
premium features, see to the
Subsystem Management window
online help.
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Table 3. General troubleshooting for the VolumeCopy feature (continued)

Problem

Cause

Resolution

The error message indicates that the
selected source logical drive has a
reservation placed on it

Logical drives that are configured with
a legacy or persistent reservation
cannot be selected as a source logical
drive or a target logical drive for a
VolumeCopy.

Clear the reservation for the selected
logical drive, and then recreate the
VolumeCopy.

1. Click Advanced » Persistent
Reservations to open the
Persistent Reservations window.

Ensure that the View Associated
Registrations check box is
deselected in the upper left corner
of the Persistent Reservations
window.

2. Click one or more desired logical
drives. To select all logical drives,
click Select All. The selected
logical drives or all logical drives
are highlighted, depending on your
selection.

3. Click Clear.
The Clear
Registrations/Reservations window
opens.

4. Type Yes in the confirmation field.
The OK button is enabled.

5. Click OK, or click Cancel to return
to the main Persistent

Reservations window without
clearing any reservations.

The reservations and registrations that
are associated with the logical drives
that you highlighted in the upper pane
are cleared.

VolumeCopy critical events

Critical major event Log (MEL) events are generated when an error occurs that can
affect data availability or that results in a degraded mode of operation. The storage
management software responds by alerting the appropriate administrators by
e-mail, SNMP trap, or other configured mechanisms.

Because administrative action is required to correct the problem, the storage
subsystem generally enters a Needs Attention status. Therefore, the appropriate
indications are presented through the storage management software and an
associated Recovery Guru procedure displays when requested.

[Table 4 on page 79| provides a description of critical MEL events, with a brief

explanation of what caused the event, and the recommended resolution. If your
critical MEL event is not included in this section, contact technical support.
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Table 4. VolumeCopy critical events

Problem Cause Resolution
Event 6600 - VolumeCopy Operation | This event is logged when a For specific recovery procedures, see
Failed VolumeCopy with a status of In the Recovery Guru.

Progress or Pending fails. A Needs
Attention status is also reported for
the storage subsystem.

This failure can be caused by a read
error on the source logical drive, a
write error on the target logical drive,
or because of a failure that occurred
on the storage subsystem that affects
the source logical drive or target
logical drive.

Chapter 5. Troubleshooting VolumeCopy
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Chapter 6. Overview of the Remote Mirror Option

This chapter introduces the basic concepts of the Remote Mirror Option, describes
what a remote mirror is, how information is replicated between storage subsystems,
the software and hardware required, and the preferred system configurations.

Basic concepts of the Remote Mirror Option

The Remote Mirror Option is a premium feature that comes with the IBM FAStT
Storage Manager 8.4 software and is enabled by purchasing a premium feature
key. The Remote Mirror Option is used for online, real-time replication of data
between storage subsystems over a remote distance. In the event of a disaster or
unrecoverable error at one storage subsystem, the Remote Mirror Option enables
you to promote a second storage subsystem to take over responsibility for normal
I/O operations.

The maximum number of storage subsystems that can participate in a remote
mirror configuration is two. The two storage subsystems are called primary and
secondary storage subsystems or local and remote storage subsystems. These
names are used interchangeably to describe remote mirror setups or concepts. The
names do not refer to the location of storage subsystems or to the role that storage
subsystems have in a remote mirror relationship.

Primary and secondary logical drives on a remote mirror setup

This section introduces you to primary and secondary logical drives, and describes
how they interact to replicate data between storage subsystems using the Remote
Mirror Option. When you create a remote mirror, a mirrored logical drive pair is
defined and consists of a primary logical drive at the primary storage subsystem,
and a secondary logical drive at a secondary storage subsystem. A standard logical
drive might only be defined in one mirrored logical drive pair. The maximum number
of supported mirrored logical drive pairs is determined by the storage subsystem
model.

The primary and secondary role in a remote mirror setup is implemented at the
logical drive level instead of at the storage subsystem level. All logical drives that
participate in a remote mirror relationship on a storage subsystem can be in either a
primary or secondary role only. The storage subsystem can also have a
combination of logical drives in a primary role and logical drives in a secondary role.
Whether the logical drive is in a primary or secondary role, it counts towards the
maximum number of mirror logical drive pairs that can be defined in a storage
subsystem.

There are no requirements for having a certain number of logical drives be of a
certain role in a remote mirror relationship for a given storage subsystem. For
example, a storage subsystem with a maximum of 16 remote mirror relationship
pairs might have logical drives in any one of the remote mirror relationship
combinations shown in [Table 5 on page 82
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Table 5. Remote Mirror drives in primary and secondary roles

Remote mirror
drives in a
secondary role

Remote mirror
drives in a
primary role

16 0

Description

This local storage subsystem has data in 16 logical
drives mirrored in 16 logical drives in a separate
(remote) storage subsystem.

This local storage subsystem has data in eight logical
drives mirrored in eight logical drives in a remote
storage subsystem. It also has eight logical drives that
are used to store the mirrored data from eight logical
drives in a remote storage subsystem.

There are four logical drives that are used to store the
mirrored data from four logical drives in a remote
storage subsystem. It also has 12 logical drives that
are used to store the mirrored data from 12 logical
drives in a remote storage subsystem.

This local storage subsystem has 16 logical drives that
are used to store the mirrored data from 16 logical
drives in a remote storage subsystem.

With controller firmware 05.30.xx.xx. and higher, there is a limit to how many logical
drives that you can create in a single storage subsystem. When Remote Mirror
Option is enabled, the total number of logical drives that are supported for each
storage subsystem is reduced from the number of logical drives that you would
have without the Remote Mirror Option enabled. The reduced maximum number of
logical drives that a FAStT storage subsystem can support with firmware version
05.30.xx.xx and higher depends on the model of the FAStT storage subsystem. See

able 6[for more information.

Table 6. Logical drives using the Remote Mirror option for firmware version 5.3x.xx.xx and
higher

Maximum logical drives

Maximum logical

per storage mapping

Maximum FlashCopy

Model type |drives partition logical drives

3542 N/A (See note 7) N/A N/A

1722 N/A (See note 7) N/A N/A

3552 512 (See notes 3 and 6) |32 (See note 5) 255 (See note 2)

1742 2048 (See notes 1, 4, 32 or 256 (See note 5) 1023 (See note 2)
and 6)

Notes:

1. When using firmware version 5.xx.xx, the firmware reserves one logical drive for
the system to use.

2. There is a maximum of four FlashCopy logical drives for each standard logical

drive.

3. There is a maximum of eight remote mirror pairs.
4. There is a maximum of 32 remote mirror pairs.

5. The host-agent management method uses a special logical drive, called an
access logical drive, to communicate with the controllers on the storage
subsystem. The access logical drive uses one of the available LUNs. Therefore,
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managing storage subsystems with the host-agent software limits you to one
fewer LUN than the maximum number that is supported by the operating system
and the host adapter.

For controller firmware 05.4x.xx.xx and higher the maximum number of logical
drives per storage mapping partition is increased to 256. However, depending
on the operating system limitations, the actual number of supported LUNs
logical drives per storage mapping partition is less than 256.

6. For firmware version 05.3x.xx.xx, the maximum number of logical drives
includes the FlashCopy repository logical drives and the Remote Mirror
repository logical drives, in addition to the standard data logical drives. If the
Remote Mirror option is enabled, two logical drives are reserved for the system
to use.

7. The IBM FAStT200 (machine type 3542) and the IBM FAStT600 (machine type
1722) storage subsystems do not support the Remote Mirror option.

The primary logical drive is the drive that accepts host computer I/O and stores
program data. When you first create the mirror relationship, data from the primary
logical drive is copied (becomes a mirror image) in its entirety to the secondary
logical drive. This process is known as a full synchronization and is directed by the
controller owner of the primary logical drive. During a full synchronization, the
primary logical drive remains fully accessible for all normal I/O operations.

When a write request is made to the primary logical drive, the controller owner of
the primary logical drive also initiates a remote write request to the secondary drive.
The write request does not complete until both write requests are performed. This
additional write request keeps the data on the two logical drives in the remote
mirror relationship synchronized. Whenever the data on the primary drive and the
secondary drive becomes unsynchronized, the controller owner of the primary drive
initiates a full synchronization.

The secondary logical drive is used to store data that is copied from its associated
primary logical drive. The controller owner of the secondary logical drive receives
remote writes from the controller owner of the primary logical drive and will not
accept host read or write requests.

The secondary logical drive is unavailable to host computer programs while
mirroring is performed. In the event of a disaster or unrecoverable error of the
primary storage subsystem, a role reversal is performed to promote the secondary
logical drive to the primary logical drive. Host computers will then be able to access
the newly-promoted logical drive and normal operations can continue.

[Figure 26 on page 84| shows the primary and secondary logical drives displayed in
the Subsystem Management window for the primary storage subsystem and the
secondary storage subsystem.
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Primary storage subsystem

@ Logical/Physical View |
Logical

£5l Storage Subsystem Primary Site

Ej Unconfigured Capacity (8.44 GB)
B% Logical Drive Group 1 (RAID 5)

CTL A Mirror Repository (0.004 GB)
CTL B Mirror Repository (0.004 GB)
ﬁ] Free Capacity (10.873 GB)

Primary Logical Drive (5 GB) |

| Secondary Logical Drive

Both the primary and secondary
logical drives are displayed in the
Subsystem Management window

Secondary storage subsystem

Logical/Physical View |
Logical

3]
3|

5 Storage Subsystem Secondary Site

@ Unconfigured Capacity (8.44 GB)
=& Logical Drive Group 1 (RAID 5)

CTL A Mirror Repository (0.004 GB)
—— CTL B Mirror Repository (0.004 GB)
-{@ Free Capacity (10.873 GB)

E‘} Secondary Logical Drive |

Only the secondary logical drive
is displayed in the Subsystem
Management window for the

for the storage subsystem. secondary storage subsystem.

SJ001109

Figure 26. Primary and secondary logical drives displayed in the Subsystem Management
window

Mirror repository logical drives

84

A mirror repository logical drive is a special logical drive in the storage subsystem. It
is created as a resource for the controller owner of the primary logical drive in a
remote logical drive mirror. The controller stores mirrored information on this logical
drive, including information about remote write requests that are not yet written to
the secondary logical drive. The controller can use this information to recover from
controller resets or if the storage subsystems are accidentally turned off.

When you activate the Remote Mirror Option on the storage subsystem, two mirror
repository logical drives are created, one for each controller in the storage
subsystem. An individual mirror repository logical drive is not needed for each mirror
logical drive pair.

When you create the mirror repository logical drives, you specify their location. You
can either use existing free capacity (shown in [Figure 27 on page 85) or you can
create an array for the logical drives from unconfigured capacity and then specify
the RAID level.

Because of the critical nature of the data that is stored, the RAID level of mirror
repository logical drives must be non-zero. The required size of each logical drive is
4 MB, for each mirror repository logical drive.

[Figure 27 on page 85| shows mirror repository logical drives displayed in the
Subsystem Management window for the primary storage subsystem.
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] Logical/Physical View |
Logical

FEl Storage Subsystem Primary Site

[ 1] Unconfigured Capacity (8.44 GB)
E% Logical Drive Group 1 (RAID 5)
CTL A Mirror Repository (0.004 GB)
CTL B Mirror Repository (0.004 GB)
Ejl Free Capacity (10.873 GB)
Primary Logical Drive (5 GB)

Lo Secondary Logical Drive

w

Mirror Repository logical drives

Figure 27. Mirror repository logical drives displayed in the Subsystem Management window

Mirror relationships

Before you define a mirror relationship, the Remote Mirror Option must be enabled
on both the primary and secondary storage subsystems. A secondary standard
logical drive candidate must be created on the secondary storage subsystem if one
does not already exist. It must be a standard logical drive and be at least the same
size or larger than the primary logical drive.

When secondary logical drive candidates are available, you can define a mirror
relationship in the storage management software by identifying the storage
subsystem that contains the primary logical drive and the storage subsystem that
contains the secondary logical drive.

When you set up the mirror relationship, a full synchronization occurs as data from
the primary logical drive is copied in its entirety to the secondary logical drive. For
more information about establishing mirror relationships, sed“Creating mirroi
Irelationships” on page 121

Data replication

This section describes how data is replicated between storage subsystems that are
participating in remote logical drive mirroring, and the actions that are taken by the
controller owner of the primary logical drive if a link interruption occurs between
storage subsystems. Data replication between the primary logical drive and the
secondary logical drive is managed by the controllers and is transparent to host
computers and programs.

When the controller owner of the primary logical drive receives a write request from
a host computer, the controller first logs information about the write request to its
mirror repository logical drive, and then writes the data to the primary logical drive.
The controller then initiates a remote write operation to copy the affected data
blocks to the secondary logical drive at the secondary storage subsystem.
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After the host computer write request is written to the primary logical drive and the
data is successfully copied to the secondary logical drive, the controller removes
the log record on the mirror repository logical drive and sends an I/O completion
message back to the host computer. See [Figure 2§ for the data replication process.

1. The host sends 3. Data is logged to 4. Data is written to the 5. Data is then copied to
the write request. the mirror repository primary logical drive. the mirrored secondary
logical drive. logical drive.

Host 7. The write -

request is re'\rftl)gﬁgry :

completed logical drive !

and sent to !

the host. !

1

1

Controller Controller :

A Primary T ’
H logical drive

1

1

1
2. The write request 1
is received by the Primary 1 Secondary
controller owner of the storage subsystem ! storage subsystem
primary logical drive. : I

6. The /O completion
indication is sent.

$J001106

Figure 28. Data replication between primary and secondary storage subsystems

Because the controller does not send the I/O completion message to the host
computer until the data is copied to both the primary and secondary logical drives,
this mirroring operation is called synchronous.

When a read request is received from a host computer, the controller owner of the
primary logical drive manages the request. No communication takes place between
the primary and secondary storage subsystems.

Link interruptions or secondary logical drive errors

86

In the course of processing write requests, a primary controller might be able to
write to the primary logical drive while a link interruption prevents communication
with the remote secondary controller.

After a link interruption, the remote write operation cannot complete to the
secondary logical drive and the primary and secondary logical drives are no longer
correctly mirrored. The primary controller transitions the mirrored pair into an
Unsynchronized status and sends an 1/O completion message to the primary host
computer, as shown in |Figure 29 on page 87|. The primary host computer can
continue to write to the primary logical drive but remote write operations will not
take place.
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Primary Storage Subsystem
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Logical

5 S sompen Py ste__|
ﬁ Unconfigured Capacity (8.44 GB)
EI[% Logical Drive Group 1 (RAID 5)
Mirror Repository 1 (0.004GB)
Mirror Repository 2 (0.004GB)
E@ Primary Logical Drive (5 GB)

Secondary Storage Subsystem

[ Logical/Physical View |

Logical

i Storage Subsystem Secondary Site

@ Unconfigured Capacity (8.44 GB)

-8 Logical Drive Group 1 (RAID 5)
Mirror Repository 1 (0.004GB)

: ‘ Mirror Repository 2 (0.004GB)

E‘ﬁ' Secondary Logical Drive

Figure 29. Mirrored logical drive pair showing Unsynchronized status

When connectivity is restored between the controller owner of the primary logical
drive and the controller owner of the secondary logical drive, a full synchronization
automatically takes place. The mirrored pair transitions from an Unsynchronized
status to a Synchronization-in-Progress status, as shown in

Primary Storage Subsystem

(T3 LogicalPhysical View |

Logical

EE Storage Subsystem Primary Site

I:j Unconfigured Capacity (8.44 GB)

E[% Logical Drive Group 1 (RAID 5)
- [ Mirror Repository 1(0.004 GB)
Mirror Repository 2 (0.004 GB)

&£ Primary Logical Drive (5 GB)

Secondary Storage Subsystem

{1 Logical/Physical View |

Logical

Storage Subsystem Secondary Site

i Eﬁ Unconfigured Capacity (8.44 GB)
E!% Logical Drive Group 1 (RAID 5)
Mirror Repository 1 (0.004 GB)
-- Mirror Repository 2 (0.004 GB)
E@) Secondary Logical Drive

Figure 30. Mirrored logical drive pair showing Synchronization-in-Progress status

The primary controller marks the mirrored pair as unsynchronized when a logical
drive error from the secondary storage subsystem prevents a remote write
operation from completing. For example, an offline or a failed secondary logical
drive can cause the remote logical drive mirror to become unsynchronized. When
the logical drive error is corrected (the secondary logical drive is placed online or
recovered to an Optimal status) then a full synchronization automatically begins and
the mirrored pair transitions to a Synchronization-in-Progress status.

For more information about Remote Mirror Option status, see [Chapter 8, “Using thel

[Remote Mirror Option,” on page 121
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Connectivity and 1/0

The Remote Mirror option requires a dedicated host port for mirroring data between
storage subsystems. This section describes three configurations that you can use to
connect storage subsystems for remote logical drive mirroring, controller ownership
of logical drives within storage subsystems, the maximum storage subsystem
distance permitted, and some general performance considerations. If these
configurations do not meet your remote mirror configuration requirement, contact
your IBM technical-support representative.

Host minihubs

Controller A host port A1
Controller B host port B1
Controller A host port A2
Controller B host port B2

l
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Figure 31. Controller A and Controller B host ports

The Remote Mirror Option is supported on FASIT storage subsystems that have at
least two fibre-channel host ports per controller (machine types 3552 and 1742)
although it is not supported on the FAStT600 (machine type 1722). When Remote
Mirror Option is activated, one fibre-channel host-side 1/0 port on each controller is
dedicated only to mirroring operations. For example, in the primary storage
subsystem, controller host ports A2 and B2 are dedicated to mirroring operations. In
the secondary storage subsystem, controller host ports A2 and B2 are also
dedicated to mirroring operations. See for the location of the controller
host port.

Each of the controller host ports are connected to a minihub. Each minihub has two
small form-factor pluggable (SFP) or gigabit interface converter (GBIC) port slots. If
the first minihub SFP or GBIC port slot is connected to a fibre-channel switch port
as part of remote mirror setup, the second minihub port must not be occupied.

Host-initiated 1/O operations are refused by the dedicated port. Requests that are
received on this dedicated port are only accepted from a controller that is
participating in the remote mirror relationship.

Controller ports that are dedicated to the remote logical drive mirror must be
attached to a fibre-channel fabric environment with support for the Directory Service
and Name Service interfaces.

Logical drive ownership

88

The controller owner of the primary logical drive attempts to communicate with only
its mirrored controller in the secondary storage subsystem. As shown in[Figure 32

controller A in the primary storage subsystem attempts to communicate

with controller A in the secondary storage subsystem.
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The controller (A or B) that owns the primary logical drive determines the controller
owner of the secondary logical drive. Regardless of the secondary logical drive
controller ownership, if the primary logical drive is owned by controller A on the
primary storage subsystem, the secondary logical drive is then owned by controller
A on the secondary storage subsystem. If primary controller A cannot communicate
with secondary controller A, no controller ownership changes take place and the
remote mirror link is broken for that mirror logical drive pair. When primary controller
A can communicate with secondary controller A, the next I/O request to the primary
logical drive results in a secondary drive ownership change.

Primary
logical drive
Finance

Secondary
logical drive

Finance

Port Port Port Port Port Port Port Port
B2 B1 A2 Al B2 B1 A2 A1

Controller B Controller A Controller B Controller A
Primary storage subsystem Secondary storage subsystem

Figure 32. Controller A shown as the controller owner

When an 1/O path error causes a logical drive ownership change on the primary
storage subsystem, or if the storage administrator changes the controller owner of
the primary logical drive, the next remote write request that is processed
automatically starts an ownership change on the secondary storage subsystem.

As shown in [Figure 33 on page 90| if a primary logical drive is owned by controller
A and the controller owner is changed to controller B, the next remote write
operation changes the controller owner of the secondary logical drive from controller
A to controller B.
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Primary
logical drive

Secondary
logical drive

Finance Finance

Port Port Port Port Port Port Port Port
B2 B1 A2 A1 B2 B1 A2 Al

Controller B Controller A Controller B Controller A
Primary storage subsystem Secondary storage subsystem

Figure 33. Controller B shown as controller owner

Because controller ownership changes on the secondary storage subsystem are
controlled by the primary controller, they do not require any special intervention and
you cannot manually change them.

Primary and secondary storage subsystem connection distance

The maximum connection distance that is permitted between storage subsystems
that are participating in a mirror relationship is governed by the distance limits of the
fibre-channel interswitch links (ISL). Using standard single mode fiber technology, a
maximum link distance of 10 Km (6.25 mi) between storage subsystems can be
achieved. In addition, the ISL link must be a standard fibre-channel connection
using single mode fibre-channel cables between two longwave GBICs or SFPs that
are inserted into the fibre-channel switch port slots. Contact your IBM
technical-support representative if you need a remote mirror configuration with a link
distance greater than 10 Km (6.25 mi) or if you need protocol (for example,
FC-ATM-FC) conversion between remote mirror nodes.

Note: The IBM FASIT Storage Manager Version 8.4 software limits distances
between storage subsystems in a fibre-channel environment to
10 Km (6.25 mi).

General performance considerations

90

Note the following general performance considerations when you create remote
mirrors:

* The controller owner of a primary logical drive performs a full synchronization in
the background while processing local I/O write operations to the primary logical
drive and associated remote write operations to the secondary logical drive.
Because a full synchronization diverts controller processing resources from 1/0
activity, this can impact performance to the host computer program.

To reduce the performance impact, you can set the synchronization priority to
establish how the controller owner prioritizes a full synchronization relative to
other I/O activity. The following are some basic guidelines for setting the
synchronization rate:
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— A full synchronization at the lowest synchronization priority rate takes
approximately eight times as long as a full synchronization at the highest
priority synchronization rate.

— A full synchronization at the low synchronization priority rate takes
approximately six times as long as a full synchronization at the highest priority
synchronization rate.

— A full synchronization at the medium synchronization priority rate takes
approximately three and a half times as long as a full synchronization at the
highest priority synchronization rate.

— A full synchronization at the high synchronization priority rate takes
approximately twice as long as a full synchronization at the highest priority
synchronization rate.

For more information about setting the synchronization priority, see [Chapter 8,
[‘Using the Remote Mirror Option,” on page 121

* When the mirror logical drive pair is in the Synchronization-in-Progress status,
all host computer write data is copied to the remote system in processing the I/O.
Controller I/0O bandwidth and I/O latency affect host computer write performance.
Host read performance is not affected by the mirror relationship.

* The overall system performance is impacted when data is copied from the
primary logical drive to the secondary logical drive and when the number of write
operations that are permitted at one time are limited.

Using other premium features with the Remote Mirror Option

This section describes how you can use the Remote Mirror Option with the other
premium features that are available in Storage Manager version 8.4.

Storage Partitioning and the Remote Mirror Option

Note: Storage partitioning is not a copy services premium feature. This guide does
not describe how to enable and use the Storage Partitioning feature. For
more information about storage partitioning, see the IBM FAStT Storage
Manager Version 8.4 Installation and Support Guide for your specific
operating system.

Storage Partitioning is a premium feature which enables host computers to share
access to logical drives in a storage subsystem. A storage partition is created when
you define a collection of host computers (a host group) or a single host computer
and then define a logical drive to logical unit number (LUN) map. This map enables
you to define what host group or host computer has access to a particular logical
drive in your storage subsystem.

|Figure 34 on page 92| shows the Mappings view of the Subsystem Management
window, where primary logical drive Accounting is included in a partition that is
accessible by host group Campus East, and secondary logical drive Accounting 2 is
included in a partition that is accessible by host group Campus West.
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Figure 34. Mappings view of the Subsystem Management window showing storage
partitioning

The storage partition definitions for the primary and secondary storage subsystems
are independent of each other. If the storage partition definitions are put in place
while the logical drive is in the secondary role, the storage partition reduces the
administrative effort that is associated with storage subsystem recovery if it
becomes necessary to promote the secondary logical drive to the primary role.
However, depending on the host operating system and application, the secondary
logical drive might not be assigned to the same host that the primary logical drive is
mapped to. For more information about defining storage partitions, see the
Subsystem Management window online help.

Storage partition definitions can be performed using the Create command in the
Storage Manager Script window or the CLI. For more information, see the
Enterprise Management window online help.

FlashCopy and the Remote Mirror Option

92

FlashCopy is a premium feature that comes with the IBM FAStT Storage Manager
software. You can enable this premium feature by purchasing the FlashCopy option.
A FlashCopy logical drive is a point-in-time (real-time) image of a logical drive and
is created so that a program, such as a backup program, can access the
FlashCopy logical drive and read the data while the base logical drive remains
online and is accessible to host computers.

The logical drive on which the point-in-time image is created is known as the base
logical drive and must be a standard logical drive in the storage subsystem. For
remote logical drive mirroring, only the base logical drive of a FlashCopy logical
drive is permitted to be a candidate for the primary logical drive in a mirror
relationship. [Figure 35 on page 93 shows the primary logical drive (also the base
logical drive for the FlashCopy logical drive), the secondary logical drive, and the
FlashCopy repository logical drive in the Subsystem Management window for the
primary storage subsystem.
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Important: The base logical drive of a FlashCopy logical drive cannot be a
candidate for the secondary logical drive role in a mirror relationship. Otherwise, the
FlashCopy logical drive fails when the remote mirror relationship is created.

Secondary logical drives are restricted from being the base logical drive for a
FlashCopy logical drive because the full synchronization process would fill the
FlashCopy repository logical drive, resulting in a failed FlashCopy logical drive.

[ LogicalPhysical View |

Logical

R Storage Subsystem Primary Site

[:] Unconfigured Capacity (8.44 GB)

&5 &g Logical Drive Group 1 (RAID 5)

..... [EE3 Mirror Repository 1 (0.004GB)
..... Mirror Repository 2 (0.004GB)
..... [ Free Capacity (10.873 GB)

_| = @i Accounting (5 GB/0 GB usable) |
-8 Accounting 2

@ Accounting-1 (5 GB)
{ @& Accounting-R1 (0.466 GB)

[

FlashCopy logical drive
Secondary logical drive
Primary logical drive (also the basic logical drive

Figure 35. FlashCopy logical drive included in a mirror relationship

When FlashCopy is enabled, you can have FlashCopy logical drives that are based
on the primary logical drive of a mirrored logical drive pair.

If a role reversal is performed, and the primary logical drive is demoted to the
secondary logical drive status, all FlashCopy logical drives that are associated with
the demoted primary logical drive will show a Failed status.

Important: A secondary logical drive cannot be designated as the base logical drive
of a FlashCopy logical drive.

As shown in [Figure 36 on page 94, primary logical drive Accounting and secondary
logical drive Accounting 2 are displayed in the Logical view of the Subsystem
Management window for the primary storage subsystem. A FlashCopy logical drive
of primary logical drive Accounting was created.
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[Z LogicalPhysical View |
Logical
f#7 Storage Subsystem Primary Site

Ann

Ej Unconfigured Capacity (8.44 GB)
&5 &g Logical Drive Group 1 (RAID 5)
..... Mirror Repository 1 (0.004GB)

..... Mirror Repository 2 (0.004GB)
..... {@f Free Capacity (10.873 GB)

=@ Accounting (5 GB/0 GB usable)
----- Accounting 2

L@ Accounting-1 (5.GB) |
{38 Accounting-R1 (0.466 GB)

FlashCopy logical drive created, based
on primary logical drive Accounting

SJ001115

Figure 36. FlashCopy logical drive associated with primary logical drive Accounting

If a role reversal is performed, primary logical drive Accounting is demoted to
secondary role status and the FlashCopy logical drive fails. This is because the
secondary logical drive Accounting 2 is considered the base logical drive of the
FlashCopy logical drive, which is not permitted.

If a FlashCopy logical drive fails as the result of a role reversal, you must perform
another role reversal to promote the secondary logical drive back to primary logical
drive status. After the role reversal is complete, you must create the FlashCopy
logical drive again. For more information, see [Chapter 10, “Troubleshooting the]
[Remote Mirror Option,” on page 135
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Chapter 7. Installing hardware and software for the Remote
Mirror Option

This chapter contains the information that you need to install the hardware and
software to run the Remote Mirror Option. The first section contains the steps that
you must complete before you install the hardware and software. Next, hardware
installation procedures are presented, followed by software installation procedures.
Complete the procedures in this chapter sequentially, from beginning to end.

Pre-installation considerations

This section provides the following information that you must review and complete
before you begin the hardware or software installation procedures:

 Site preparation

* Hardware requirements
» Software requirements
* Host operating systems
» Switch zoning overview

Site preparation

The Remote Mirror Option uses fibre-channel switches to create a fabric
environment for data replication. These fibre-channel switches require only minimal
additional site preparation beyond basic storage subsystem operation.

For basic site preparation considerations including the use of fibre-channel cables
and connections, see the IBM FAStT Storage Manager Version 8.4 Installation and
Support Guide for your specific operating system.

For additional site preparation considerations concerning the fibre-channel switches,
including power requirements and physical dimensions and requirements, see the
documentation that comes with the fabric switch.

Hardware requirements

The following list contains the minimum hardware requirements for configuring your
system to use the Remote Mirror Option. The list includes the components that are
supplementary to the standard requirements of a basic storage subsystem
environment. For more information, see the IBM FAStT Storage Manager Version
8.4 Installation and Support Guide for your specific operating system.

+ Two Netfinity® FAStT500 RAID controller enclosure units or IBM TotalStorage
FAStT700 or IBM TotalStorage FAStT900 fibre-channel storage subsystems. It is
possible to have different storage subsystems in each of the two nodes of the
Remote Mirror Option. For example, the local storage subsystem can be the IBM
FAStT500 storage subsystem and the remote storage subsystem can be the IBM
FAStT700 storage subsystem and vice-versa. However, because the IBM
FAStT500 and IBM FAStT700 storage subsystems are different sets of hardware
with different performance characteristics, for optimal and reliable performance,
the storage subsystem and its associated drives and drive enclosures in each of
the nodes of the remote mirror setup must be the same.
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» Fibre-channel switches - Use these devices to connect multiple host computers
with multiple storage subsystems in a controlled environment. You can connect
multiple fibre-channel switches over a distance of up to 10 Km (6.25 mi) to create
a fabric environment.

See the readme file for a list of certified fibre-channel switches to use with the
Remote Mirror Option.

» Short or medium range fibre-channel cables - Use these cables to connect the
host computers and storage subsystems to the fibre-channel switches.

* Long range fibre-channel cables - These cables support distances up to
10 Km (6.25 miles). Use these cables to connect between fibre-channel switches
to complete long distance fabrics.

» Fibre-channel host bus adapters (HBAs) - See the readme file for a list of
certified HBAs to use with the Remote Mirror Option.

Software requirements

When configuring your host computer to use the Remote Mirror Option, be sure that
the following minimum software requirements are met:

« IBM FASHT Storage Manager Version 8.4x.xx

» Controller firmware version 5.20.xx.xx or higher for FAStT500 and FAStT700.
Controller firmware version 5.30.xx.xx or higher for FAStT900.

* |IBM Remote Mirror Premium Feature Key (one for each storage subsystem)

Host operating systems

Host computers that access mirrored logical drives must have one of the following
operating systems installed to use the Remote Mirror Option. See the readme file
for the latest operating system support.

* Microsoft Windows NT 4.0 Server Edition

* Microsoft Windows 2000

* Microsoft Windows Server 2003

» Solaris Version 2.6, 2.7 (Solaris 7), 2.8 (Solaris 8)

* HP-UX Version 11.0 or later

* Linux (Red Hat Advance Server 2.1, SUSe SLES 8)
* Novell NetWare Version 6.0

Switch zoning overview

96

All fibre-channel switches do not need to be zoned exactly as presented in this
chapter. The only zoning requirement is to zone the Remote Mirror host port
connections together. For example, you can create one zone that consists of all
primary and secondary host ports A2 and B2. You can create two zones - one zone
consists of primary and secondary host ports A2 and the other zone consists of
primary and secondary host ports B2. This is required to make sure that the host
port of the controller is fully dedicated for remote mirroring operations.

There are no zone requirements for the server HBA connections. However,
depending on the operating system, server HBA connections can be zoned so that
a single host bus adapter in a server can access only one controller per storage
subsystem.

Important: Do not zone the ISL port that connects (cascades) switches within a
fabric environment.
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Switch zoning configurations are set using the management software that comes
with the fibre-channel switch.

When two or more fibre-channel switches are cascaded together, the switch
management software combines the ports for all fibre-channel switches that are
linked. For example, if two 16-port fibre-channel switches are cascaded with a
physical connection with a fibre-channel cable, the switch management software
shows ports 0 - 31 participating in the fabric, rather than two fibre-channel switches
each with ports 0 - 15. Therefore, a zone that is created containing any of these
ports can exist on multiple cascaded fibre-channel switches.

In the top illustration in [Figure 37 on page 98, the fibre-channel switches are on the
same network and cascaded; therefore, Zone 1 is the same zone on Switch 1A as
Zone 1 on Switch 1B. In the bottom illustration in |Figure 37 on page 98|, the
fibre-channel switches are on the same network, but are not cascaded. Even
though both contain a Zone 1 (shown as Zone A in Switch 2), these zones are
independent of each other.
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Figure 37. Switch zoning in cascaded (top) and noncascaded (bottom) fibre-channel switches

For more information about fibre-channel switch zoning or setting up a zone
configuration, see the documentation that comes with the switch.

Installing the hardware

This section describes the procedures that are necessary to properly connect and
configure one or more storage subsystems for use with the Remote Mirror Option.

For a checklist to ensure that all the required hardware components are configured
properly, see|[‘Hardware and software checklists” on page 118

Highest Availability Campus configuration

Note: The Highest Availability Campus configuration is the preferred configuration
for the Remote Mirror Option.
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This configuration has two fibre-channel switches at both the primary and
secondary sites to provide complete failover and redundancy in the fibre-channel
switches and fabrics, with an ISL distance up to 10 Km (6.25 mi) in addition to all
storage subsystem components and host computers. Two fibre-channel switches at
each site also provide redundancy to the local site in addition to a fully redundant
remote configuration. There is no single point of failure in the hardware
components. Therefore, data synchronization can continue for any single switch
failure. This simplifies the disaster recovery process.

Figure 38|shows the Highest Availability Campus configuration after installation is
complete.
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Host Host

Group 1 Group 2
Host 1 Host 2 Host 3 Host 4

HA1 HA2||HB1 HB2 HC1 HC2| HD1 HD2
[g]
| i |
____ [ swichiA  Fabict | [T swicnis

@@ -
one one

1] [3) (8] [7] {9 H11}{13] (154 17) (19] [21] 23] {25} {27}{20f{31]
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pfie] f18] [2q] [22] [24]{26]128] {30
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(][] [s] [7]] e [11[13] [15]4

H400] [2] [4] (6] [e]frol 12| a

g Host fibre-channel cable

@——@ Storage subsystem fibre-channel cable
@——@ Dedicated Remote Mirror Option cable

*3))——&= Fabric uplink fibre-channel cable (ISL) 54001091

Figure 38. Highest Availability Campus configuration

Switch zoning for the Highest Availability Campus configuration
This configuration provides a separate zone for each reserved port for the Remote
Mirroring Option.

The fibre-channel switches do not need to be zoned exactly as presented in this

configuration. However, the following are requirements when zoning switches for the
Highest Availability Campus configuration:
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* The remote mirror host port connections must be zoned together. For example,
you can create one zone that consists of all primary and secondary host ports A2
and B2. You can create two zones - one zone consists of primary and secondary
host ports A2 and the other zone consists of primary and secondary host ports
B2. This is required to make sure that the host port of the controller is fully
dedicated for remote mirroring operations.

* The uplink port must not be zoned on any fibre-channel switch.

* There are no zone requirements for the server HBA connections. However,
depending on the operating system, server HBA connections can be zoned so
that a single host adapter can access only one controller per storage subsystem.

The fibre-channel switches in contain 16 ports each, which leaves many
unused ports per switch. You can redistribute the remaining ports among the other
zones. However, it is preferred that most remaining ports be assigned to the zones
that contain the host connections (Zones 1 and 2 in|Figure SQD. This will allow easy
setup for additional host computers to connect to the environment.

shows how the four fibre-channel switches are zoned for this Highest
Availability Campus configuration. The zones are configured on the switch to allow
one port per zone for a storage subsystem connection, and one port per zone for
each host. There are four zones in the following configuration example.

» Zone 1 and Zone 3 exist on Fabric 1 (switch 1A at the primary site, and switch
1B at the secondary site)

* Zone 2 and Zone 4 exist on Fabric 2 (switch 2A at the primary site, and switch
2B at the secondary site.

__________________ Switch1A __ _ Fabrict _ __________________Switth1B
! 10 Km max !
;@@ b116] [18] [20] [22] [24] 126 [28f{[30f{
one 1 Zone 1 |
|| (11 78] [5] (7)o ]t 1] 13] (154 17] 9] [21] [23] 28] 127} 29f |31}
1
e e e e e = = = = — = = = — == — == ——— = —— 1
__________________ Switch2A ___ Fabric2 _ ________________Switch2B_
i 10 Km max

Zone 2 Zone 2
(1] 3] [s][7]]e Fl11f13] [1514

@@-»_/\/—(«

Figure 39. Switch zoning for the Highest Availability Campus configuration

Before proceeding to the next section, ensure that all four fibre-channel switches
are properly zoned according to the requirements and the zoning shown in
Figure 39] For more information about zoning fibre-channel switches, see
zoning overview” on page 96.
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Table 7. Highest Availability Campus configuration connections (Primary site)

Cabling examples for the Highest Availability Campus

configuration
able 7] and [Table 8 show examples of the fibre-channel cabling connections in the
Highest Availability Campus configuration. Refer to the examples before you

complete the procedure in [‘Setting up the Highest Availability Campus|

lconfiguration” on page 102

Primary site
Switch 1A Switch 2A
Zone Port Connection to and from: Zone Port Connection to and from:
1 0 Host 1, HBA 1 (HA1) 2 0 Host 2, HBA 2 (HB2)
1 Controller port A1 1 Host 1, HBA 2 (HA2)
2 Host 2, HBA 1 (HB1) 2 Controller port B1
3 Additional host, HBA 1 (optional) 3 Additional host, HBA 2 (optional)
4 Additional host, HBA 1 (optional) 4 Additional host, HBA 2 (optional)
5 Additional host, HBA 1 (optional) 5 Additional host, HBA 2 (optional)
6 Additional host, HBA 1 (optional) 6 Additional host, HBA 2 (optional)
7 Additional host, HBA 1 (optional) 7 Additional host, HBA 2 (optional)
3 8 Unused 4 8 Controller port B2 (dedicated
remote mirror port)
9 Controller port A2 (dedicated 9 Unused
remote mirror port)
10 Unused 10 Unused
11 Unused 11 Unused
12 Unused 12 Unused
13 Unused 13 Unused
N/A 14 Spare (can be added to either N/A 14 Spare (can be added to either
zone) zone)
N/A 15 Uplink with Switch 1B N/A 15 Uplink with Switch 2B

Table 8. Highest Availability Campus configuration connections (Secondary site)

Secondary site

Switch 1B Switch 2B

Zone Port Connection from and to: Zone Port Connection from and to:

N/A 16 Uplink with Switch 2A N/A 16 Uplink with Switch 1A

N/A 17 Spare (can be added to either N/A 17 Spare (can be added to either

zone) zone)

1 18 Host 3, HBA 1 (HC1) 2 18 Controller port B1
19 Controller port A1 19 Host 4, HBA 2 (HD2)
20 Host 4, HBA 1 (HD1) 20 Additional host, HBA 1 (optional)
21 Additional host, HBA 1 (optional) 21 Host 4, HBA 2 (HD2)
22 Additional host, HBA 1 (optional) 22 Additional host, HBA 1 (optional)
23 Additional host, HBA 1 (optional) 23 Additional host, HBA 1 (optional)
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Table 8. Highest Availability Campus configuration connections (Secondary site) (continued)

Secondary site

3

24

Unused

25

Controller port A2 (dedicated
remote mirror port)

24

Controller port B2 (dedicated
remote mirror port)

26

Unused

25

Unused

27

Unused

26

Unused

28

Unused

27

Unused

29

Unused

28

Unused

30

Unused

29

Unused

31

Unused

30

Unused

31

Unused
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Setting up the Highest Availability Campus configuration
Complete the following procedure to set up the Highest Availability Campus
configuration for the Remote Mirror Option.

Important: Begin the installation at the primary site. Repeat these steps for the

secondary site when instructed to do so.

If you are adding the Remote Mirror Option hardware to an existing storage
subsystem environment that stops 1/0 from all host computers, go to step

If this is a new storage subsystem installation, go to step

Note: All connections are completed using fibre-channel cables of appropriate

length.

1. Power down all storage subsystems, host computers, fibre-channel switches,
and all other hardware in the storage subsystem environment.

2. Ensure that the cabling between all storage subsystems and drive enclosures

is complete.

Note: Depending on which site you are configuring, Switch 1 represents
Switch 1A for the primary site and Switch 1B for the secondary site.
Repeat the same configuration for Switch 2.

3. Connect the primary host bus adapter (Hx1) for each local host to an available
port in Zone 1 of Switch 1, as shown in|Figure 40 on page 103

Note: You can connect the cables to any port in the proper zone of the switch.



4. Connect the secondary host bus adapter (Hx2) for each host at this site to an

available port in Zone 2 of Switch 2, as shown in [Figure 44

Host Group
Host 1 Host 2

Step 3\1%A1 HA2 I HB1 H’_TJBZ

| Switch 1
(0] [2][4][6]]8]{10]12] [14]

Zone 1
1 (3] [s] [7] /{9 f11]13] [15]

Step 4<]

Switch 2

—¢ (0] [2] [4][6]]8 {10012 [14]

Zone 2

EERENIEl @ EE

SJ001095

Figure 40. Connecting the host bus adapters to fibre-channel switches

5. Connect controller port A1 of the storage subsystem to an available port in
Zone 1 of Switch 1. See |Figure 41 on page 104| for stepthrough step .

6. Connect controller port B1 of the storage subsystem to an available port in
Zone 2 of Switch 2.

7. Connect controller port A2 of the storage subsystem to an available port in
Zone 3 of Switch 1.

8. Connect controller port B2 of the storage subsystem to an available port in
Zone 4 of Switch 2.

Note: Controller ports A2 and B2 are reserved for mirror relationship

synchronization when the Remote Mirror Option is activated. For more
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information, see [‘Connectivity and I/O” on page 88
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Figure 41. Connecting the storage subsystem to the fibre-channel switches

9. If the primary site cabling and the secondary site cabling is complete, go to
step Otherwise, repeat step |1 on page 102 through step [8 on page 103 for
the secondary site.

10. Complete the Fabric 1 environment for Switch 1 by connecting Switch 1A with
Switch 1B. Connect each end of a long range fibre-channel cable (that can
support a distance up to 10 Km (6.25 mi)) to an unzoned port in each switch,
as shown in |Figure 42l

11. Repeat step Efor Switch 2A and 2B to complete the Fabric 2 environment for
Switch 2, as shown in [Figure 42

Switch 1A Fabric 1 Switch 1B
10 Km max

@@-»_/\/—«‘

Zone 1 Zone 1
1 [3]) [s] [7]9f[11]13] [15/4

Step 10
Switch 2A Fabric 2 Switch 2B

= — === 10Kmmax , [ — — sy

@@.»—/\/—(«

Zone 2 Zone 2
(1] (3] [5] [7]le F11[13] [154

__________________________________________________________________

Step 11

Figure 42. Connecting the switches over a remote network to complete Fabric 1 and Fabric 2
environments

12. Cabling for this Highest Availability Campus configuration is complete. Repeat
step [3 on page 102 through step [9|for any additional storage subsystems that

use the Remote Mirror Option.
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13. Power up all storage subsystems, host computers, fibre-channel switches, and
any other hardware at both sites that were powered down in step[1 on page]

frod
14. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to[‘Installing the

lsoftware” on page 115

Campus configuration

The Campus configuration offers the same functionality as the Highest Availability
Campus configuration, but contains only one switch at each site, rather than two.
The configuration is still redundant for host bus adapters, controllers, and remote
logical drive mirroring ports, but is a single point of failure for fibre-channel
switches. If a switch at either site fails, the Remote Mirror Option cannot function.
For this reason, the Highest Availability Campus configuration is preferred for total
environment redundancy. shows the Campus configuration after
installation is complete.
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( Ethernet network )
L*J [*J L*J L*J
Host Host
Group 1 Group 2
Host 1 Host 2 Host 3 Host 4
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@Z 6]
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B Host fibre-channel cable
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*3)——&= Fabric uplink fibre-channel cable (ISL)

$J001092

Figure 43. Campus configuration

Switch zoning for the Campus configuration
This configuration provides a separate zone for each reserved port for the Remote

Mirroring Option.

For an example of how to zone the fibre-channel switches, see [‘Switch zoning foi
the Highest Availability Campus configuration” on page 99.| Remember that the
Campus configuration uses two fibre-channel switches and one 10Km (6.2 mi) ISL.

There are a total of four zones in this configuration.
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* All zones exist on the Fabric 1 environment (Switch 1A at the primary site, and
Switch 1B at the secondary site).

» Zone 3 and Zone 4 are reserved for the dedicated Remote Mirror Option
connections.

Figure 44| shows how the two fibre-channel switches are zoned for the Campus
configuration.

___________________ Swih 1A Fabriel  ____ Swich1B

(o) wEletae ] " ™t ic 18 20 22 el

lnjaiaa a)njE| = 77 19 21 23 25 [o7 2o 1]

A [Fzones™
Zone 4

Figure 44. Switch zoning for the Campus configuration

Before proceeding to the next section, ensure that both fibre-channel switches are
properly zoned according to the requirements and the zoning example shown in
Figure 44] For more information about zoning fibre-channel switches, see
zoning overview” on page 96.|

r?_a_bﬂr‘rg examples for the %ampus configuration

able 9(and [Table 10 on page 107| show examples of the fibre-channel cabling
connections in the Campus configuration. Refer to the examples before you
complete the procedure in |“Setting up the Campus configuration” on page 107.|

Table 9. Campus configuration connections (Primary site)

Primary site

Switch 1A

Zone Port Connection to and from:

1 0 Host 1, HBA 1

—_

Controller port A1

Host 2, HBA 1

Additional host, HBA 1 (optional)

Additional host, HBA 1 (optional)

Additional host, HBA 1 (optional)

Host 1, HBA 2

Controller port B1

Host 2, HBA 2

N
Ol N|o|Oa|~|lwW[DN

Additional host, HBA 2 (optional)

—_
o

Additional host, HBA 2 (optional)

—_
—_

Additional host, HBA 2 (optional)

w
-
\V]

Controller port A2 (dedicated remote mirror port)

N
-
w

Controller port B2 (dedicated remote mirror port)

N/A

—_
SN

Spare
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Table 9. Campus configuration connections (Primary site) (continued)

Primary site
N/A 15 Uplink with Switch 2

Table 10. Campus configuration connections (Secondary site)

Secondary site

Switch 1B
Zone Port Connection to and from:
1 16 Uplink with Switch 1
17 Spare
18 Host port, HBA 1
19 Controller port A1
20 Host 4, HBA 1
21 Additional host, HBA 1 (optional)
22 Additional host, HBA 1 (optional)
23 Additional host, HBA 1 (optional)
2 24 Host 3, HBA 2
25 Controller port B1
26 Host 4, HBA 2
27 Additional host, HBA 2 (optional)
28 Additional host, HBA 2 (optional)
29 Additional host, HBA 2 (optional)
30 Controller port A2 (dedicated remote mirror port)
4 31 Controller port B2 (dedicated remote mirror port)

Setting up the Campus configuration

Important: Begin the installation at the primary site. Repeat these steps for the
secondary site when instructed to do so.

Complete the following procedure to set up the Campus configuration for the
Remote Mirror Option.

If you are adding Remote Mirror Option hardware to an existing storage subsystem
environment that stops 1/0 from all host computers, go to step

If this is a new storage subsystem installation, go to step

Note: All connections are completed using fibre-channel cables of appropriate
length.

1. Power down all storage subsystems, host computers, fibre-channel switches,
and all other hardware in the storage subsystem environment.

2. Ensure that the basic cabling between all storage subsystems and drive
enclosures is complete.

Note: Depending on which site is configured, Switch 1 represents Switch 1A
for the primary site, and Switch 1B for the secondary site.
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3.

Connect the primary host bus adapter (Hx1) for each host at this site to an
available port in Zone 1 of Switch 1, as shown in [Figure 45

Note: You can connect the cables to any port in the proper zone of the switch.

Connect the secondary host bus adapter (Hx2) for each host at this site to an
available port in Zone 2 of Switch 1 as shown in|Figure 45|

Host Group
Host 1 Host 2

I Step 4
HA1 HA2/HB1 HB2y!

Cel Cgll

| |
—

Step 34ﬂ

Switch 1A

ol o) e[ oJfoll]
one
aibjalain nEE

LZone 3
Zone 4

SJ001121

Figure 45. Connecting the host bus adapter to fibre-channel switches

5.

Connect controller port A1 of the storage subsystem to an available port in
Zone 1 of Switch 1. See [Figure 46| for stepthrough step [9 on page 109
Connect controller port B1 of the storage subsystem to an available port in
Zone 2 of Switch 1.

Connect controller port A2 of the storage subsystem to an available port in
Zone 3 of Switch 1.

Connect controller port B2 of the storage subsystem to an available port in
Zone 4 of Switch 1.

Note: Controller ports A2 and B2 are reserved for mirror relationship
synchronization when the Remote Mirror Option is activated. For more
information, see [‘Connectivity and I/O” on page 88

Switch 1A

(0] [2] [4]{6]]8{10[12] [14]

one 1

z
(1] 3] [s]i7[{e 11]

Step Sj_/' LLZone 3
Step 6 Zone 4

SJ001099

Figure 46. Connecting the storage subsystem to fibre-channel switches
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9. The primary site cabl is now complete. If the secondary site cabling is

complete, go to step Otherwise, repeat step [1 on page 107|through step
on page 108 for the secondary site.

10. Complete the Fabric 1 environment by connecting Switch 1A with Switch 1B.
Connect each end of a long range fibre-channel cable (that can support a

distance of up to 10 Km (6.25 mi)) to an unzoned port in each switch, as
shown in

___________________ Switch 1A___ Fabric1 _~~_______ Switch1B

igﬂg@nmmmmjycfﬁ

([ [1]Ta] [s]7 ][ 1] 19 frs)

T fzaéa ““““““““““““““““““
Zone 4 Step 10

$J001100

Figure 47. Connecting fibre-channel switches over a remote network to complete the Fabric 1
environment

11. Cabling for this Campus configuration is complete. Repeat step [3 on page 108
through step|§|for any additional storage subsystems that use the Remote
Mirror Option.

12. Power up all storage subsystems, host computers, fibre-channel switches, and
any other hardware at both sites that were powered down in step
ﬁi

13. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to[‘Installing the

lsoftware” on page 115/

Intra-site configuration

This configuration is similar to the Campus configuration in that there are only two
fibre-channel switches. However, no multiple-switch fabrics exist in this
configuration. This configuration is used in environments where a long distance
fabric is not required due to the close proximity of the host computers and storage
subsystems. The configuration is still redundant for host bus adapters, controllers,
remote logical drive mirroring ports, and fibre-channel switches, but is a single point
of failure for the site. For this reason, the Highest Availability Campus configuration
is preferred for total environment redundancy.

Important: A switch failure in this configuration does not affect data access;
however, an unsynchronized mirror state might occur as a result.

[Figure 48 on page 110| shows the Intra-site configuration after installation is
complete.
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Figure 48. Intra-site configuration

Switch zoning for Intra-site configuration

Intra-site configuration is designed for switch redundancy. However, the
fibre-channel switches are not cascaded, and therefore are independent of each
other. This configuration provides a separate zone for each reserved port for the
Remote Mirroring Option.

For an example of how to zone the fibre-channel switches, see [‘Switch zoning foi
|the Highest Availability Campus configuration” on page 99.| Remember that the
Intra-site configuration uses two fibre-channel switches but does not use any 10Km
(6.2 mi) ISLs.

The fibre-channel switches shown in [Figure 49 on page 111| contain 16 ports each,
which leaves many unused ports per switch. You can distribute the remaining ports
among the other zones. However, it is preferred that most remaining ports be
assigned to the zones containing the host connections (Zone 1 and Zone A shown
in [Figure 49 on page 111). This provides an easy set up for additional host
computers to connect to the environment.

Note: |Figure 49 on page 111| illustrates that there is no relationship between Zone
A and Zone B in Switch 2 and Zone 1 and Zone 2 in Switch 1.

There are a total of four zones in this configuration.
* Zone 1 and Zone 2 exist on Switch 1
* Zone A and Zone B exist on Switch 2

In|Figure 49 on page 111} the fibre-channel switches use half of the ports for each
zone for simplicity, although Zone 2 and Zone B require fewer ports.
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Figure 49. Switch zoning for the Intra-site configuration

Before proceeding to the next section, ensure that both fibre-channel switches are

zoning overview” on page 96

properly zoned according to the requirements and the zoning example shown in
Figure 49] For more information about zoning fibre-channel switches, see

Cabling examples for the intra-site configuration

shows examples of the fibre-channel cabling connections in the Campus
configuration. Refer to the examples before you complete the procedure in

lup the Intra-site configuration.”|

Table 11. Intra-site configuration connection

Switch 1 Switch 2
Zone Port Connection to and from: Zone Port Connection to and from:
1 0 Host 1, HBA 1 (HA1) A 0 Host 1, HBA 2 (HA2)
1 Controller port A1 (primary storage 1 Controller port B1 (primary
subsystem) storage subsystem)
Host 2, HBA 1 (HB1) Host 2, HBA 2 (HB2)
Controller port A1 (secondary Controller port B1 (secondary
storage subsystem) storage subsystem)
4 Host 3, HBA 1 (HC1) 4 Host 3, HBA 2 (HC2)
Additional host, HBA 1 (optional) 5 Additional host, HBA 2
(optional)
Host 4, HBA 1 (HD1) Host 4, HBA 2 (HD2)
Additional host, HBA 1 (optional) Additional host, HBA 2
(optional)
2 Unused B Unused
Controller port A2 (primary storage Controller port B2 (primary
subsystem - dedicated remote storage subsystem -
mirror port) dedicated remote mirror port)
10 Unused 10 Unused
11 Controller port A2 (secondary 11 Controller port B2 (secondary
storage subsystem - dedicated storage subsystem -
remote mirror port) dedicated remote mirror port)
12 Unused 12 Unused
13 Unused 13 Unused
14 Unused 14 Unused
15 Unused 15 Unused

Setting up the Intra-site configuration
Complete the following procedure to set up the Intra-site configuration for the

Remote Mirror Option.
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If you are adding Remote Mirror Option hardware to an existing storage subsystem
environment that stops 1/0 from all host computers, go to step

If this is a new storage subsystem installation, go to step

Note: All connections are completed using fibre-channel cables of appropriate
length.

1. Power down all storage subsystems, host computers, fibre-channel switches,
and all other hardware in the storage subsystem environment.

2. Ensure that the basic cabling between all storage subsystems and drive
enclosures is complete on both storage subsystems.

3. Connect the primary host bus adapter for each host (Hx1) to an available port
in Zone 1 of Switch 1, as shown in |Figure 50

Note: You can connect the cables to any port in the proper zone of the switch.

Host 1 Host2 | —Step3 Host 3 Host 4
</( / \\‘k A
HAT*HA2 | | HB1 HB2 HC1 HC2 'HD1 HD2
(N N O
B
@@ @@
one one
(1] [3] [5] [7]{9 H11H13}15] (1] [3] [5] [7]{9 H11H13}15]
Switch 1 Switch 2

SJ001102

Figure 50. Connecting the primary host bus adapter (Hx1) to the fibre-channel switches

4. Connect the secondary host bus adapter (Hx2) for each host to an available
port in Zone A of Switch 2, as shown in

Host 1 Host 2 /7Step 4——_ |  Host3 Host 4
HA1 HA2# AB1 HB2% ‘HePHC2 || HDPHD2
Lo [ 1| []
"
@@ @@
one one
(1] [3][5] [7] o H11}{13}15] (1] [3][5] [7]{ e H11}{13}15]
Switch 1 Switch 2

SJ001103

Figure 51. Connecting the secondary host bus adapter (Hx2) connection to the fibre-channel
switches
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Connect controller port A1 of the primary storage subsystem to an available
iort in Zone 1 of Switch 1. See[Figure 52 on page 114 for step [5]through step
Q)

.

Connect controller port B1 of the primary storage subsystem to an available
port in Zone A of Switch 2.

Connect controller port A2 of the primary storage subsystem to an available
port in Zone 2 of Switch 1.

Connect controller port B2 of the primary storage subsystem to an available
port in Zone B of Switch 2.
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Note: Controller Ports A2 and B2 are reserved for mirror relationship
synchronization when the Remote Mirror Option is activated. For more
information, see [‘Connectivity and I/O” on page 88

Switch 1 Switch 2
@@ @EA@
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1] [3] 5] [7] 19111} {13] f15] ] [3][s] [7] 19 l11}{13] f15]
Step 5 I
€P O —p 4 Step 7 l¢e—Step 8
B B2
gojoo gjgjon 0/gjoo
A1l A2
Step 6
Primary storage subsystem Secondary storage subsystem

SJ001104

Figure 52. Connecting the primary storage subsystem to fibre-channel switches

9. Connect controller port A1 of the secondary storage subsystem to an available
port in Zone 1 of Switch 1. See for step [d through step[12
10. Connect controller port B1 of the secondary storage subsystem to an available
port in Zone A of Switch 2.
11. Connect controller port A2 of the secondary storage subsystem to an available
port in Zone 2 of Switch 1.
12. Connect controller port B2 of the secondary storage subsystem to an available
port in Zone B of Switch 2.

Switch 1 Switch 2
(o] [2][4] [s]]8}10] [12]14] (0] [2][4] [6]]810[[12] 14]
Zone 1 Zone A
(1] (3] [8] [7] ] f11]13[ 15 KR ERERE ENENENE
Step 10 ?
Step9 | > L« Step 12
EE B B2
gjojo[o gjojo)m Step 11 it OO
Al (A2 Al 2
Primary storage subsystem Secondary storage subsystem
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Figure 53. Connecting the secondary storage subsystem to fibre-channel switches

13. Cabling for this Intra-site configuration is complete. Repeat step |3 on page 112

through step for any additional storage subsystems that use the Remote
Mirror Option.

14. Power up all storage subsystems, host computers, fibre-channel switches and
any other hardware that was powered down in step|1 on page 112
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15. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to[‘Installing the

Installing the software

The Remote Mirror Option is a premium feature that is included as part of the IBM
FASIT Storage Manager 8.4 installation. You must purchase an IBM Storage
Manager Remote Mirror Option for each storage subsystem in your remote mirror
configuration. This option contains a GenKey file that will enable the Remote Mirror
Option. If you want to purchase the Remote Mirror Premium Feature Option,
contact your IBM technical-support representative.

Important: All storage subsystems participating in mirror relationships must have
firmware level 05.2x.xx.xx or higher installed. For more information about upgrading
firmware and installing the storage-management software, see your appropriate /BM
FAStT Storage Manager Version 8.4 Installation and Support Guide.

For a checklist to ensure that all the required software components are configured
properly, see [‘Hardware and software checklists” on page 118

For more information about enabling or activating the Remote Mirror Option, see
{‘Enabling and activating the Remote Mirror Option.”|

Enabling and activating the Remote Mirror Option

The Remote Mirror Option premium feature key must be purchased before you can
enable the option. The option must be activated by using a GenKey program before
you can create any mirror relationships. First, determine the status of the Remote
Mirror Option. Then enable and activate it.

Determining Remote Mirror Option status
There are four possible statuses of the Remote Mirror Option:

* Disabled/Deactivated
* Disabled/Activated

* Enabled/Deactivated
* Enabled/Activated

Important: The Remote Mirror Option must be in the Enabled/Activated state on
the secondary storage subsystem as well as the primary storage subsystem to
create and maintain mirror logical drive pairs.

You can determine the current status by hovering the mouse pointer over the
Remote Mirror Option icon in the status area of the Subsystem Management
window, as shown in |Figure 54 on page 116[
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Figure 54. Remote Mirror Option status

Important: The Remote Mirror Option status for the primary storage subsystem is
managed independently from the secondary storage subsystem. To determine the
status for both storage subsystems, select each storage subsystem independently,
then determine the status.

The Remote Mirror Option statuses are as follows:

Disabled and deactivated
No function of the Remote Mirror Option can be performed. Full Remote
Mirror Option functionality is not available until the option is enabled and
activated. The icon for this state is displayed in the Premium Feature status
area as a cylinder with a mirrored reflection. The icon has a red slash

through it to show it is disabled, and is greyed out to show it is deactivated.
An example of this state is shown in [Figure 54
Disabled and activated

The Remote Mirror Option is disabled, preventing new mirror relationships
from being created. However, any pre-existing mirror relationships are
maintained with all functions of the Remote Mirror Option. The icon that is
displayed for this state is similar to the disabled and deactivated state,
because the red slash remains to show the option is disabled. However, the
cylinder and its reflection are green to show that the option is active.

Enabled and deactivated
The Remote Mirror Option is enabled, but not activated. The icon that is
displayed for this state is similar to the disabled and deactivated state,
because the cylinder and its reflection remain grey. However, there is no
red slash, indicating that the option is enabled.

Enabled and activated
The Remote Mirror Option is enabled and active. You can create and
maintain mirror relationships. The icon for this state is displayed in the
Premium Feature status area as a green cylinder with a mirrored reflection.

Enabling the Remote Mirror Option

If the current status of the Remote Mirror Option is Disabled/Deactivated or
Disabled/Activated, complete the following steps to enable the Remote Mirror
Option.
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To enable the Remote Mirror Option, you must perform the following two
procedures in the following order:

1. Obtain the feature enable identifier. This procedure is described in detail in
[‘Obtaining the feature enable identifier” on page 3|

2. Generate the feature key file and enable the Remote Mirror Pption. This
procedure is described in detail in |“Generating the feature key file and enabling|
[the premium feature” on page 3!

Before you begin, gather the following information:

* Your Feature Activation Code, which is printed on the IBM FlashCopy Premium
entitlement card

* Your controller unit IBM serial number, which is printed on the label on the back
of your FAStT controller unit

* A 32 character alphanumeric IBM FASLT storage subsystem premium feature
identifier string.

To obtain the storage subsystem premium feature identifier string, ensure that your
controller unit and expansion units are connected, powered on, and managed using
the SMclient.

If the Remote Mirror Option has not been activated, go to [‘Activating the Remote]
Mirror Option.’1 If the Remote Mirror Option is activated, go to [‘Creating mirroi
relationships” on page 121

For more detailed steps on how to enable the Remote Mirror Option, see
lremium features” on page 3.|For information on how to view a list of those

premium features that are enabled on your storage subsystem, see
istatus of premium features” on page 4.|

Activating the Remote Mirror Option

Activating the Remote Mirror Option prepares the storage subsystem to create and
configure mirror relationships. When the option is activated, ports A2 and B2 of the
storage controller are reserved and dedicated to Remote Mirror Option usage. In
addition, a mirror repository logical drive is created for each controller in the storage
subsystem.

If the current status of the Remote Mirror Option is Enabled/Deactivated, complete
the following steps to activate the option:

1. In the Subsystem Management window, click Storage subsystem » Remote
Mirror » Activate.

The Activate Remote Logical Drive Mirroring - Introduction window opens.

Note: Click Back at any time to change the information in the previous window.

2. Decide where the mirror repository logical drives will reside. Select one of the
following:

« Use free capacity on existing arrays - If this option is selected, then a
corresponding logical drive must also be selected.

a. Select a logical drive.
b. Select Finish or Next.

c. Go to step|6 on page 118,

* Create a new array using unconfigured capacity - If this option is
selected, more information must be collected about the new logical drive. Go

to step 8 on page 11§
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3.
4.

9.

In the Create New Array window, select the RAID level for the new logical drive.

Under the drive selection choices, select one of the following:

* Automatic - The drives are chosen automatically according to available
capacity.

* Manual - This option gives you the option to specify which drives contain the
mirror repository logical drive.

a. Press and hold the Ctrl key and click to select the drives that you want to

include in your array.

b. Click Apply.

Important: If the RAID level for the new array is RAID 1, then the number of
drives must be an even number. If an odd number of drives are selected, an
error message displays when you click Apply.

Click Next.

Review the information in the Preview window and click Finish if all information
is satisfactory.

If the storage subsystem password is protected, type the password and click
OK.

If the storage subsystem password is not protected, go to step

Review the information in the Completed window and click OK to finish the
Remote Mirror Option activation.

The Remote Mirror Option must be enabled and activated on all storage
subsystems that are part of a remote mirror setup. When the Remote Mirror
Option is activated, the icon in the Premium Feature status area changes from
grey to green. If this is not the case, repeat the steps in[‘Enabling and activating]
[the Remote Mirror Option” on page 115|and step|1 on page 117|through step |g
of this procedure for each storage subsystem that has the remote mirror option
disabled and deactivated.

Continue with [‘Creating mirror relationships” on page 121

Hardware and software checklists
Complete the hardware checklist in[Table 12] and the software checklist in

118

to ensure that all the required hardware and software components are

configured properly.

Hardware checklist
Complete the tasks in|Table 12| before you configure the Remote Mirror Option

using the storage management software.

Table 12. Hardware checklist

Task description Validation activity

Ensure that the minimum hardware requirements are met. For a [] Completed

complete list of the hardware requirements, see fHardware]

[requirements” on page 95

Configure your primary and secondary storage subsystems. See [] Completed

the appropriate storage subsystem Installation and User’s Guide
for configuration information and see [Finstalling the hardware” on|

Configure your fibre-channel switches and cables. For more ] Completed

information about configuring the fibre-channel switches to use
with the Remote Mirror Option, see [“Installing the hardware” on|
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Software checklist

Complete the tasks in:TabIe 13| before you define mirror relationships in your

storage subsystems.

Table 13. Software checklist

Task description

Validation activity

Back up all data on the primary and secondary storage
subsystems that are participating in remote logical drive mirroring.

[] Completed

Install the correct version of firmware and storage-management
software. For more information about upgrading firmware or
installing the storage management software, see the appropriate
IBM FAStT Storage Manager Installation and Support Guide or
the Subsystem Management window online help.

[] Completed

Enable the Remote Mirror Option on both the primary and
secondary storage subsystems. For information about enabling
the feature, see [‘Enabling and activating the Remote Mirror|
[Option” on page 115.|

] Completed

Activate the Remote Mirror Option and create a mirror repository
logical drive for each controller on the primary storage subsystem.
For more information about activating the Remote Mirror Option,
see[‘Enabling and activating the Remote Mirror Option” on page|

5!

[] Completed

Create the required primary and secondary logical drives on the
primary and secondary storage subsystems. For more information
about establishing a mirror relationship, see [Chapter 8, “Using the]
[Remote Mirror Option,” on page 121,

] Completed

Verifying installation and configuration

All hardware and software is now set up to support mirror relationships through the
Remote Mirror Option. However, before creating mirror relationships, ensure that all

required components are working properly.

Complete the following procedure for each storage subsystem that is participating in
any aspect of a mirror relationship to verify correct configuration:

1. Start the storage management software.

For more information about starting the storage management software, see
your IBM FASLtT Storage Manager Version 8.4 Installation and Support Guide

for operating-system specific procedures.

If this is the first time that you have started the storage management software,
go to step If this is not the first time that you have started the storage

management software, go to step

2. If this is the first time that you have started the storage management software,

perform the following steps:

a. Click OK when prompted for Automatic Discovery of devices.

b. Ensure that all the storage subsystems that are designated to participate in
mirror relationships are displayed in the Device Tree view of the Enterprise

Management window.

Note: If the storage subsystems do not display, see |Chapter 10,|

[Troubleshooting the Remote Mirror Option,” on page 135.|

3. If this is not the first time that you have started the storage management

software, perform the following steps:
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10.

11.
12.

13.

a. In the Enterprise Management Window, click Tools » Automatic
Discovery.

Click OK.
c. Verify that all the storage subsystems that are designated to participate in

mirror relationships are displayed in the Device Tree view of the Enterprise
Management window.

Note: If the storage subsystems do not display, see |Chapter 10,|
[‘Troubleshooting the Remote Mirror Option,” on page 135

In the Enterprise Management window, select a storage subsystem that will
participate in mirror relationships.

Click Tools » Manage Device to open the Subsystem Management window
for that storage subsystem.

In the Subsystem Management window, click Help » About.

Verify that the version of the storage management software is 08.3x.xx.xx or
later. If this requirement is not met, see your specific IBM FAStT Storage
Manager Version 8.4 Installation and Support Guide for the procedures to
upgrade the storage management software.

Click OK.

In the Subsystem Management window, click View » Storage subsystem
Profile.

Click the All tab, and verify that the current firmware version is 05.2x.xx.xx or
later. If this requirement is not met, see your specific IBM FAStT Storage
Manager Version 8.4 Installation and Support Guide for the procedures to
upgrade the firmware.

When your installation is completed, refer to the following online help systems:

* Enterprise Management window help - Use this online help system to learn
more about working with the entire management domain.

* Subsystem Management window help - Use this online help system to learn
more about managing individual storage subsystems and Remote Mirror
Option.

You can access these help systems from within the Storage Manager Client. In
either a Enterprise Management or Subsystem Management window, click
Help or press F1.

Click Close.

Observe the Remote Mirror Option icon in the status area. The icon
represents the Disabled and Deactivated status of the Remote Mirror Option.
To begin working with mirror relationships, go to [Chapter 8, “Using the Remote]
[Mirror Option,” on page 121

IBM TotalStorage FAStT Storage Manager Copy Services User’s Guide



Chapter 8. Using the Remote Mirror Option

This chapter contains the procedures for completing the major tasks that are
associated with the Remote Mirror Option. The chapter is organized sequentially;
after the Remote Mirror Option premium feature key is purchased, you can enable
and activate the option so you can create and maintain mirror relationships. The
final section, on deactivating and disabling the Remote Mirror option, is provided for
reference only and might be useful when a mirror relationship is no longer needed.

Creating mirror relationships

Before you create mirror relationships, be sure that the Remote Mirror Option is
enabled and activated.

Note: The secondary host ports on the storage subsystems are reserved for data
synchronization between a primary and secondary logical drive of a mirror
relationship.

Creating logical drives for mirror relationships

Before you create mirror relationships, be sure that logical drives exist at both the
primary and secondary storage subsystems. The logical drive of the remote mirror
pair that is presented to the host is the primary logical drive. The storage
subsystem that the primary drive resides in is called the primary storage subsystem.
Similarly, the storage subsystem that the secondary logical drive resides in is called
the secondary storage subsystem.

If a primary or secondary logical drive does not exist, you must create one on the
corresponding storage subsystem.

Consider the following when creating a logical drive:

» The secondary logical drive must be of equal or greater size than the primary
logical drive.

» The RAID level of the secondary logical drive does not have to be the same as
that of the primary logical drive.

For more information about creating logical drives, see the Subsystem Management
window online help.

When logical drives exist at both sites, you can create mirror relationships by using
the Create Remote Mirror wizard.

Creating a mirror relationship using the Create Remote Mirror wizard

Using the Create Remote Mirror wizard, you can create a mirror relationship
between a primary logical drive and a secondary logical drive. Before beginning the
wizard, ensure that the following requirements are met:

» The Remote Mirror Option is enabled on both storage subsystems in which the
primary and secondary logical drives will reside.

« The Remote Mirror Option is activated on both subsystems.

» The storage subsystems are connected through a proper fibre-channel fabric
configuration.

* The size of the secondary logical drive is equal to or greater than the primary
logical drive.
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* There are management connections to both the primary and secondary storage
subsystems. The Enterprise Management window must display both primary and
secondary storage subsystems in the management domain.

* The remote fibre-channel switch connections are made between the primary and
secondary storage subsystems. The fibre-channel switches are zoned so that the
controller host ports are by themselves.

When these requirements are met, complete the following steps to create a mirror
relationship:
1. In the Logical/Physical view of the Subsystem Management window, select the
logical drive that will become the primary logical drive in the mirror relationship.
2. Click Logical Drive » Remote Mirror » Create.
3. Click Next.
4. Follow the instructions in the Select Remote Storage subsystem window.
The Create Remote Mirror window opens stating requirements that are similar
to those listed at the beginning of this section.

a. Select the proper storage subsystem. The Remote Mirror Option supports
a maximum of two storage subsystems per configuration. The wizard
displays all available storage subsystems within the management domain
that have the Remote Mirror Option enabled and activated. If you have an
existing remote mirror relationship with a given storage subsystem, do not
select another storage subsystem from the list.

b. Click Next.

5. Select the logical drive that will become the secondary logical drive in the
mirror relationship. If there are no logical drives listed, the secondary storage
subsystem that you selected does not have logical drives with enough capacity
available to mirror the selected logical drive.

6. Click Next.
7. Select the synchronization priority level.

Note: For more information about the synchronization priority level, see

[‘Changing the synchronization priority level” on page 124.|
8. Click Finish.
9. If the remote storage subsystem is password protected, type the password and
click OK.

If the remote storage subsystem is not password protected, go to step

10. If you do not exceed the maximum number of mirrored logical drive pairs that
can be created for the storage subsystem, you are prompted to create another
mirror logical drive pair by the Create Remote Mirror wizard. If you do not want
to create another mirror logical drive pair, click No and go to step
Otherwise, perform the following steps:

a. Select the logical drive that will become the next primary logical drive.

b. Click Next.
c. Repeat step [ through step [10 on page 122]for each additional mirror
relationship.

11. Review the information in the Completed window, then click OK to complete
the Create Remote Mirror wizard.

The primary and secondary logical drives are now displayed with the mirror

relationship icons, which will change slightly when the data synchronization is
completed. The amount of time that is required for the data to be synchronized
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between the two logical drives varies proportionally to the size of the logical drive
being mirrored and storage subsystem 1/O loads. After the synchronization is
complete, the icons change to the optimal state mirror relationship icons. [Figure 55
shows how the icons display during and after data synchronization.

Note: To view all the icons that are associated with the Remote Mirror Option and

a description of their purpose, see the Subsystem Management window
online help.

Eﬁ Primary Logical Drive (5GB) E| Primary Logical Drive (5 GB)

b @Secondary Logical Drive L Secondary Logical Drive
New mirror relationship Optional mirror relationship
with synchronizing data with fully synchronized data

Figure 55. Synchronizing and optimal mirror relationship icons

The mirror relationship is now created and optimal.

Maintaining mirror relationships

When a mirror relationship is active, you can modify certain attributes of the
relationship at any time. This section describes how to view information about the
mirror relationship, how to change the synchronization priority level, how to remove
a mirror relationship, and how to delete logical drives that are participating in a
mirror relationship.

Viewing mirror relationships

The mirror relationship that exists between the primary logical drive and the
secondary logical drive can be examined by various methods, such as using the
storage subsystem profile, the Mirroring Properties window, and the View
Associated Components window.

Displaying the storage subsystem profile

The storage subsystem profile is the most efficient way to view information about
any or all components of the storage subsystem. Details for all logical drives, such
as the primary, secondary, and mirror repository logical drives can all be easily
viewed through the storage subsystem profile. The storage subsystem profile also
contains specific information about components that are associated with mirror
relationships.

Complete the following steps to display the storage subsystem profile:

1. In the Subsystem Management window click View » Storage subsystem
profile.

2. Click the Logical Drives tab.

» To view information about the mirror relationships that exist on this storage
subsystem, click the Mirrors tab.

» To view information about the mirror repository logical drive, click the
Repositories tab.
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Note: Click Save As to save all of the information that is shown in the storage
subsystem profile as a .txt file. The Save Profile window that opens provides
the option of saving the current window, multiple windows, or the entire
storage subsystem profile.

The Mirroring Properties window
The Mirroring Properties window displays all the physical characteristics of a single
logical drive in the mirror relationship.

The window displays the same information as the storage subsystem profile for the
selected logical drive, but is specific only to that logical drive. The synchronization
progress is displayed if the selected logical drive is synchronizing data with another
logical drive in a newly defined mirror relationship or in an existing mirror
relationship after the broken mirror link is restored.

Complete the following steps for each logical drive that needs to be examined in the
mirror relationship:

1. Select the primary or secondary logical drive.
2. Click Logical Drive » Properties.
3. Click the Mirroring tab.

You can also use this procedure to view the synchronization progress of a recently
created mirror relationship.

The View Associated Components window

The View Associated Components window provides a graphical representation of
the logical drives that are participating in the mirror relationship. Details are
provided for all components, rather than just the logical drive that was initially
selected.

Complete the following steps to view all the associated components in a mirror
relationship, including primary, secondary, and mirror repository logical drives:

1. Select the primary or secondary logical drive in a mirror relationship.
2. Right click and select View Associated Components.

The View Associated Components window opens.
3. Click Close to exit the window.

Changing the synchronization priority level

124

The synchronization priority level of a mirror relationship defines the amount of
system resources that are used to synchronize the data between the primary and
secondary logical drives of a mirror relationship. If you select the highest priority
level for a mirror relationship, the data synchronization uses a high amount of
system resources to increase mirror performance, but might decrease performance
for all other functions, including other mirror relationships. If you select the lowest
synchronization level, there is less impact on complete system performance, but the
mirror relationship synchronization might be slower.

Complete the following steps to change the synchronization priority level for a mirror
relationship:

1. In the Logical/Physical view of the Subsystem Management window, select a
primary logical drive of a mirror relationship.

2. Click Logical Drive » Remote Mirror » Change » Synchronization Priority.
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The Change Synchronization Priority window opens. The primary logical drive
that you chose in steg1 on page 124|is selected by default in the Select
Logical Drives field.

3. Select one or more logical drives.

4. Select the synchronization priority level. The five levels are Lowest, Low,
Medium, High, and Highest. All selected logical drives will change to the same
synchronization priority level.

5. Click OK.
6. Click Yes when the Confirmation window opens.
7. Click OK when the Completed window opens.

Removing mirror relationships

Removing a mirror relationship between a primary and secondary logical drive does
not affect any of the existing data on either logical drive. The link between the
logical drives is removed, but the primary logical drive still continues normal 1/0
operation. You can perform this action for backup routines, particularly from the
secondary logical drive. A mirror relationship between the two logical drives can be
re-created unless one of the logical drives is deleted.

Complete the following steps to remove a mirror relationship between two logical
drives:

1. In the Subsystem Management window, select a local primary logical drive or
local secondary logical drive of a mirror relationship.

2. Click Logical Drive » Remote Mirror + Remove Mirror Relationship.

The Remove Mirror Relationship window displays all mirror relationships that
are associated with this storage subsystem.

3. Select one or more mirror relationships to be removed.
4. Carefully review the information that is presented in the Confirmation window.
5. Click Yes.

Deleting primary and secondary logical drives

Deleting a logical drive that is participating in a mirror relationship removes the
mirror relationship and completely deletes the logical drive from the storage
subsystem. The mirror relationship cannot be redefined until you create a new
logical drive or an alternate logical drive replaces the deleted logical drive.

Complete the following steps to delete a primary or secondary logical drive from a
mirror relationship:

Attention:

» If you have data or logical drives that you want to keep, do not click Configure »
Reset Configure. This resets the controller unit and deletes all
previously-configured logical drives.

* You must use Disk Administrator and delete operating system logical drives
before you delete logical drives or reset the configuration in Storage Manager
8.4. This avoids damage to your registry information.

* The following steps will permanently remove data from the selected logical drive.

1. In the Subsystem Management window, select the primary or secondary logical
drive that you want to delete.

2. Click Logical Drive » Delete.
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3. Carefully review the information. To delete the logical drive, in the text area type
Yes.

4. Click OK.

Deactivating and disabling the Remote Mirror Option

If no mirror relationships exist and the Remote Mirror Option is no longer required,
you can deactivate the option to re-establish normal use of dedicated ports on both
storage subsystems and delete both mirror repository logical drives.

The Remote Mirror Option can also be disabled. When the option is in

the Disabled/Active state, you can still maintain and manage previously existing
mirrors; however, you cannot create any new mirror relationships. When in the
Disabled/Deactivated state, no Remote Mirror Option activity occurs.

Deactivating the Remote Mirror Option

Complete the following steps to change the Remote Mirror Option status from
Enabled/Activated to Enabled/Deactivated or from Disabled/Activated to
Disabled/Deactivated:

1. Verify that all mirror relationships are removed. For more information, see
[‘Removing mirror relationships” on page 125 |

2. Click Storage subsystem » Remote Mirror »Deactivate.
3. Carefully review the information that is presented in the Confirmation window.
4. Click Yes.

Disabling the Remote Mirror Option

126

Complete the following steps to change the Remote Mirror Option status from
Enabled/Deactivated to Disabled/Deactivated or from Enabled/Activated to
Disabled/Activated:

Attention: When you disable the Remote Mirror Option, you will need the key file
generating utility to reenable the feature. Copy the key file to a diskette or directory
for later use.

1. Complete the steps in ['Deactivating the Remote Mirror Option”| before you
disable the Remote Mirror Option.

2. In the Subsystem Management window, click Storage subsystem » Features »
Disable.

Click Remote Mirror.

Click OK.

Carefully review the information that is presented in the Confirmation window.
Click Yes.

ook w
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Chapter 9. Disaster recovery

This chapter describes the actions to take to prepare for a disaster, the actions to
take if a hardware component failure occurs, and the actions to take if a complete
site failure occurs.

As businesses increasingly require around-the-clock data access, you are required
to ensure that critical data is safeguarded against potential disasters. In preparing

for a potential disaster, you must develop a disaster recovery plan that details the

procedures to prepare for and prevent disasters, and the actions that you need to

take to respond to and recover from disasters if they occur.

Planning for disaster recovery

This section describes the steps that you must take to prepare for a possible
disaster or unrecoverable error. Preparation includes backing up critical data before
and during remote logical drive mirroring, using host clustering software for failover
protection, and preparing the secondary storage subsystem that will participate in
the remote logical drive mirror.

Be sure that you complete the checklists in [Table 12 on page 11§ and [Table 13 on|
page 119|to ensure that your primary and secondary storage subsystems are
prepared correctly.

Backing up critical data

It is vital that you back up critical data regularly to protect against disasters or
unrecoverable error. Backups must be performed regardless of whether the Remote
Mirror Option is in use.

A backup of all critical data on both the primary and secondary storage subsystems
that participate in remote logical drive mirroring must be performed before you
create a remote logical drive mirror. You must perform periodic backups of the
primary storage subsystem when remote logical drive mirrors are in use.

You can use FlashCopy, which captures a point-in-time image of a logical drive, to
make backups to tape or disk while /O continues. For more information about using
FlashCopy logical drives, see [‘FlashCopy and the Remote Mirror Option” on pagel
or the Subsystem Management window online help.

Preparing the secondary storage subsystem

When preparing for a potential disaster, ensure that the secondary storage
subsystem to which the data is mirrored, is structured in the same manner as the
primary storage subsystem.

Before you create a remote logical drive mirror, prepare your secondary storage
subsystem to ensure that storage partitions and FlashCopy logical drives are
defined and ready to function if the secondary storage subsystem is promoted to
the primary role.

Defining storage partitioning

The Storage Partitioning feature enables you to define which host computers have
access to which logical drives on the storage subsystem and at what LUN. When
configuring your secondary storage subsystem, replicate the storage partitions that
were previously defined on the primary storage subsystem. This ensures that if a
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role reversal is carried out, host computers are able to access their required data.
Depending on your operating system and host application software, you might not
be able to map the secondary logical drive to the host that the primary logical drive
is mapped to.

For more information about the Storage Partitioning feature, see the Subsystem
Management window online help.

Ensuring failover protection using the host clustering software

Host failover clustering is a process in which the operating system and program
software work together to provide continuous availability in the event of a program
failure, hardware failure, or operating system error. Software products that support
remote failover might refer to global or geographic cluster management.

You can use the Remote Mirror Option with remote host failover to provide
complete redundancy of host computers and storage subsystems. If a disaster
occurs at the primary storage subsystem, host computers at the secondary storage
subsystem take over the processing and initiate a role change to the secondary
storage subsystem.

Remote failover is not a requirement for a disaster recovery plan. Depending on the
requirements for how quickly operations must again function at optimal status,
mirroring the storage subsystems and relying on manual startup of the remote host
computers might be acceptable.

For more information about host cluster software and configuration, see the readme
in your IBM FAStT Storage Manager Version 8.4 CD.

Disaster recovery preparation checklist

Complete the tasks listed in[Table 14|to ensure that access to the mirrored data is
possible in the event of a disaster or an unrecoverable error.

Table 14. Disaster recovery preparation checklist

Task description Validation activity

1. Back up all critical data on both the primary and secondary ] Completed
storage subsystems.

2. Establish storage partitioning on the secondary storage ] Completed
subsystem. This reduces any lag time when promoting a
secondary logical drive to the primary logical drive role.

3. If required, configure the host clustering software to allow host |[] Completed
failover between the primary storage subsystem and secondary
storage subsystem that is participating in remote logical drive
mirroring.

Recovering from switch failures

128

The Campus configuration and the Intra-Site configuration are the two
configurations where each switch is a single point of failure. In the Highest
Availability Campus configuration, if a switch fails, at least one other switch is
configured to be an alternate path for all I/O. The single switch at each site is not
only responsible for the communication between the two sites for the Remote Mirror
Option, but for all host-to-storage subsystem I/0O as well.
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If a switch fails in the Campus configuration or the Intra-Site configuration, you must
decide whether or not to do a complete site failover. This decision must be based
on the immediate availability of a backup switch or the time it will take to receive a
replacement.

If a replacement switch is not readily available, you will need to use one of the
following temporary scenarios until the switch is replaced.

» Direct connection between host computers and storage subsystems - This
bypasses the switch and allows normal 1/O to continue. All mirror relationships
are suspended until a normal configuration is resumed. Since the storage
subsystems have a finite number of host connections, all host computers might
not be able to access the storage subsystem. For information about how to
directly connect host computers and storage subsystems, see the IBM FAStT
Storage Manager Version 8.4 Installation and Support Guide for your specific
operating system.

» Entire site failover - The switch at the secondary site is still functional, which
enables all host computers to access the switch and storage subsystems. Mirror
relationships are suspended until the primary storage subsystem is recovered. If
a complete site failover is needed to continue normal operations, see
[an entire site failover.”|

Recovering from storage subsystem failures

This section provides procedures for recovering storage systems when one of the
following situations has occurred:

* The primary storage subsystem is damaged or destroyed
* The entire primary site is damaged or destroyed

Both situations require a complete site failover from the primary site to the
secondary site so that normal operations can continue. For a secondary site failure,
no site failover is necessary. If the primary logical drive is not damaged, then a full
synchronization occurs when the site is recovered. If the primary storage subsystem
is damaged, follow the procedure in[‘Rebuilding a damaged site” on page 130

Attention: The procedures in this section must be completed in the order that
they are presented to ensure that the affected site or storage subsystem is
recovered successfully.

Performing an entire site failover

Entire site failover is necessary when an event occurs that inhibits normal operation
to the primary site for an extended period of time.

Complete the following steps to perform an entire site failover:

1. Manually reverse the role of the primary logical drive of the mirror relationship to
the secondary role. For more information, see [‘Reversing the roles of primary|
[and secondary logical drives” on page 131.|

2. If storage partitioning is preconfigured so that hosts can access the logical
drives, go to step |4 on page 130} Otherwise, continue with step B

3. Configure the storage partitioning so that host to logical drive access is identical

to the primary site configuration. When configured, continue to step |4_1 on page|

130] For more information about storage partitioning, see [‘Using other premium|

features with the Remote Mirror Option” on page 91| and the Subsystem
Management window online help.
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If the host computers at the secondary site are properly configured for host
failover, go to step [] Otherwise, continue with step [5}

Reinstall the host software and reconfigure the settings as needed. For more
information about installing and configuring host software, see the
documentation that comes with the software.

Run the Hot_add utility on hosts that have only mapped logical drives from the
secondary storage subsystem. Restart all hosts that have logical drive mappings
from the primary and secondary storage subsystems. Then resume normal
operation with the secondary site acting as a new, fully-functioning primary site.

The entire site failover is complete. The primary site must now be reconfigured
and the remote mirror environment must be re-created. The next step depends
on the resulting status of the storage subsystem.

If the storage subsystem and all of the contained data is recovered and fully
operational, go to ['Recreating a mirror relationship.”| Otherwise, go to
[‘Rebuilding a damaged site.]

Rebuilding a damaged site

If a disaster occurs to the primary or secondary site that renders the storage
subsystem or all data on the storage subsystem irreparable, then the site needs to
be rebuilt with new hardware.

Complete the following steps to rebuild a damaged site:

1.

Obtain new storage subsystems and any host computers and hardware that are
needed to properly use the Remote Mirror Option. Be sure that the new
hardware has the same level of specifications as the damaged hardware.

Depending on the configuration, complete the switch zoning and hardware
installation procedures for this site only. See [‘Installing the hardware” on page

Define a logical drive to replace the mirrored logical drive that was damaged on
the original storage subsystem. Be sure that the new logical drive is identical to
the specifications of the damaged logical drive.

Ensure that storage partitioning is properly defined so that it can take over
normal operation from the secondary site. For more information about storage
partitioning, see ['Using other premium features with the Remote Mirror Option’|
|on page 91| and the Subsystem Management window online help.

Ensure that the host software is properly configured so that the host computers
can take over I/O from the secondary site host computers. For more information
about installing and configuring host software, see the documentation that
comes with the software.

The site is recovered and is now ready to resume any mirror relationships that
were active before the failure. Go to [‘Recreating a mirror relationship.’]

Recreating a mirror relationship

When the damaged site is back online and properly configured, mirror relationships
can be resumed.

130

Complete the following steps to recreate a mirror relationship:

1.

From the active secondary site, define a mirror relationship using the logical
drive on the recovered primary site as the primary logical drive. For more
information, see |“Creating mirror relationships” on page 121 |

IBM TotalStorage FAStT Storage Manager Copy Services User’s Guide



2. Ensure that storage partitioning is properly defined on the recovered primary
site so that it can take over normal operation from the secondary site. For more
information about storage partitioning, see [‘Using other premium features with
[the Remote Mirror Option” on page 91| and the Subsystem Management window
online help.

3. Ensure that the host software is properly configured so that the host computers
at the recovered primary site can take over I/O from the secondary site host
computers. For more information about installing and configuring host software,
see the documentation provided with the software.

4. Perform a manual role reversal so that the recovered primary site now
possesses the active primary logical drive, and the primary logical drive now
exists on the secondary site. For more information, see [‘Reversing the roles of|
[primary and secondary logical drives.]

5. The remote mirror configuration is now optimal.

Reversing the roles of primary and secondary logical drives

A role reversal is the process of promoting the secondary logical drive to be the
primary logical drive within the mirrored logical drive pair, and demoting the primary
logical drive to be the secondary logical drive.

A role reversal is performed using one of the following methods:

Changing a secondary mirrored logical drive to a primary logical drive
This method promotes a selected secondary logical drive to become the
primary logical drive of the mirrored pair, and is used when an
unrecoverable error has occurred. For step-by-step instructions, see
[‘Changing a secondary logical drive to a primary drive.]

Changing a primary mirrored logical drive to a secondary logical drive
This method demotes a selected primary logical drive to become the
secondary logical drive of the mirrored pair, and is used during normal
operating conditions. For step-by-step instructions, see [‘Changing a primary|
logical drive to a secondary drive” on page 132)

Role reversals can also be performed using the Set command in the Storage
Manager Script window or the CLI. For more information, see the Enterprise
Management window online help.

Changing a secondary logical drive to a primary drive

A secondary logical drive is usually promoted to a primary logical drive role when
an unrecoverable error has occurred on the storage subsystem that contains the
primary logical drive. The secondary logical drive needs to be promoted so that host
computers can access data and normal operations can continue.

This method is not available unless the Remote Mirror Option is activated.

Note: When the secondary logical drive becomes a primary logical drive, any host
computers that are accessing the logical drive through a logical drive-to-LUN
mapping are now able to read or write to the logical drive. This condition
applies if the host did not have the same logical-drive-to-LUN mapping as
the LUN in the primary logical drive that was demoted to secondary logical
drive. If it did, you must restart the host for the newly-promoted-to-primary
(secondary) logical drive to replace the demoted (primary) logical drive.
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If a communication problem between the secondary site and the primary site
prevents the demotion of the primary logical drive, an error message displays.
However, you are given the opportunity to proceed with the promotion of the
secondary logical drive, even though this leads to a Dual Primary Remote Mirror
status condition. The recovery for this condition occurs when the remote mirror
pairs are re-created. If you attempt to change the role of one of the primary drives,
an error occurs.

Complete the following steps to promote a secondary logical drive to the primary
logical drive role:

1. Select the secondary logical drive in the Logical view. Then, either click Logical
Drive » Remote Mirror » Change » Role to Primary, or right click the drive
and click Change » Role to Primary. The Change to Primary window opens.

2. Click Yes. The secondary logical drive is promoted to the primary logical drive
role in the remote logical drive mirror.
When the controller owner of the primary logical drive is contacted, the primary
logical drive is automatically demoted to the secondary logical drive role in the
remote logical drive mirror.

Changing a primary logical drive to a secondary drive

132

Changing a primary logical drive to the secondary logical drive is used for role
reversals during normal operating conditions. You can also use this option during a
recovery procedure when a dual primary remote mirror status condition occurs.

Role reversal will not occur unless the Remote Mirror Option is activated.

Important: Any host computers that are accessing the primary logical drive through
a logical drive-to-LUN mapping are no longer able to read or write to the logical
drive. When the primary logical drive becomes a secondary logical drive, only
remote write requests initiated by the primary controller are written to the logical
drive.

If a communication problem between the primary and secondary sites prevents the
demotion of the primary logical drive, an error message displays. However, you are
given the opportunity to proceed with the demotion of the primary logical drive even
though this leads to a Dual Secondary Remote logical drive mirror status condition.
The recovery this status condition occurs when the remote mirror pairs are
re-created. If you attempt to change the role of one of the primary drives, an error
occurs.

Attention: If the selected primary logical drive has associated FlashCopy logical
drives, demoting this logical drive to a secondary role causes the associated
FlashCopy logical drives to fail.

Complete the following steps to demote a primary logical drive to the secondary

logical drive role:

1. Select the primary logical drive in the Logical view. Then either click Logical
Drive » Remote Mirror » Change » Role to Secondary, or right click the drive
and click Change » Role to Secondary. The Change to Secondary window
opens.

2. Click Yes. The primary logical drive is demoted to be the secondary logical drive
in the remote logical drive mirror.

IBM TotalStorage FAStT Storage Manager Copy Services User’s Guide



When the controller owner of the primary logical drive is contacted, the
secondary logical drive is automatically promoted to the primary logical drive
role in the remote logical drive mirror.
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Chapter 10. Troubleshooting the Remote Mirror Option

This chapter provides information about some problems that are commonly
encountered when using the Remote Mirror Option and how to resolve them.

The following troubleshooting topics are included in this chapter :
* General remote logical drive mirroring problems
* Inappropriate fibre-channel fabric configurations

* Problems with storage subsystem components that are involved in remote logical
drive mirroring

» Basic switch troubleshooting

Also provided is a list of the critical events that might be generated, and instructions
for upgrading future versions of controller firmware.

Locate the section that directly relates to your problem or consult the section
describing general troubleshooting techniques. If your problem is not discussed in
any of the sections in this chapter, contact your IBM technical-support
representative.

General troubleshooting

describes some of the usual problems that you might encounter when
using the Remote Mirror Option. The information is presented in order from the time
the option is enabled and activated, to problems that might be encountered as you
use the Remote Mirror Option.

Information about the probable cause and how you can resolve each problem is
provided. If your problem is not addressed in this section, see the remaining
sections in this chapter before you contact your IBM technical-support
representative.

Table 15. General Remote Mirror Option problems

Problem

Cause Resolution

The Remote Mirror menu
options in the Subsystem
Management window are
out and unavailable.

The Remote Mirror Option is not | 1 Enaple the Remote Mirror Option. A premium
enabled or activated. feature key is required to enable premium
greyed features.

2. Activate the Remote Mirror Option.

The Remote Mirror Option is a premium feature
option. Contact your IBM technical-support
representative for purchase information. For
step-by-step instructions to enable and activate
the Remote Mirror Option, see|“Enainng ana
activating the Remote Mirror Option” on page|
115| or the Subsystem Management window
online help.
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Table 15. General Remote Mirror Option problems (continued)

Problem

Cause

Resolution

The Remote Mirror icon in the
premium feature status area is
greyed out with a red line.

The Remote Mirror Option is not
enabled or activated.

1. Enable the Remote Mirror Option. A premium
feature key file is required to enable the
feature.

2. Activate the Remote Mirror Option.

The Remote Mirror Option is a premium feature
option. Contact your IBM technical-support
representative for purchase information. For
step-by-step instructions to enable and activate

the Remote Mirror Option, see|“Enainng ana

activating the Remote Mirror Option” on page]

115] or the Subsystem Management window
online help.

When creating a remote logical
drive mirror, the following error
message is received:

INVALID_MIRROR_CANDIDATE_VOL

The secondary logical drive
candidate was participating in a
mirror relationship with a different
logical drive on this storage
subsystem. The mirror
relationship was successfully
removed from the other storage
subsystem. However, a
communication error prevented
the successful removal of the
mirror relationship on this storage
subsystem.

A logical drive on this storage subsystem still
has a mirror relationship defined with the
secondary logical drive.

1. Click View » Storage subsystem profile.
Click the Logical Drives tab and then click
the Mirrors tab.

2. Locate the logical drive that is still
participating in the mirror relationship with
the secondary logical drive candidate and
remove the mirror relationship. For
step-by-step instructions, seel“Removingl
[mirror relationships” on page 125 or the
Subsystem Management window online help.

3. Re-create the intended remote logical drive
mirror using the original candidate logical
drives. For step-by-step instructions, see
[‘Creating mirror relationships” on page 121
or the Subsystem Management window
online help.

The primary logical drive is
showing a Synchronization-in-
Progress status.

A full synchronization, between
the primary and secondary logical
drives participating in a mirror
relationship, is in progress. Data
available on the primary logical
drive is copied in its entirety to its
associated secondary logical
drive.

Wait for the full synchronization to complete.
When full synchronization has finished copying
data from the primary logical drive to the
secondary logical drive, the mirrored logical drive
pair transitions to a Synchronized status.

For more information about monitoring the status
of a remote logical drive mirror, see the
Subsystem Management window online help.
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Table 15. General Remote Mirror Option problems (continued)

Problem

Cause

Resolution

Both the primary and secondary
logical drive are displayed as
being the primary logical drive.

A disaster or unrecoverable error
has occurred on the storage
subsystem that contains the
primary logical drive, and the
secondary logical drive is
promoted to the primary logical
drive role.

The primary storage subsystem is
now operational, but unreachable
because of a link failure. A forced
promotion of the secondary
logical drive has resulted in both
the primary and secondary logical
drives being displayed in the
primary logical drive role.

If the mirror logical drive pair status is
Synchronized, perform step [1] and step [}
Otherwise, perform step|3 and step|4].

1.

3.

Determine which of the logical drives in the
mirrored logical drive pair must be the
primary logical drive.

Choose the logical drive that must be in the
secondary logical drive role, then click
Storage subsystem » Change » Role to
Secondary. A resynchronization
automatically occurs.

Delete the mirror relationship from either
storage subsystem. Select either primary
logical drive in its respective Subsystem
Management window and click Logical
Drive » Remote Mirroring * Remove Mirror
Relationship.

Note: The mirror relationship for the remote
logical drive is not removed if there is a
connection problem between the two storage
subsystems. If the mirror relationship
remains on the remote logical drive after the
previous action, select that logical drive from
its respective Subsystem Management
window and click Logical Drive + Remote
Mirroring » Remove Mirror Relationship.

In its respective Subsystem Management
window, select the logical drive that you want
to be the primary logical drive. Click Logical
Drive » Remote Mirroring » Create. Follow
the instructions in the Create Remote Mirror
wizard to re-create the mirror relationship

For step-by-step instructions, see |“Changing 5|

rimary logical drive to a secondary drive” on|

page 132|or the Subsystem Management

window online help.

Chapter 10. Troubleshooting the Remote Mirror Option

137



Table 15. General Remote Mirror Option problems (continued)

Problem

Cause

Resolution

Both the primary and secondary
logical drives are displayed as
being the secondary logical
drive.

In response to a dual primary
logical drive condition, a role
reversal was carried out and the
primary logical drive was
demoted to the secondary logical
drive role. The secondary storage
subsystem is operational, but
unreachable because of a link
failure. The forced demotion of
the primary logical drive has
resulted in both the primary and
secondary logical drives being
displayed in the secondary logical
drive role.

If the mirror logical drive pair status is
Synchronized, perform step [1] and step 2}
Otherwise, perform step [3[and step|4].

1.

Determine which of the logical drives in the
mirrored logical drive pair must be the
primary logical drive.

Choose the logical drive that must be in the

primary logical drive role, then click Storage
Subsystem » Change » Role to Primary. A
re-synchronization automatically occurs.

Delete the mirror relationship from either
storage subsystem. Select either secondary
logical drive in its respective Subsystem
Management window and click Logical
Drive » Remote Mirroring * Remove Mirror
Relationship.

Note: The mirror relationship for the remote
logical drive is not removed if there is a
connection problem between the two storage
subsystems. If the mirror relationship
remains on the remote logical drive after the
previous action, select that logical drive from
its respective Subsystem Management
window and click Logical Drive »+ Remote
Mirroring » Remove Mirror Relationship.

In its respective Subsystem Management
window, select the logical drive that you want
to be the secondary logical drive. Click
Logical Drive» Remote Mirroring » Create.
Follow the instructions in the Create Remote
Mirror wizard to re-create the mirror
relationship.

For step-by-step instructions, see |“Changing a

secondary logical drive to a primary drive” on|

page 131|or the Subsystem Management

window online help.
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Table 15. General Remote Mirror Option problems (continued)

Problem

Cause

Resolution

The primary logical drive or
secondary logical drive is
displayed as missing.

A physical logical drive that a
remote logical drive mirror
depends on (primary logical drive,
secondary logical drive) is
removed, and the logical drive is
now displayed under the missing
logical drives node in the Logical
view of the Subsystem
Management window.

If missing logical drives are detected because
drives have accidentally been removed, or are
detected as missing because of a loss of power
to the drive enclosures. You can recover these
logical drives by completing the following steps:

1. Re-insert the drives back into the drive
enclosure.

2. Ensure that the drive enclosure power
supplies are properly connected to an
operating power source and have an Optimal
status.

For more information, see the Recovery Guru or
contact your IBM technical-support
representative.

If the missing logical drive is no longer required,
it can be deleted.

Attention: Deleting a missing logical drive is a
permanent action. Any associated logical drives
or logical drive-to-LUN mappings are also
deleted. For more information, see the Recovery
Guru or the Subsystem Management window
online help.

The mirror relationship was
removed successfully from the
primary side, but not from the
secondary side.

When removing a mirror
relationship, a link failure
occurred between the primary
and secondary storage
subsystems and an error
message displays.

The Subsystem Management
window for the primary storage
subsystem indicates that the
mirror relationship was removed
successfully; however, the
Subsystem Management window
for the secondary storage
subsystem indicates that the
mirror relationship still exists.

Open the Subsystem Management window for
the secondary storage subsystem and remove
the mirror relationship.

For step-by-step instructions, see |“Removina
[mirror relationships” on page 125 or the
Subsystem Management window online help.
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Table 15. General Remote Mirror Option problems (continued)

Problem

Cause

Resolution

The mirror relationship was
removed successfully from the
secondary side, but not from the
primary side.

When removing a mirror
relationship, a link failure
occurred between the primary
and secondary storage
subsystems.

The Subsystem Management
window for the secondary storage
subsystem indicates that the
mirror relationship is removed
successfully; however, the
Subsystem Management window
for the primary storage
subsystem indicates that the
mirror relationship still exists, with
the primary logical drive showing
an Unresponsive status.

Open the Subsystem Management window for
the primary storage subsystem and remove the
mirror relationship.

For step-by-step instructions, see |“Removing
[mirror relationships” on page 125 or the

Subsystem Management window online help.

The primary logical drive is
showing an Unsynchronized
status.

The remote logical drive mirror is
in an Unsynchronized status
because the data that is mirrored
between the primary logical drive
and the secondary logical drive is
no longer identical. Usual causes
for this status include link errors,
a failed primary logical drive or
secondary logical drive, or a dual
primary or dual secondary error
condition.

While the remote logical drive
mirror is in an Unsynchronized
status, no mirroring activity takes
place.

Note: The remote mirror link and
the mirror logical drive pair status
depends on I/O requests,
especially /0 write requests to
the primary logical drive. If there
are no I/O requests, the
displayed status of the mirror link
and the mirror logical drive pair in
the Storage Manager client might
be incorrect.

Note: Generate I/O write
requests to the primary logical
drive to force the storage
subsystems updating the remote
mirror status.

When the controller owner of the primary logical
drive can communicate with the controller owner
of the secondary logical drive and the logical
drive is online and optimal, a full synchronization
automatically takes place. When a full
synchronization begins, the remote logical drive
mirror transitions to a mirror
Synchronization-in-Progress status.

For information about monitoring the status of a
remote logical drive mirror, see the Subsystem
Management window online help.
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Table 15. General Remote Mirror Option problems (continued)

Problem

Cause

Resolution

An error message indicates that
the Remote Mirror Option is out
of compliance.

The Remote Mirror Option is out
of compliance. This normally
occurs if a storage subsystem
with logical drives that are
participating in remote logical
drive mirroring is moved into the
primary storage subsystem and
one of the following conditions
now exists:

* The Remote Mirror Option is
not enabled on the selected
storage subsystem.

e The Remote Mirror Option is
enabled, but the current
number of remote logical drive
mirrors that are defined on the
primary storage subsystem
exceeds the number of mirror
relationships that are allowed
for this storage subsystem.

If the Remote Mirror Option is not enabled for
the primary storage subsystem:

1. Obtain a premium feature key for this feature

from your IBM technical-support
representative.

2. Enable the Remote Mirror Option. For

step-by-step instructions, see |“Enab|ing the|
[Remote Mirror Option” on page 116,|or the

Subsystem Management window online help.

If the Remote Mirror Option is enabled, but the
current number of mirror relationships on the
storage subsystem exceeds the number of
mirror relationships that are allowed for the
storage subsystem, reduce the number of mirror
relationships to equal or less than the number of
mirror relationships allowed. The maximum
number of mirror relationships that are allowed is
32.

For step-by step instructions, see |“Removina
[mirror relationships” on page 125| or the
Subsystem Management window online help.

The remote logical drive
candidate is unresponsive and
cannot be updated.

The primary storage subsystem is
unable to notify the secondary
storage subsystem that its
worldwide name (WWN) has
changed.

This might be the result of a
controller in the primary storage
subsystem being swapped or
removed. Storage subsystem
recovery procedures that result in
configurations being reset and
can also cause a change to the
WWN.

The first write operation to the
primary logical drive causes the
mirrored logical drive pair to
transition into an Unsynchronized
status.

1. Remove all the existing mirror relationships
from the primary storage subsystem. For
step-by-step instructions, see |“Removing|
[mirror relationships” on page 125 or the
Subsystem Management window online help.

2. Re-establish the required mirror
relationships. For step-by step instructions,
see [‘Creating mirror relationships” on page]
[121] or the Subsystem Management window
online help.

General switch troubleshooting

[Table 16 on page 142 describes some of the common switch-related problems that

you might encounter when using the Remote Mirror Option. The troubleshooting
information provided relates to switches that are supported for use with IBM FAStT
Storage Manager Version 8.4. For a list of supported switches, see the IBM
TotalStorage FASIT Storage Manager Installation and Support Guide that is
appropriate for your operating system.
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Information about the probable cause and how you can resolve for each problem is
provided. If your problem is not addressed in this section, see the remaining
sections in this chapter before contacting your IBM technical-support representative.

Table 16. General switch problems

Problem

Cause

Resolution

The host is unable to detect primary
and secondary storage subsystems
that are participating in remote logical

When two or more switches are
cascaded together and have the
same domain ID, host computers are

Change the domain ID of one or
more of your switches, ensuring that
each one is unique. A domain ID

drive mirroring.

domain ID when attempting to

unable to locate the target device.
Each switch must have a unique

cascade two switches together.

must be a unique number between 1
and 239, which is used to identify the
switch to a fibre-channel fabric. For
more information about setting
domain IDs, see your switch
documentation.

Inappropriate fibre-channel fabric configurations

describes fibre-channel fabric configuration problems that you might
encounter after you have configured your storage subsystems and have activated
and enabled the Remote Mirror Option.

Information about the probable cause and how you can resolve each problem is
provided. If your problem is not addressed in this section, see the remaining
sections in this chapter before you contactyour IBM technical-support
representative.

Table 17. Fibre-channel fabric configuration problems

Problem

Cause

Resolution

The primary logical drive is
unable to contact the
fibre-channel fabric.

Usually, this error occurs because of a
failed fibre-channel fabric or because
of cabling problems between the
primary and secondary storage
subsystems that are participating in a
remote logical drive mirror.

 If the fibre-channel fabric has failed, repair
or replace the failed fabric.

« If the fibre-channel fabric is operational,
check the configuration cabling. The cable
must not go through a hub or be connected
directly between storage subsystems.
Ensure that the cable is attached through a
switch.

For step-by-step instructions to configure
storage subsystems for remote logical drive
mirroring, see|Chapter 7, “Installing hardware)

and software for the Remote Mirror Option,’|

on page 95.|
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Table 17. Fibre-channel fabric configuration problems (continued)

Problem Cause Resolution

The primary logical drive is
unable to communicate with
the secondary storage
subsystem. The primary
storage subsystem can still
communicate with the fabric.

Usually, this error occurs when the .
secondary storage subsystem has lost
power or when network problems exist
between the secondary storage
subsystem and the fabric.

The secondary storage subsystem has no
power. If the secondary storage subsystem
has no power and is not operational,
restore power to the storage subsystem.
For information about powering on storage
subsystems, see your hardware
documentation.

* The secondary storage subsystem has
power and is operational. Check the
network status. Ensure that the secondary
storage subsystem is visible on the
network. Ensure that the cables are
correctly connected.

For step-by-step instructions to configure
storage subsystems for remote logical drive
mirroring, see|Chapter 7, “Installing hardware)
and software for the Remote Mirror Option, ]

on page 95]

Storage subsystem component failures

describes how physical or logical storage subsystem component failures
can impact remote logical drive mirroring functionality. Information about the
probable cause and how you can resolve each problem is provided. If your problem
is not addressed in this section, see the remaining sections in this chapter before
you contact your IBM technical-support representative.

Table 18. Storage subsystem component failures

Problem Cause Resolution

A FlashCopy logical drive that was | The base logical drive for the FlashCopy Perform a role reversal to

created for a primary logical drive
indicates that it has failed.

logical drive is a primary logical drive that is
involved in a mirror relationship. A role reversal
was performed, which demoted the primary
logical drive to secondary logical drive status,
resulting in a FlashCopy logical drive on the
secondary logical drive.

The base logical drive for a FlashCopy logical
drive cannot be a candidate for the secondary
logical drive role in a remote logical drive
mirror. Therefore, the FlashCopy logical drive
has failed.

promote the secondary logical
drive to the primary logical drive
role. After the role reversal is
complete, the FlashCopy logical
drive returns to Optimal status.

For step-by-step instruction, see

“Changing a secondary logical|

drive to a primary drive” on|

|page 131| or the Subsystem

Management window online

help.
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Table 18. Storage subsystem component failures (continued)

Problem

Cause

Resolution

The primary storage subsystem
controller indicates that it has failed.

Failure of the owning controller on the primary
storage subsystem usually causes the
associated multipath driver on the attached
host computer to transfer ownership of the
alternate controller on the primary storage
subsystem.

When this occurs, the alternate controller on
the primary storage subsystem begins
forwarding newly-written data to its peer on the
secondary storage subsystem. The secondary
controller takes ownership of the logical drive
from its (secondary) peer controller. This is a
reactive event; it occurs because of the arrival
of a write request from the primary storage
subsystem to the non-owning controller on the
secondary storage subsystem.

Allow the ownership transfer to
complete. Operations continue
in a normal fashion, with the
alternate (usually the
non-preferred) controller on the
primary storage subsystem
interacting with the alternate
controller on the secondary
storage subsystem.

Failure of the non-owning
controller on the primary storage
subsystem has no direct impact
on the status of the remote
logical drive mirrors.

The secondary storage subsystem
controller indicates that it has failed.

One of the following scenarios has occurred:

» Controller A on the secondary storage
subsystem has failed while Controller A is
the owner of the primary logical drive.

» Controller B on the secondary storage
subsystem has failed while Controller B is
the owner of the primary logical drive.

In both scenarios, the mirrored logical drive
pair transitions to the Unsynchronized status.

Restore the failed controller. For
detailed recovery procedures,
see the Recovery Guru. After
the failed controller is restored,
the primary storage subsystem
automatically transitions to a
Synchronizing status.

Remote Mirror critical events

Critical major event log (MEL) events are generated when an error occurs that can
affect data availability or that results in a degraded mode of operation. The storage
management software responds by alerting the appropriate administrators by
e-mail, SNMP trap, or other configured devices. Because administrative action is
required to correct the problem, the storage subsystem generally enters a Needs
Attention status. This causes the appropriate indications to be presented through
the storage management software and an associated Recovery Guru procedure to
be displayed when requested by the end user.

Critical events table

provides a description of critical MEL events, with a brief explanation of
what caused the event to be triggered, and how you can resolve the problem. If
your problem is not addressed in this section, see the remaining sections in this
chapter before you contact your IBM technical-support representative.

Table 19. Remote Mirror critical events

Problem

Cause

Resolution

Mirrored pair becomes
unsynchronized.

This event is logged when a remote
logical drive mirror transitions to an
Unsynchronized status, from either a
Synchronizing or Optimal status.

See the associated Recovery Guru
message for specific recovery
procedures.
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Table 19. Remote Mirror critical events (continued)

Problem

Cause

Resolution

Dual-role conflict detected.

This event is logged when a dual-role
conflict is detected, and is usually the
result of a role reversal. Because both
sides of the mirrored logical drive pair
are in the same primary or secondary
logical drive role, both the primary and
secondary storage subsystems will
report this MEL event.

See the associated Recovery Guru
message for specific recovery
procedures.

Communication error with the
secondary logical drive on the

secondary remote storage subsystem.

This event is logged when an
interruption in the link that cannot be
recovered by the firmware

fibre-channel device driver is detected.

Error codes and recovery procedures
assist you in finding the exact cause
of the communication problem
between storage subsystems that are
participating in a mirror relationship.

See the associated Recovery Guru
message for specific recovery
procedures.

Worldwide name (WWN) change
notification failed.

This event is logged when a storage
subsystem detects during start-up
processing that its WWN has
changed. The WWN can only change
if both controllers of the array are
exchanged while the array is powered
off.

When the firmware detects this name
change, it attempts to notify any
remote storage subsystem that had
previously been participating in a
mirroring relationship with any logical
drive on the array.

See the associated Recovery Guru
message for specific recovery
procedures.

Critical event scenarios

The following scenarios present resolutions or workarounds to potential critical

events:

Problem:

When you create a remote mirror of a FlashCopy base logical drive, the

following scenario is possible.

+ First, you have created a FlashCopy of a base logical drive and the base
logical drive is receiving 1/O.

» Second, you decide to create a remote mirror relationship, using the
base logical drive as the primary logical drive in the remote mirror pair.

» As you create the remote mirror relationship, the FlashCopy logical drive
fails.

Workaround:
Quiesce 1/0 to the base logical drive while you are creating the remote
mirror relationship. Alternatively, if the remote mirror relationship is created
before you create the FlashCopy logical drive, this event will not occur.

Problem:

When alternately switching the roles of the logical drives in a remote
mirrored relationship back and forth, Windows NT 4.0 and Windows 2000
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might cache the file or files on the logical drive (disk) in memory and use
the cached data instead of going out to the disk to get the data. This
Windows operating system behavior might make the data look like it was
not synchronized between logical drives in a remote mirror relationship.

Resolution:

Unmount the primary logical drive in the server before demoting it to the
secondary role. In a Microsoft Windows environment, shut down the server
that the primary logical drive is mapped to. Then, promote the secondary
logical drive to the primary role and hot_add it to the appropriate server.

If the logical drive is of the “Dynamic Disk” type, you might be able to

resolve the situation without shutting down the server. Perform the following

steps:

1. In the server that has the primary logical drive, run the
SMFlashCopyAssist program in the FAStT Storage Manager 8.4 utility
directory with the -f option to flush the cached data to disk.

2. Promote the secondary logical drive and hot_add it to the appropriate
server.

3. Before you promote the logical drive to the primary role in the original
server, force a failure to the disk by running chkdsk on the disk.

4. Promote the logical drive to primary role in the original server and
hot_add it.

5. You might have to reactivate the disk after it is hot_added to the server.

If the server environment prevents the server from being restarted and the
logical drive is of the “Basic Disk” type, perform the following steps:

1. In the server that has the primary logical drive, run the
SMFlashCopyAssist program in the FAStT Storage Manager 8.3x util
directory with the -f option to flush the cached data to disk.

2. Use the FASLT Storage Manager to remove the LUN mapping of the
logical drive that had the primary role from its server (host computer).

3. Promote the secondary role LUN to the primary role and hot_add it in
the appropriate server assuming that the LUN mapping is already
defined for this server in the FASLT storage subsystem.

4. Before you promote the logical drive to the primary role in the original
server, run the Hot_add program or initiate a Scan for Hardware
Changes task in the original server. This removes the logical drive from
the available disks. In Windows 2000, you might see Unsafe Removal of
Devices messages.

5. Use the FAStT Storage Manager to add the LUN mapping of the logical
drive that will be promoted to primary role to the original server (host
computer).

6. Promote the logical drive to primary role and hot_add it in the original
server. If you are unable to hot_add the logical drive or the data still
seems to be mismatched, you must restart the server.
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Appendix A. Controller firmware version 5.4 upgrades

The Remote Mirror Option is designed so that it is not necessary for the primary
storage subsystem and the secondary storage subsystem to run the same controller
firmware level. All inter-controller operations (including those needed for propagation
of newly-written data from the primary logical drive to the secondary logical drive)
are implemented so as to support mixed firmware levels to the greatest extent
possible. This allows firmware upgrades to be performed on both the primary and
secondary storage subsystems without any loss of data.

This section describes the procedure that you must follow to upgrade controller
firmware (version 5.20 and higher) to ensure that the Remote Mirror Option works
properly. The preferred sequence for performing firmware upgrades on storage
subsystems that are participating in mirror relationships is detailed below.

Important: By following this sequence, it is possible to avoid transitions of the
mirrored logical drive pair to an Unsynchronized status, avoiding the need for a full
resynchronization afterwards.

1. Stop I/O to programs that operate on all the affected primary logical drives that
are temporarily inactive.

2. Download firmware to the secondary storage subsystem.

Resume program access to the primary logical drives. You can operate the
primary storage subsystem with a different firmware level than the secondary
storage subsystem for a time, but the inter-controller protocols for data
replication do not support such interactions.

3. Download the firmware to the primary storage subsystem.
4. Download the firmware to the secondary storage subsystem.

Some configuration operations, such as establishing new mirrors and modifying
mirror parameters, might not be allowed between storage subsystems that have
different firmware levels and will result in error messages. However, the key data
availability operations, including promotion from the secondary logical drive to the
primary logical drive, are allowed in such circumstances.
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Appendix B. Additional FAStT documentation

The following tables present an overview of the FAStT900, FAStT700, and
FAStT600 Fibre Channel Storage Server product libraries, as well as other related
documents. Each table lists documents that are included in the libraries and what
common tasks they address. Click on active links in the tables to access those
documents currently available on the Internet. You can access documentation for

the other FASIT products at the following Web site:

issddom02.storage.ibm.com/techsup/webnav.nsf/support/fastt/|

FAStT900 Fibre Channel Storage Server library

associates each document in the FAStT900 Fibre Channel Storage Server
library with its related common user tasks.

Table 20. TotalStorage FAStT900 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotaIStorage|
FAStT900

Installation and
Support Guide,

GC26-7530|

IBM TotalStorage
FAStT900 Fibre
Channel Cablin
Instructions,
24P8135

IBM TotaIStorage|

FAStT900 Storage]
Server User's Guide)|

GC26-7534|

IBM TotaIStorage|

FAStT FC2-133 Dual|
Port Host Bus|
Adapter Installation|
and User’s Guide,|

GC26-7532]

IBM FAStT FC2-133
Host Bus Adaptet|
Installation and
User's Guide,
48P9823

IBM TotalStorag
FAStT900 Rack
Mountin
Instructions,
19K0900

0]
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http://ssddom02.storage.ibm.com/techsup/webnav.nsf/support/fastt
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8136.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/24p8135.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7534.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k0900.pdf

Table 20. TotalStorage FAStT900 Fibre Channel Storage Server document titles by user tasks (continued)

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM Fibre Channel|
Planning and
Integration: User’s|
Guide and Service|

Information,
SC23-432

IBM FAStT|

Management Suite
Java User’s Guide,

32P008 1|

IBM TotaIStorage|

FAStT Fibre Channel|
Hardware|
Maintenance Manual
and Problem|
Determination

Guide, GC26-7528|
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http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
http://www-1.ibm.com/servers/eserver/pseries/library/hardware_docs/a4a/234329.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf

FAStT700 Fibre Channel Storage Server library

able 21| associates each document in the FAStT700 Fibre Channel Storage Server
library with its related common user tasks.

Table 21. TotalStorage FAStT700 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM FAStT700
Installation and
Support Guide,
32P0171

IBM FAStT700 Fibrel
Channel Cablin
Instructions,)
32P0343

IBM FAStT700 Fibre|
Channel Storage]
Server User's Guide)|
32P0341

IBM EXP700
Storage Expansion|
Unit Installation and|

User's Guide,
32P0178

IBM FAStT FC2-133
Dual Port Host Bus|
Adapter Installation|
and User’'s Guide,|

GC26-7532]

IBM TotaIStorage|

FAStT FC2-133 Host|
Bus Adapte

IBM FAStT]

Management Suite
Java User’s Guide,
32P0081

IBM Fibre Channel|

Hardware
Maintenanc

Manual, 19K6130|

IBM Fibre Channel|
Problem
Determination
Guide, 48P980
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0171.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0343.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0341.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0178.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9823.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/32p0081.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k6130.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k6130.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k6130.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/19k6130.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9804r.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9804r.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9804r.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/48p9804r.pdf

FAStT600 Fibre Channel Storage Server library

associates each document in the FAStT600 Fibre Channel Storage Server
library with its related common user tasks.

Table 22. TotalStorage FAStT600 Fibre Channel Storage Server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
FAStT600 Fibre
Channel Storage|

Server Installation|
land User’s Guide,|

GC26-7531]

IBM TotaIStorage|

FAStT Fibre Channel|
Hardware|
Maintenance Manual
and Problem|
Determination

Guide, GC26-7528|

IBM TotaIStorage|

FAStT FC2-133 Dual|
Port Host Bus|
[Adapter Installation|
and User’s Guide,

GC26-7532]

IBM TotalStorage
FAStT600 Rack
Mounting
Instructions,
24P8125

IBM TotalStorage
FAStT600 Cabling
Instructions,
24P8126
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/f602iug.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/hmpd3.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/gc26-7532.pdf

FAStT-related documents
associates each of the following documents related to FAStT operations

with its related common user tasks.

Table 23. TotalStorage FAStT related document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM Safety
Information,
P48P9741

’/

IBM Netfinity® Fibre]
Channel Cablin
Instructions,|
19K0906]

IBM Fibre Channel|
SAN Configuration|

Setup Guide,
25P2509
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ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers/19k0906.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
ftp://ftp.pc.ibm.com/pub/pccbbs/pc_servers_pdf/25p2509.pdf
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Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Trademarks

The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

IBM Intellistation
AIX Netfinity
e-server logo ServerProven
FlashCopy TotalStorage
xSeries
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Intel is a trademark of Intel Corporation in the United States, other countries, or
both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, or service names may be the trademarks or service marks
of others.

Important notes
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Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often
less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000
bytes, and GB stands for approximately 1 000 000 000 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.
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Glossary

This glossary provides definitions for the
terminology used for the IBM TotalStorage FAStT.
This glossary also provides definitions for the
terminology used for the IBM TotalStorage FAStT
Storage Manager.

This glossary defines technical terms and
abbreviations used in this document. If you do not
find the term you are looking for, see the IBM
Glossary of Computing Terms located at
www.ibm.com/networking/nsg/nsgmain.htm

This glossary also includes terms and definitions
from:

» Information Technology Vocabulary by
Subcommittee 1, Joint Technical Committee 1,
of the International Organization for
Standardization and the International
Electrotechnical Commission (ISO/IEC
JTC1/SCH1). Definitions are identified by the
symbol (l) after the definition; definitions taken
from draft international standards, committee
drafts, and working papers by ISO/IEC
JTC1/SC1 are identified by the symbol (T) after
the definition, indicating that final agreement
has not yet been reached among the
participating National Bodies of SC1.

» IBM Glossary of Computing Terms. New York:
McGraw-Hill, 1994.

The following cross-reference conventions are
used in this glossary:

See Refers you to (a) a term that is the
expanded form of an abbreviation or
acronym, or (b) a synonym or more
preferred term.

See also
Refers you to a related term.

Abstract Windowing Toolkit (AWT). A Java graphical
user interface (GUI).

accelerated graphics port (AGP). A bus specification
that gives low-cost 3D graphics cards faster access to
main memory on personal computers than the usual
peripheral component interconnect (PCI) bus. AGP
reduces the overall cost of creating high-end graphics
subsystems by using existing system memory.

access volume. A special logical drive that allows the
host-agent to communicate with the controllers in the
storage subsystem.

© Copyright IBM Corp. 2003

adapter. A printed circuit assembly that transmits user
data input/output (I/0O) between the internal bus of the
host system and the external fibre-channel (FC) link and
vice versa. Also called an I/O adapter, host adapter, or
FC adapter.

ADT. See auto-logical drive transfer feature.

advanced technology (AT) bus architecture. A bus
standard for IBM compatibles. It extends the XT bus
architecture to 16 bits and also allows for bus
mastering, although only the first 16 MB of main
memory are available for direct access.

agent. A server program that receives virtual
connections from the network manager (the client
program) in a Simple Network Management
Protocol-Transmission Control Protocol/Internet Protocol
(SNMP-TCP/IP) network-managing environment.

AGP. See accelerated graphics port.
AL_PA. See arbitrated loop physical address.

arbitrated loop. A shared 100 MBps fibre-channel
transport structured as a loop and supporting up to 126
devices and one fabric attachment. A port must
successfully arbitrate before a circuit can be
established.

arbitrated loop physical address (AL_PA). One of
three existing fibre-channel topologies, in which two to
126 ports are interconnected serially in a single loop
circuit. Access to the fibre channel-Arbitrated Loop
(FC-AL) is controlled by an arbitration scheme. The
FC-AL topology supports all classes of service and
guarantees in-order delivery of FC frames when the
originator and responder are on the same FC-AL. The
default topology for the disk array is arbitrated loop. An
arbitrated loop is sometimes referred to as Stealth
Mode.

auto-logical drive transfer (ADT) feature.. ADT is a
built-in feature of the controller firmware that allows
logical drive-level failover rather than controller-level
failover.

auto volume transfer/auto disk transfer (AVT/ADT).
A function that provides automatic failover in case of
controller failure on a storage subsystem.

AVT/ADT. See auto volume transfer/auto disk transfer.
AWT. See Abstract Windowing Toolkit.

basic input/output system (BIOS). Code that controls
basic hardware operations, such as interactions with
diskette drives, hard disk drives, and the keyboard.

BIOS. See basic input/output system.
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BOOTP. See bootstrap protocol.

bootstrap protocol (BOOTP). A Transmission Control
Protocol/Internet Protocol (TCP/IP) protocol that a
diskless workstation or network computer uses to obtain
its Internet Protocol (IP) address and other network
information such as server address and default
gateway.

bridge. A storage area network (SAN) device that
provides physical and transport conversion, such as
fibre channel to small computer system interface (SCSI)
bridge.

bridge group. A bridge and the collection of devices
connected to it. Bridge Groups are discovered by the
SANavigator tool and are displayed with a gray
background on the Physical and Data Path Maps.

broadcast. A method of sending a Simple Network
Management Protocol (SNMP) request for information to
all the devices on a subnet that use a single special
request. Because of its efficiency, the SANavigator tool
sets its default method of discovery to broadcast.
However, a network administrator might disable this
method on the network router.

cathode ray tube (CRT). An electrical device for
displaying images by exciting phosphor dots with a
scanned electron beam. CRTs are found in computer
video display units (VDUs) and monitors, televisions,
and oscilloscopes.

CDPD. See cellular digital packet data.

cellular digital packet data (CDPD). A wireless
standard that provides two-way, 19.2 kps packet data
transmission over existing cellular telephone channels.

CGA. See color graphics adapter.

client. A computer system or process that requests a
service of another computer system or process that is
typically referred to as a server. Multiple clients can
share access to a common server.

color graphics adapter (CGA). An early, now
obsolete, IBM video display standard for use on IBM
personal computers. CGA displays 80 x 25 or 40 x 25
text in 16 colors, 640 x 200 pixel graphics in two colors
or 320 x 200 pixel graphics in four colors.

command. Any selection on a dialog box or elsewhere
in the user interface that causes the SANavigator tool to
perform a task.

community strings. The name of a community
contained in each Simple Network Management
Protocol (SNMP) message. SNMP has no standard
mechanisms for verifying that a message was sent by a
member of the community, keeping the contents of a
message private, or for determining if a message has
been changed or replayed.

CRC. See cyclic redundancy check.
CRT. See cathode ray tube.

cyclic redundancy check (CRC). (1) A redundancy
check in which the check key is generated by a cyclic
algorithm. (2) An error detection technique performed at
both the sending and receiving stations.

dac. See disk array controller.
dar. See disk array router.
DASD. See direct-access storage device.

default host group. A logical collection of discovered
host ports, defined host computers, and defined host
groups in the storage-partition topology that fulfill the
following requirements:

» Are not involved in specific logical drive-to-LUN
mappings

+ Share access to logical drives with default logical
drive-to-LUN mappings

device type. Identifier used to place devices in the
physical map, such as the switch, hub, storage.

DHCP. See Dynamic Host Configuration Protocol.

direct access storage device (DASD). IBM
mainframe terminology for a data storage device by
which information can be accessed directly, instead of
bypassing sequentially through all storage areas. For
example, a disk drive is a DASD, in contrast with a tape
drive, which stores data as a linear sequence.

direct memory access (DMA). The transfer of data
between memory and an input/output (I/O) device
without processor intervention.

disk array controller (dac). A disk array controller
device that represents the two controllers of an array.
See also disk array router..

disk array router (dar). A disk array router that
represents an entire array, including current and
deferred paths to all logical unit numbers (LUNSs) (hdisks
on AIX). See also disk array controller.

DMA. See direct memory access.

domain. The most significant byte in the node port
(N_port) identifier for the fibre-channel (FC) device. It is
not used in the fibre channel-small computer system
interface (FC-SCSI) hardware path ID. It is required to
be the same for all SCSI targets logically connected to
an FC adapter.

DRAM. See dynamic random access memory.
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dynamic host configuration protocol (DHCP). A
protocol defined by the Internet Engineering Task Force
that is used for dynamically assigning IP addresses to
computers in a network.

dynamic random access memory (DRAM). A
storage in which the cells require repetitive application
of control signals to retain stored data.

E_port. See expansion port.
ECC. See error correction coding.

EEPROM. See electrically erasable programmable
read-only memory.

EGA. See enhanced graphics adapter.

electrically erasable programmable read-only
memory (EEPROM). A type of non-volatile storage
device that can be erased with an electrical signal.
Writing to EEPROM takes much longer than reading. It
also can only be reprogrammed a limited number of
times before it wears out. Therefore, it is appropriate for
storing small amounts of data that are changed
infrequently.

electrostatic discharge (ESD). The flow of current
that results when objects that have a static charge
come into close enough proximity to discharge.

enhanced graphics adapter (EGA). An IBM video
display standard that provides text and graphics with a
resolution of 640 x 350 pixels of 16 colors. It emulates
the Color Graphics Adapter (CGA) and the Monochrome
Display Adapter (MDA) and was superseded by the
Video Graphics Display (VGA).

enhanced small device interface (ESDI). A hard disk
controller standard that allows disks to communicate
with computers at high speeds. ESDI drives typically
transfer data at about 10 megabits per second, although
they are capable of doubling that speed.

error correction coding (ECC). A method for
encoding data so that transmission errors can be
detected and corrected by examination of the data on
the receiving end. Most ECCs are characterized by the
maximum number of errors they can detect and correct.

error detection coding. A method for encoding data
so that errors that occur during storage or transmission
can be detected. Most error detection codes are
characterized by the maximum number of errors they
can detect. The simplest form of error detection is by
using a single added parity bit or a cyclic redundancy
check. Adding multiple parity bits can detect not only
that an error has occurred, but also which bits have
been inverted, thereby indicating which bits should be
re-inverted to restore the original data.

ESD. See electrostatic discharge.

ESDI. See enhanced small device interface.
EXP. See expansion unit.

expansion port (E_port). An expansion port (E_port)
that connects the switches for two fabrics (also used for
McData ES-1000 B ports).

expansion unit. A feature that can be connected to a
system unit to provide additional storage and processing
capacity.

eXtended graphics array (XGA). An IBM advanced
standard for graphics controller and display mode
design introduced in 1990. XGA, used mostly on
workstation-level systems, supports a resolution of 1024
X 768 pixels with a palette of 256 colors, or 640 x 480
with high color (16 bits per pixel). XGA-2 added 1024 x
768 support for high color and higher refresh rates,
improved performance, and supports 1360 x 1024 in 16
colors.

F_port. See fabric port.

fabric group. A collection of interconnected storage
area network (SAN) devices discovered by the
SANavigator tool and displayed with a blue background
on the Physical and Data Path Maps.

fabric port (F_port). A fabric port (F_port) that
supports a node port (N_port) on a fibre-channel switch.

FAStT MSJ. See FASIT Management Suite Java.

FAStT Management Suite Java (FASIT MSJ) . A
diagnostic and configuration utility that can be used on
Linux, Microsoft Windows, and Novell NetWare host
systems. In Linux, it is also used with the QLRemote
agent to define preferred and non-preferred paths for
logical drives.

feature enable identifier. A unique identifier for the
storage subsystem, which is used in the process of
generating a premium feature key. See also premium
feature key.

fibre channel (FC). A bidirectional, full-duplex,
point-to-point, serial data channel structured for high
performance capability. Physically, fibre channel
interconnects devices, such as host systems and
servers, FC hubs and disk arrays, through ports, called
node ports (N_ports), in one of three topologies: a
point-to-point link, an arbitrated loop, or a cross point
switched network, which is called a fabric. FC can
interconnect two devices in a point-to-point topology,
from two to 126 devices in an arbitrated loop. FC is a
generalized transport mechanism that can transport any
existing protocol, such as small computer system
interface (SCSI), in FC frames.

Fibre Channel Protocol (FCP) for small computer

system interface (SCSI). A high-level fibre-channel
mapping layer (FC-4) that uses lower-level fibre-channel
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(FC-PH) services to transmit SCSI command, data, and
status information between a SCSI initiator and a SCSI
target across the FC link by using FC frame and
sequence formats.

field replaceable unit (FRU). An assembly that is
replaced in its entirety when any one of its components
fails. In some cases, a FRU might contain other field
replaceable units.

FRU. See field replaceable unit.
GBIC. See gigabit interface converter.

general purpose interface bus (GPIB). An 8-bit
parallel bus developed for the exchange of information
between computers and industrial automation
equipment.

gigabit interface converter (GBIC). A transceiver that
performs serial, optical-to-electrical and
electrical-to-optical signal conversions for high-speed
networking. A GBIC can be hot swapped. See also
small form-factor pluggable.

GPIB. See general purpose interface bus.

graphical user interface (GUI). A type of computer
interface that presents a visual metaphor of a real-world
scene, often of a desktop, by combining high-resolution
graphics, pointing devices, menu bars and other menus,
overlapping windows, icons, and the object-action
relationship.

GUI. See graphical user interface.
HBA. See host bus adapter.

hdisk. An AIX term that represents a logical unit
number (LUN) on an array.

host. A system that is directly attached to the storage
subsystem through a fibre-channel input/output path.
This system is used to serve data (typically in the form
of files) from the storage subsystem. A system can be
both a storage management station and a host
simultaneously.

host bus adapter (HBA). An interface between the
fibre-channel network and a workstation or server.

host computer. See host.

host group. A host group is an entity in the
storage-partition topology that defines a logical
collection of host computers that require shared access
to one or more logical drives.

host port. Host ports physically reside on the host
adapters and are automatically discovered by the FAStT
Storage Manager software. To give a host computer
access to a partition, you must define its associated
host ports.

hot swap. To replace a hardware component without
turning off the system.

hub. In a network, a point at which circuits are either
connected or switched. For example, in a star network,
the hub is the central node; in a star/ring network, it is
the location of wiring concentrators.

IBMSAN driver. The IBM Storage Area Network
device driver that is used in a Novell NetWare
environment to provide multipath 1/0O support to the
storage controller.

IC. See integrated circuit.
IDE. See integrated drive electronics.

in-band. Transmission of management protocol over
the fibre-channel transport.

Industry Standard Architecture (ISA). A bus
standard for IBM compatibles that allows components to
be added as cards plugged into standard expansion
slots. ISA was originally introduced in the IBM PC/XT
with an 8-bit data path. It was later expanded to permit
a 16-bit data path when IBM introduced the PC/AT.

initial program load (IPL). The part of the boot
sequence during which a computer system copies the
operating system kernel into main memory and runs it.

integrated circuit (IC). A microelectronic
semiconductor device that consists of many
interconnected transistors and other components. ICs
are constructed on a small rectangle cut from a silicon
crystal or other semiconductor material. The small size
of these circuits allows high speed, low power
dissipation, and reduced manufacturing cost compared
with board-level integration. Also known as a chip.

integrated drive electronics (IDE). Also known as an
Advanced Technology Attachment Interface (ATA). A
disk drive interface based on the 16-bit IBM personal
computer Industry Standard Architecture (ISA) in which
the controller electronics reside on the drive itself,
eliminating the need for a separate adapter card.

integrated services digital network (ISDN). A digital
end-to-end telecommunication network that supports
multiple services including, but not limited to, voice and
data. ISDNs are used in public and private network
architectures.

interrupt request (IRQ). A type of input found on
many processors that causes the processor to suspend
normal instruction execution temporarily and start
executing an interrupt handler routine. Some processors
have several interrupt request inputs that allow different
priority interrupts.
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Internet Protocol (IP) address. The unique 32-bit
address that specifies the location of each device or
workstation on the Internet. For example, 9.67.97.103 is
an |IP address.

IP address. See Internet Protocol address.
IPL. See initial program load.

IRQ. See interrupt request.

ISA. See Industry Standard Architecture.

ISDN. See Integrated Services Digital Network.

isolated group. A collection of isolated devices not
connected to the storage area network (SAN) but
discovered by the SANavigator tool. The isolated group
displays with a gray background near the bottom of the
Physical and Data Path Maps.

Java Runtime Environment (JRE). A subset of the
Java Development Kit (JDK) for end users and
developers who want to redistribute the JRE. The JRE
consists of the Java virtual machine, the Java Core
Classes, and supporting files.

JRE. See Java Runtime Environment.

label. A discovered or user entered property value that
is displayed underneath each device in the Physical and
Data Path Maps.

LAN. See local area network.
LBA. See logical block addressing.

local area network (LAN). A computer network
located on a user’s premises within a limited geographic
area.

logical block addressing (LBA). A hard disk sector
addressing scheme in which the addressing conversion
is performed by the hard disk firmware. LBA is used on
all small computer system interface (SCSI) hard disks
and on ATA-2 conforming intergrated drive electronics
(IDE) hard disks.

logical unit number (LUN). An identifier used on a
small computer systems interface (SCSI) bus to
distinguish among up to eight devices (logical units) with
the same SCSI ID.

loop address. The unique ID of a node in
fibre-channel loop topology sometimes referred to as a
loop ID.

loop group. A collection of storage area network
(SAN) devices that are interconnected serially in a
single loop circuit. Loop groups are discovered by the
SANavigator tool and displayed with a gray background
on the Physical and Data Path Maps.

loop port (FL_port). A node port (N-port) or fabric port
(F-port) that supports arbitrated loop functions
associated with an arbitrated loop topology.

LUN. See logical unit number.
MAC. See medium access control.

medium access control (MAC). In local area
networks (LANSs), the sublayer of the data link control
layer that supports medium-dependent functions and
uses the services of the physical layer to provide
services to the logical link control sublayer. The MAC
sublayer includes the method of determining when a
device has access to the transmission medium.

man pages. In UNIX-based operating systems, online
documentation for operating system commands,
subroutines, system calls, file formats, special files,
stand-alone utilities, and miscellaneous facilities.
Invoked by the man command.

management information base (MIB). The
information that is on an agent. It is an abstraction of
configuration and status information.

MCA. See micro channel architecture.
MIB. See management information base.

micro channel architecture (MCA). IBM’s proprietary
bus that is used in high-end PS/2 personal computers.
Micro channel is designed for multiprocessing and
functions as either a 16-bit or 32-bit bus. It eliminates
potential conflicts that arise when installing new
peripheral devices.

MIDI. See musical instrument digital interface.

model. The model identification assigned to a device
by its manufacturer.

musical instrument digital interface (MIDI). A
protocol that allows a synthesizer to send signals to
another synthesizer or to a computer, or a computer to
a musical instrument, or a computer to another
computer.

NDIS. See network device interface specification.

network device interface specification (NDIS). An
application programming interface (API) definition that
allows disk operating systems (DOS) or OS/2 to support
one or more network adapters and protocol stacks.
NDIS is a 16-bit, Ring O (for the OS/2 operating
system) application programming interface (API) that
defines a specific way for writing drivers for layers 1 and
2 of the OSI model. NDIS also handles the configuration
and binding of these network drivers to multiple protocol
stacks.

network management station (NMS). In the Simple
Network Management Protocol (SNMP), a station that
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executes management application programs that
monitor and control network elements.

NMI. See non-maskable interrupt.
NMS. See network management station.

non-maskable interrupt (NMI). A hardware interrupt
that another service request cannot overrule (mask). An
NMI bypasses and takes priority over interrupt requests
generated by software, the keyboard, and other such
devices and is issued to the microprocessor only in
disastrous circumstances, such as severe memory
errors or impending power failures.

node. A physical device that allows for the
transmission of data within a network.

node port (N_port). A fibre-channel defined hardware
entity that performs data communications over the
fibre-channel link. It is identifiable by a unique worldwide
name. It can act as an originator or a responder.

N_port. See node port.

nonvolatile storage (NVS). A storage device whose
contents are not lost when power is cut off.

NVS. See nonvolatile storage.

NVSRAM. Nonvolatile storage random access
memory. See nonvolatile storage.

Object Data Manager (ODM). An AIX proprietary
storage mechanism for ASCII stanza files that are
edited as part of configuring a drive into the kernel.

ODM. See Object Data Manager.

out-of-band. Transmission of management protocols
outside of the fibre-channel network, typically over
Ethernet.

PCl local bus. See peripheral component interconnect
local bus.

PDF. See portable document format.

peripheral component interconnect local bus (PCI
local bus). A standard that Intel Corporation
introduced for connecting peripherals. The PCI local bus
allows up to 10 PCIl-compliant expansion cards to be
installed in a computer at a time. Technically, PCI is not
a bus but a bridge or mezzanine. It runs at 20 - 33 MHz
and carries 32 bits at a time over a 124-pin connector
or 64 bits over a 188-pin connector. A PCI controller
card must be installed in one of the PCl-compliant slots.
The PCI local bus is processor independent and
includes buffers to decouple the central processing unit
(CPU) from relatively slow peripherals, allowing them to
operate asynchronously. It also allows for multiplexing, a
technique that permits more than one electrical signal to
be present on the PCI local bus at a time.

performance events. Events related to thresholds set
on storage area network (SAN) performance.

polling delay. The time in seconds between
successive discovery processes during which discovery
is inactive.

port. The hardware entity that connects a device to a
fibre-channel topology. A device can contain one or
more ports.

portable document format (PDF). A standard
specified by Adobe Systems, Incorporated, for the
electronic distribution of documents. PDF files are
compact; can be distributed globally by e-mail, the Web,
intranets, or CD-ROM; and can be viewed with the
Acrobat Reader, which is software from Adobe Systems
that can be downloaded at no cost from the Adobe
Systems home page.

premium feature key. A file that the storage
subsystem controller uses to enable an authorized
premium feature. The file contains the feature enable
identifier of the storage subsystem for which the
premium feature is authorized, and data about the
premium feature. See also feature enable identifier.

private loop. A freestanding arbitrated loop with no
fabric attachment.

program temporary fix (PTF). A temporary solution or
bypass of a problem diagnosed by IBM in a current
unaltered release of the program.

PTF. See program temporary fix.
RAM. See random-access memory.

random-access memory (RAM). A temporary storage
location in which the central processing unit (CPU)
stores and executes its processes.

RDAC. See redundant disk array controller.

read-only memory (ROM). Memory in which the user
cannot changed stored data except under special
conditions.

recoverable virtual shared disk (RVSD). A virtual
shared disk on a server node configured to provide
continuous access to data and file systems in a cluster.

red, green, blue (RGB). (1) Color coding in which the
brightness of the additive primary colors of light, red,
green, and blue are specified as three distinct values of
white light. (2) Pertaining to a color display that accepts
signals that represent red, green, and blue.

redundant disk array controller (RDAC). (1) In
hardware, a redundant set of controllers (either
active/passive or active/active). (2) In software, a layer
that manages the input/output (1/O) through the active
controller during normal operation and transparently
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reroutes 1/Os to the other controller in the redundant set
if a controller or I/O path fails.

RGB. See red, green, blue.
ROM. See read-only memory.

router. A computer that determines the path of
network traffic flow. The path selection is made from
several paths based on information obtained from
specific protocols, algorithms that attempt to identify the
shortest or best path, and other criteria such as metrics
or protocol-specific destination addresses.

RVSD. See recoverable virtual shared disk.
SAN. See storage area network.

scope. Defines a group of controllers by their Internet
Protocol (IP) addresses. You must create and configure
a scope so that dynamic IP addresses can be assigned
to controllers on your network.

SCSIl. See small computer system interface.

segmented loop port (SL_port). A segmented loop
port (SL_port) allows you to divide a fibre-channel
private loop into multiple segments. Each segment can
pass frames around as an independent loop and can
connect through the fabric to other segments of the
same loop.

sense data. (1) Data sent with a negative response,
indicating the reason for the response. (2) Data
describing an 1/O error. Sense data is presented to a
host system in response to a sense request command.

serial storage architecture (SSA). An interface
specification from IBM in which devices are arranged in
a ring topology. SSA, which is compatible with small
computer system interface (SCSI) devices, allows
full-duplex packet multiplexed serial data transfers at
rates of 20 Mbps in each direction.

server. A functional hardware and software unit that
delivers shared resources to workstation client units on
a computer network.

server/device events. Events that occur on the server
or a designated device that meet criteria that the user
sets.

SFP. See small form-factor pluggable.

Simple Network Management Protocol (SNMP). In
the Internet suite of protocols, a network management
protocol that is used to monitor routers and attached
networks. SNMP is an application layer protocol.
Information on devices managed is defined and stored
in the application’s Management Information Base
(MIB).

SL_port. See segmented loop port.

SMagent. The FASIT Storage Manager optional
Java-based host-agent software, which can be used on
Microsoft Windows, Novell Netware, HP-UX and Solaris
host systems to manage storage subsystems through
the host fibre-channel connection.

SMclient. The FAStT Storage Manager client software,
which is a Java-based graphical user interface (GUI)
that is used to configure, manage, and troubleshoot
storage servers and expansion units in a FAStT storage
subsystem. SMclient can be used on a host system or
on a storage management station.

SMruntime. A Java compiler for the SMclient.

SMutil. The FASIT Storage Manager utility software
that is used on Microsoft Windows, HP-UX and Solaris
host systems to register and map new logical drives to
the operating system. In Microsoft Windows, it also
contains a utility to flush the system’s OS cached data
for a particular drive before creating a FlashCopy.

small computer system interface (SCSI). A standard
hardware interface that enables a variety of peripheral
devices to communicate with one another.

small form-factor pluggable (SFP). An optical
transceiver that is used to convert signals between
optical fiber cables and switches. An SFP is smaller
than a gigabit interface converter (GBIC). See also
gigabit interface converter.

SNMP. See Simple Network Management Protocol.

SNMPv1. The original standard for Simple Network
Management Protocol (SNMP) is now referred to as
SNMPv1, as opposed to SNMPv2, a revision of SNMP.
See also Simple Network Management Protocol.

SNMP time-out. The maximum amount of time the
SANavigator tool will wait for a device to respond to a
request. The specified time applies to one retry only.

SNMP trap events. Simple Network Management
Protocol (SNMP) is based on a manager/agent model.
SNMP includes a limited set of management commands
and responses. The management system issues
messages that tell an agent to retrieve various object
variables. The managed agent sends a Response
message to the management system. That message is
an event notification, called a trap, that identifies
conditions, such as thresholds, that exceed a
predetermined value.

SRAM. See static random access memory.
SSA. See serial storage architecture.

static random access memory (SRAM). Random
access memory based on the logic circuit known as
flip-flop. It is called static because it retains a value as
long as power is supplied, unlike dynamic random
access memory (DRAM), which must be regularly
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refreshed. It is however, still volatile, meaning that it can
lose its contents when the power is switched off.

storage area network (SAN). A network that links
servers or workstations to disk arrays, tape backup
subsystems, and other devices, typically over fibre
channel.

storage management station. A system that is used
to manage the storage subsystem. A storage
management station does not need to be attached to
the storage subsystem through the fibre-channel
input/output path.

storage partition. Storage partitions are storage
subsystem logical drives that are visible to a host
computer or are shared among host computers that are
part of a host group.

storage partition topology. In the FAStT Storage
Manager client, the Topology view of the Mappings
window displays the default host group, the defined host
group, the host computer, and host-port nodes. You
must define the host port, host computer and host group
topological elements to grant access to host computers
and host groups using logical drive-to-LUN mappings.

subnet. An interconnected but independent segment
of a network that is identified by its Internet Protocol (IP)
address.

super video graphics array (SVGA). A video display
standard that Video Electronics Standards Association
(VESA) created to provide high resolution color display
on IBM PC compatible personal computers. The
resolution is 800 x 600 4-bit pixels. Each pixel can
therefore be one of 16 colors.

SVGA. See super video graphics array.

sweep method. A method of sending Simple Network
Management Protocol (SNMP) requests for information
to all the devices on a subnet by sending the request to
every device on the network. Sweeping an entire
network can take a half an hour or more. If broadcast is
disabled, the recommended method is to enter the
individual Internet Protocol (IP) addresses of the storage
area network (SAN) devices into the SANavigator tool.
This method produces good results without
unnecessarily using time to wait for responses from
every IP address in the subnet, especially for IP
addresses where no devices are present. There might,
however, be times when a full subnet sweep will
produce valuable diagnostic information about the
network or a device’s configuration.

switch. A fibre-channel device that provides full
bandwidth per port and high-speed routing of data by
using link-level addressing.

switch group. A switch and the collection of devices
connected to it that are not in other groups. Switch

groups are discovered by the SANavigator tool and
displayed with a gray background on the Physical and
Data Path Maps.

system name. Device name assigned by the vendor’s
third-party software.

TCP. See Transmission Control Protocol.

TCP/IP. See Transmission Control Protocol/Internet
Protocol.

terminate and stay resident program (TSR
program). A program that installs part of itself as an
extension of DOS when it is executed.

TFT. See thin-film transistor.

thin-film transistor (TFT). A transistor created by
using thin film methodology.

topology. The physical or logical arrangement of
devices on a network. The three fibre-channel
topologies are fabric, arbitrated loop, and point-to-point.
The default topology for the disk array is arbitrated loop.

TL_port. See translated loop port.

transceiver. A device that is used is used to transmit
and receive data. "Transceiver” is an abbreviation of
"transmitter-receiver.”

translated loop port (TL_port). Each translated loop
port (TL_port) connects to a private loop and allows
connectivity between the private loop devices and off
loop devices (devices not connected to that particular
TL_port).

Transmission Control Protocol (TCP). A
communication protocol used in the Internet and in any
network that follows the Internet Engineering Task Force
(IETF) standards for internetwork protocol. TCP
provides a reliable host-to-host protocol between hosts
in packed-switched communication networks and in
interconnected systems of such networks. It uses the
Internet Protocol (IP) as the underlying protocol.

Transmission Control Protocol/Internet Protocol
(TCP/IP). A set of communication protocols that
provide peer-to-peer connectivity functions for both local
and wide-area networks.

trap. In the Simple Network Management Protocol
(SNMP), a message sent by a managed node (agent
function) to a management station to report an
exception condition.

trap recipient. Receiver of a forwarded Simple
Network Management Protocol (SNMP) trap.
Specifically, a trap receiver is defined by an Internet
Protocol (IP) address and port to which traps are sent.
Presumably, the actual recipient is a software
application running at the IP address and listening to
the port.
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TSR program. See terminate and stay resident
program.

uninterruptible power supply. A source of power
from a battery that is installed between a computer
system and its power source. The uninterruptible power
supply keeps the system running if a commercial power
failure occurs, until an orderly shutdown of the system
can be performed.

user action events. Actions that the user takes, such
as changes in the storage area network (SAN), changed
settings, and so on. Each such action is considered a
user action event.

vendor. Property value that the SANavigator tool uses
to launch third-party software. Vendor property might be
discovered but will always remain editable.

VGA. See video graphics adapter.

video graphics adapter (VGA). A computer adapter
that provides high-resolution graphics and a total of 256
colors.

video random access memory (VRAM). A special
type of dynamic random access memory (DRAM) used
in high-speed video applications, designed for storing
the image to be displayed on a computer’s monitor.

VRAM. See video random access memory.
WORM. See write-once read-many.

worldwide name (WWN). A registered, unique 64-bit
identifier assigned to nodes and ports.

write-once read-many (WORM). Any type of storage
medium to which data can be written only a single time,
but can be read from any number of times. After the
data is recorded, it cannot be altered. Typically the
storage medium is an optical disk whose surface is
permanently etched by using a laser in order to record
information. WORM media are high-capacity storage
devices and have a significantly longer shelf life than
magnetic media.

WWN. See worldwide name.
XGA. See eXtended graphics array.

zoning. A function that allows segmentation of nodes
by address, name, or physical port and is provided by
fabric switches or hubs.
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